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FPGA Support
Simulink Real-Time and HDL Coder™ software enable you to implement
Simulink algorithms and configure I/O functionality on Speedgoat field
programmable gate array (FPGA) boards. Speedgoat I/O FPGA boards are
sold as part of Speedgoat turnkey systems. For information on Speedgoat I/O
hardware, see “Speedgoat I/O Configuration”.

Simulink Real-Time supports the following Speedgoat boards.

Board Description

Speedgoat IO301 Xilinx® Virtex-II, 6912 logic cells, 64 TTL
I/O lines

Speedgoat IO302 Xilinx Virtex-II, 6912 logic cells, 32 RS-422
I/O lines

Speedgoat IO303 Xilinx Virtex-II, 6912 logic cells, 16 TTL and
24 RS-422 I/O lines

Speedgoat IO311 Xilinx Virtex-II, 24192 logic cells, 64 TTL
I/O lines

Speedgoat IO312 Xilinx Virtex-II, 24192 logic cells, 32 RS-422
I/O lines

Speedgoat IO313 Xilinx Virtex-II, 24192 logic cells, 16 TTL
and 24 RS-422 I/O lines

Speedgoat IO314 Xilinx Virtex-II, 24192 logic cells, 32 LVDS
I/O lines

Speedgoat IO321 Xilinx Virtex-4 chip, 41472 logic cells, 64
LVCMOS or 32 LVDS (four are input only)
I/O lines, two 16-bit 105 MHz analog input
channels, optional high-speed AXM-A30
A/D port subassembly (Speedgoat IO321-5).

Speedgoat IO331 Xilinx Spartan 6 chip, 147333 logic
cells, 64 LVCMOS or 32 LVDS I/O lines,
optional AXM-A75 A/D and D/A converter
subassembly (Speedgoat IO331-6).
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To work with FPGAs in the Simulink Real-Time environment, you must:

• Install HDL Coder and Xilinx ISE. For the specific ISE version required,
see the Speedgoat board documentation. For more information, see “Tool
Setup” in the HDL Coder documentation.

• Install the Speedgoat FPGA I/O board in the Speedgoat target machine.

• Be familiar with FPGA technology. In particular, you must know the clock
frequency and the I/O connector pin and channel configuration of your
FPGA board.

• Have experience using data type conversion and designing Simulink
fixed-point algorithms.

To generate HDL code for your FPGA target, you do not need to have HDL
programming experience.

The Simulink Real-Time product provides the following FPGA applications
as examples.

Example Description

Servo Control with the
Speedgoat IO301 FPGA
Board

Shows programming and configuring the
Speedgoat IO301 with a simple PWM servo
controller, hardware counter, and digital I/O.

Digital I/O with the
Speedgoat IO303 FPGA
Board

Shows programming and configuring the
Speedgoat IO303 for digital I/O.
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FPGA Programming and Configuration
To implement Simulink algorithms on a Speedgoat FPGA I/O board, you use
“HDL Workflow Advisor” to specify an FPGA board and its I/O interface,
synthesize the Simulink algorithm for FPGA programming, and generate an
Simulink Real-Time interface subsystem model. The interface subsystem
model contains blocks to program the FPGA and communicate with the
FPGA I/O board during target application execution. You add the generated
subsystem to your Simulink Real-Time domain model.

The workflow looks like this figure.
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FPGA Programming and Configuration

Before you begin this procedure, you must have completed the following:

• “Simulink Domain Model” on page 1-6

• “FPGA Subsystem Plan” on page 1-8

This procedure uses example Servo Control with the Speedgoat IO301
FPGA Board.

1 “FPGA Target Configuration” on page 1-11

2 “FPGA Target Interface Configuration” on page 1-13

3 “FPGA Target Frequency Configuration” on page 1-15

4 “Simulink® Real-Time™ Interface Subsystem Generation” on page 1-17

5 “Simulink® Real-Time™ Domain Model” on page 1-20

6 “Simulink® Real-Time™ Interface Subsystem Integration” on page 1-22

The next task is “Target Application Execution” on page 1-24.
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Simulink Domain Model
The Simulink FPGA domain model contains a subsystem (algorithm) to be
programmed onto the FPGA chip. Using this model, you can test your FPGA
algorithm in a simulation environment before you deploy the algorithm to
an FPGA board.

1 Create a Simulink model to contain the algorithm that you want to load
onto the FPGA.

2 Place the algorithm to be programmed on the FPGA inside a Subsystem
block. The model can include other blocks and subsystems for testing.
However, one subsystem must contain the FPGA algorithm.

3 Set or confirm the subsystem inport and outport names and data types.

The HDL Coder HDL Workflow Advisor uses these settings for routing
and mapping algorithm signals to I/O connector channels. See “FPGA
Subsystem Plan” on page 1-8.

4 Save the model.

This model is your FPGA domain model. It represents the simulation sample
rate of the clock on your FPGA board. For example, the Speedgoat IO301 has
an onboard 33MHz clock. One second of simulation equals 33e6 iterations
of the model.

For an example of an FPGA domain model, see dxpcSGIO301servo_fpga. The
ServoSystem subsystem contains the FPGA algorithm.
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FPGA Subsystem Plan
Before you work with the HDL Coder HDL Workflow Advisor, plan how to
prepare the FPGA subsystem for HDL code generation and FPGA synthesis.

Target Device
You must decide which FPGA to target for code generation. The example
procedure uses the Simulink Real-Time FPGA workflow and the Speedgoat
IO301 FPGA IO board for target platform. These choices require that you use
the Xilinx ISE synthesis tool.

For information about other target devices, see “Supported Third-Party Tools
and Hardware”.

FPGA Synchronization Mode
To select the processor/FPGA synchronization mode, you must decide which of
the FPGA synchronization modes to use:

• Free running

• Coprocessing blocking

• Coprocessing nonblocking with delay.

For more information, see “FPGA Synchronization Modes” on page 1-28.

FPGA Inports and Outports
Inports and outports may transmit signal data between the Speedgoat
target machine and the FPGA over the PCI bus or map to I/O channels for
communicating with external devices. For connector pin and I/O channel
assignments of your supported FPGA I/O board, see the board reference
page for your board.

In addition to the Port Name and Port Type (Inport or Outport), to specify
the I/O interface, see:

• Data Type—Encodes such attributes as width and sign. Data types must
map consistently to their corresponding I/O pins. An inport of type Boolean
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FPGA Subsystem Plan

requires 1 bit, one of type uint32 requires 32 bits, and so on. For example,
you cannot connect an inport of type uint32 to an FPGA I/O interface of
type TTL I/O channel [0:7]; it requires TTL I/O channel [0:31].

• Target Platform Interfaces—Encodes the I/O channels on the FPGA as
well as their functional type. For a single-ended interface (TTL, LVCMOS),
one channel maps to one connector pin. For a differential interface (RS422,
LVDS), one channel maps to two connector pins. To discover the mapping
for a particular pin, see the pin connector map provided with the board
description.

I/O channels may also map to a predefined specification or role (PCI
Interface, Interrupt from FPGA).

For information on using FPGA interrupts, see “Interrupt Configuration”
on page 1-25.

• Bit Range/Address/FPGA Pin—Encodes the pins on the target
platform to which the inports and outports are assigned, along with the
channel number used by the port. For specification PCI Interface, Bit
Range/Address/FPGA Pin encodes the PCI address used by the port.

If vector inports or outports are required, specify a vector port:

• Inport — Add a mux outside the subsystem that connects to a demux
inside the subsystem.

• Outport – Add a mux inside the subsystem that connects to a demux
outside the subsystem.

• Inport and Outport – Configure the port dimension to be greater than 1.

Workflow Advisor automatically inserts a strobe to achieve a simultaneous
update of vector elements.

If you have specified vector inports or outports, before generating code, you
must select the Scalarize vector ports check box. This check box is on
the Coding style tab of node Global Settings, under node HDL Code
Generation in the Configuration Parameters dialog box.
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FPGA Clock Frequency
The FPGA system clock frequency defaults to the fixed FPGA input clock
frequency. The fixed FPGA input clock frequency is shown in the FPGA
input clock frequency (MHz) box. You can specify another frequency
in this box. If the FPGA clock circuits cannot generate the specified value
exactly, HDL Coder HDL Workflow Advisor generates the closest match. The
closest match, Fsystem, is based on the following formula:

F F ClkFxMultiply ClkFxDividesystem input * /

Finput is the fixed FPGA input clock frequency. ClkFxMultiply and
ClkFxDivide are integers.
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FPGA Target Configuration
This procedure uses the dxpcSGIO301servo_fpga example. You must have
already created an FPGA subsystem (algorithm) in an FPGA domain model
and developed an FPGA subsystem plan. See “Simulink Domain Model” on
page 1-6 and “FPGA Subsystem Plan” on page 1-8.

1 Open the FPGA domain model dxpcSGIO301servo_fpga.

2 In the FPGA model, right-click the FPGA subsystem (ServoSystem). From
the context menu, select HDL Code > HDL Workflow Advisor.

The HDL Workflow Advisor dialog box displays a number of tasks for
the subsystem. You need to address only a subset of the tasks.

3 Expand the Set Target folder and select task 1.1 Set Target Device
and Synthesis Tool.

4 Set Target Workflow to Simulink Real-Time FPGA I/O.

5 From the Target platform list, select the Speedgoat FPGA I/O board
installed in your Speedgoat target machine.

For the dxpcSGIO301servo_fpga example, this is Speedgoat IO301.

6 From the Synthesis tool list, select Xilinx ISE.

7 Click Run This Task.
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The next task is “FPGA Target Interface Configuration” on page 1-13.
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FPGA Target Interface Configuration
This procedure uses the dxpcSGIO301servo_fpga example. You must have
already developed an FPGA subsystem plan and configured the FPGA target.
See “FPGA Subsystem Plan” on page 1-8 and “FPGA Target Configuration”
on page 1-11.

1 In the Set Target folder, select task 1.2 Set Target Interface.

2 In the Processor/FPGA synchronization box, select Free running.

For information about FPGA synchronization modes, see “FPGA
Synchronization Modes” on page 1-28.

3 For signals from the FPGA through I/O lines (channels) — In the Target
Platform Interfaces column, select the required I/O channel type (for
example, TTL I/O Channel [0:63]).

In the Bit Range/Address/FPGA Pin column, enter the channel value
for each signal.

4 For signals between the Speedgoat target machine and the FPGA — In the
Target Platform Interfaces column, select PCI Interface.

In the Bit Range/Address/FPGA Pin column, use the automatically
generated values. Do not enter PCI address values.

5 After specifying interfaces for the required signals, click Run This Task.
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For more information about mapping Speedgoat FPGA I/O pins in HDL Coder
HDL Workflow Advisor, see “Set the Target Interface for Speedgoat Boards”.

The next task is “FPGA Target Frequency Configuration” on page 1-15.
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FPGA Target Frequency Configuration
This optional procedure uses the dxpcSGIO301servo_fpga example. You
must have already developed an FPGA subsystem plan and configured the
FPGA target interface. See “FPGA Subsystem Plan” on page 1-8 and “FPGA
Target Interface Configuration” on page 1-13.

1 In the Set Target folder, select task 1.3 Set Target Frequency (optional).

The Set Target Frequency pane contains fields showing the FPGA input
clock frequency (fixed) and the FPGA system clock frequency. The FPGA
system clock frequency defaults to the FPGA input clock frequency.

2 To specify a different system clock frequency (for example, 50 MHz), type
the new value in the field FPGA system clock frequency (MHz). For
the permitted range for the system clock rate, see the Speedgoat board
characteristics table.

The system may set a value different from the one you specified. For more
information, see “FPGA Clock Frequency” on page 1-10.

3 Click Run This Task.
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The next task is “Simulink® Real-Time™ Interface Subsystem Generation”
on page 1-17.
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Simulink Real-Time Interface Subsystem Generation
This procedure uses the dxpcSGIO301servo_fpga example. You must
have already configured the FPGA target interface and the required target
frequency. If you have specified vector inports or outports, you must have
already selected the Scalarize vector ports check box. This check box is
on the Coding style tab of node Global Settings, under node HDL Code
Generation in the Configuration Parameters dialog box.

1 Expand the Download to Target folder, and right-click task 5.2
Generate Simulink Real-Time Interface.

2 In this pane, click Run To Selected Task.

This action:

• Runs the remaining tasks.

• Creates the FPGA bitstream file in the hdlsrc folder. The Simulink
Real-Time interface subsystem references this bitstream file during the
build and download process.

• Generates a model named gm_fpgamodelname_xpc, which contains the
Simulink Real-Time interface subsystem.
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Here is an example of the HDL Coder HDL Workflow Advisor after this action.
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The generated interface subsystem looks like this figure.

This generated model contains a masked subsystem with the same name as
the subsystem in the Simulink FPGA domain model. Although the appearance
is similar, this subsystem does not contain the Simulink algorithm. Instead,
the algorithm is implemented in an FPGA bitstream. You reference and load
this algorithm into the FPGA from this subsystem.

The next task is “Simulink® Real-Time™ Domain Model” on page 1-20.
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Simulink Real-Time Domain Model
Using the Simulink Real-Time software, you can transform a Simulink or
Stateflow® domain model into a Simulink Real-Time domain model and
execute it on a Speedgoat target machine for real-time testing applications.
After creating a Speedgoat FPGA domain model and the Simulink Real-Time
interface subsystem using HDL Coder HDL Workflow Advisor, you can
include the FPGA board in your Simulink Real-Time domain model by
inserting the interface subsystem.

1 Create a Simulink Real-Time domain model with the functionality that you
want to simulate in conjunction with the FPGA algorithm.

Leave the inports and outports of the FPGA subsystem disconnected.

2 Save the model.

The Simulink Real-Time domain model looks like this figure. See example
model dxpcSGIO301servo_xpc.
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The next task is “Simulink® Real-Time™ Interface Subsystem Integration”
on page 1-22.
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Simulink Real-Time Interface Subsystem Integration
Before doing this procedure, you must have already generated an Simulink
Real-Time interface subsystem with the HDL Coder software. If you have not
yet done so, see “Simulink® Real-Time™ Interface Subsystem Generation”
on page 1-17.

You need to set three parameters in the Simulink Real-Time interface
subsystem mask:

• Device index

• PCI slot

• Sample time

In addition, you must evaluate the communication timeout requirements for
your model. The default communication timeout of 5 seconds may not be long
enough to download and program a large FPGA, such as the Speedgoat IO331.

1 In the Simulink editor, open gm_fpgamodelname_xpc.

2 Copy and paste the this subsystem, Simulink Real-Time interface
subsystem, into the Simulink Real-Time domain model.

3 Save or discard gm_fpgamodelname_xpc. You can recreate it as required
using the HDL Coder HDL Workflow Advisor.

4 In the Simulink Real-Time domain model, connect signals to the inports
and outports of the Simulink Real-Time interface subsystem.

5 Set the block parameters according to the FPGA I/O boards in your
Speedgoat target machine.

• If you have a single FPGA I/O board, leave the device index and PCI
slot at the default values. You can set the sample time or leave it at 1
for inheritance.

• If you have multiple FPGA I/O boards, give each board a unique device
index.

• If you have two or more boards of the same type (for example, two
Speedgoat IO301 boards), specify the PCI slot ([bus, slot]) for each board.
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Get this information with the SimulinkRealTime.target.getPCIInfo
function.

6 If you need a larger communication timeout, in the Configuration
Parameters dialog box for the model, expand the Code Generation
and Simulink Real-Time Options nodes, clear the Use default
communication timeout check box, and then enter a new value in the
Specify the communication timeout in seconds box.

7 Save the model.

The updated Simulink Real-Time domain model looks like this figure. See
example model dxpcSGIO301servo_xpc_wiss.

You are now ready to build and download the Simulink Real-Time domain
model. Continue with “Target Application Execution” on page 1-24.
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Target Application Execution
To do this procedure, you must have already created an Simulink Real-Time
domain model that includes an Simulink Real-Time interface subsystem
generated from the HDL Coder HDL Workflow Advisor. If you have not
yet done so, see “Simulink® Real-Time™ Interface Subsystem Integration”
on page 1-22.

1 Configure the Speedgoat target machine and connect it to the host
computer.

2 Build and download the Simulink Real-Time model. The Simulink
Real-Time model loads onto the Speedgoat target machine and the FPGA
algorithm bitstream loads onto the FPGA.

3 If you are using I/O lines (channels), confirm that you have connected the
lines to your external hardware under test.

The start and stop of the Simulink Real-Time model controls the start and
stop of the FPGA algorithm. The FPGA algorithm executes at the clock
frequency of the FPGA I/O board, while the application executes in accordance
with the model sample time.
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Interrupt Configuration
Simulink Real-Time software schedules the target application using either
the internal timer of the Speedgoat target machine (default) or an interrupt
from an I/O board. You can use your Speedgoat FPGA board to generate an
interrupt, which allows you to:

• Schedule execution of the target application based on this interrupt
(synchronous execution). For this method, you must generate the interrupt
periodically.

• Execute a designated subsystem in your target application (asynchronous
execution).

To use FPGA-based interrupts, set up and configure the FPGA domain and
Simulink Real-Time domain models.

FPGA Domain Model
In the FPGA domain subsystem, create the interrupt source execution of the
target application in one of the following ways.

Source Description

Internal A clock you create using Simulink blocks to create input
signals. This clock is a binary pulse train of zeros and ones
(transition from 0 to 1 and vice versa). The clock generates an
interrupt on a rising edge. The following is an example of an
internally generated interrupt source from Simulink blocks.
Connect the internally generated interrupt source to an outport
labelled INT.

External A clock signal that comes from a device outside the Speedgoat
target machine. You use a digital input pin to connect to this
signal. The following is an example of an externally generated
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Source Description

interrupt source that comes from TTL channel 8. Delay this
source by one FPGA clock cycle and connect to an outport
labeled INT.

In both cases, wire the interrupt source to an outport in the FPGA subsystem.
Assign the outport as Interrupt from FPGA in the HDL Coder HDL
Workflow Advisor task 1.2 Set Target Interface.

You are now ready to set up interrupt support in the Simulink Real-Time
domain model. See “Simulink® Real-Time™ Domain Model” on page 1-26.

Simulink Real-Time Domain Model
For overview information, see “FPGA Domain Model” on page 1-25.

Configure the model Simulink Real-Time domain model to set up interrupt
support:

1 Open the Simulink Real-Time domain model.

2 In the Simulink editor, select Simulation > Model Configuration
Parameters.

3 Navigate to node Simulink Real-Time Options, under node Code
Generation.

4 From the Real-time interrupt source list, select one of the following:

• Auto (PCI only)

• The IRQ assigned to your FPGA board

5 From the I/O board generating the interrupt parameter, select your
FPGA board, for example, Speedgoat_IO301.
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6 Add the Simulink Real-Time interface subsystem to the model (see
“Simulink® Real-Time™ Interface Subsystem Integration” on page 1-22).

7 Build and download the application to the Speedgoat target machine.

8 When you start the target application, simulation updates occur when the
application receives an interrupt from the FPGA I/O board.
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FPGA Synchronization Modes
In Simulink Real-Time, an FPGA operates in three synchronization modes:

• Free running

• Coprocessing blocking

• Coprocessing nonblocking with delay

• Free running (default) — The CPU and the FPGA each run
nonsynchronized, continuously, and in parallel. When you want the CPU
to run continuously without interrupts, select this mode. For example,
you could select this mode when the model is processing continuous PWM
output.

The Speedgoat target machine CPU strobes data out of the FPGA, reads
the results from the FPGA outputs, writes data to the FPGA inputs, and
strobes the data into the FPGA.

FPGA

Send Read Strobe

Target 
CPU

Latch FPGA Data into Outputs

Read Data from Outputs

Write Input Data to Inputs

Send Write Strobe

Latch Input Data into FPGA

Send Read Strobe

Latch FPGA Data into Outputs

Sa
m

pl
e 

Ti
m

e
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• Coprocessing blocking— The CPU and the FPGA run synchronized
and in tandem. When the FPGA execution time is short compared to
the Speedgoat target machine sample time, and you want the FPGA to
complete before the model continues, select this coprocessor mode.

The CPU writes data to the FPGA inputs, strobes the data into the FPGA,
waits for the FPGA to finish executing, and reads the result out of the
FPGA outputs.

FPGA

Detect Done

Target 
CPU

Latch FPGA Data into Outputs

Read Data from Outputs

Write Input Data to Inputs

Send Write Strobe

Latch Input Data into FPGA

Write Input Data to Inputs

Assert DoneSa
m

pl
e 

Ti
m

e

• Coprocessing nonblocking with delay — The CPU and the FPGA
run synchronized and in tandem. When the FPGA execution time is
long compared to the Speedgoat target machine sample time, select this
coprocessor mode. For example, you could select this mode to manage
multiple FPGAs effectively in parallel.

The CPU waits for the FPGA to finish executing, reads the data from the
previous time step, writes new data to the FPGA inputs, and strobes the
data into the FPGA.
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FPGA
Target 

CPU

Read Data from Outputs

Write Input Data to Inputs
Sa

m
pl

e 
Ti

m
e

Latch FPGA Data into Outputs

Detect Done Assert Done

Latch FPGA Data into Outputs

Detect Done Assert Done

Send Write Strobe

Latch Input Data into FPGA
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Vector CANape Support

This topic describes how to use Simulink Real-Time to interface the
target computer to the Vector CAN Application Environment (CANape®)
(http://www.vector-worldwide.com) using the Universal Calibration
Protocol (XCP). This documentation includes the following topics:

• “Vector CANape” on page 2-2

• “Configuring the Model for Vector CANape” on page 2-4

• “Event Mode Data Acquisition” on page 2-11

http://www.vector-worldwide.com 
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Vector CANape

In this section...

“Vector CANape Basics” on page 2-2

“Simulink® Real-Time™ and Vector CANape Limitations” on page 2-3

Vector CANape Basics
You can use a target computer as an electronic control unit (ECU) for a Vector
CANape system. Using a target computer in this way, a Vector CANape
system can read signals and parameters from a target application running on
the target computer.

The Simulink Real-Time software supports polling and event driven modes
for data acquisition. Polling mode data acquisition is straightforward. Event
mode data acquisition requires additional settings (see “Event Mode Data
Acquisition” on page 2-11).

Note This documentation describes how to configure Simulink Real-Time
and Vector CANape software to work together. It also assumes
that you are familiar with the Vector CANape product family. See
http://www.vector-cantech.com for further information about the Vector
CANape products.

The Simulink Real-Time software works with Vector CANape version 5.6 and
higher. To enable a target computer to work with Vector CANape software,
you need to:

• Configure Vector CANape to communicate with the Simulink Real-Time
software as an ECU.

• Enable the Simulink Real-Time software to generate a target application
that can provide data compliant with Vector CANape.

• Provide a standard TCP/IP physical layer between the host computer
and target computer. The Simulink Real-Time software supports Vector
CANape only through TCP/IP.

2-2
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To support the XCP communication layer, the Simulink Real-Time software
provides:

• An XCP server process in the target application that runs on-demand in
the background.

• A generator that produces A2L (ASAP2) files that Vector CANape can load
into the Vector CANape software database. The generated file contains
signal and parameter access information for the target application.

Simulink Real-Time and Vector CANape Limitations
The Simulink Real-Time software supports the ability to acquire signal data
at the base sample rate of the model. The Simulink Real-Time software does
not support the following for Vector CANape:

• Vector CANape start and stop ECU (target computer) commands

Tip To start and stop the application on the target computer, use the
Simulink Real-Time start and stop commands, for example tg.start,
tg.stop.

• Vector CANape calibration commands or flash RAM calibration commands

• Multiple simultaneous Vector CANape connections to a single target
computer
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Configuring the Model for Vector CANape

In this section...

“Setting Up and Building the Model” on page 2-4

“Creating a New Vector CANape Project” on page 2-6

“Configuring the Vector CANape Device” on page 2-6

“Providing A2L (ASAP2) Files for Vector CANape” on page 2-9

Setting Up and Building the Model
Set up your model to work with Vector CANape. The following procedure
uses the xpcosc model. It assumes that you have already configured your
model to generate Simulink Real-Time code. If you have not done so, see
“Set Configuration Parameters” and “Simulink® Real-Time™ Options
Configuration Parameters” on page 4-3. It also assumes that you have already
created a Vector CANape project. If you have not done so, see “Creating a
New Vector CANape Project” on page 2-6.

1 In the MATLAB® Command Window, type

xpcosc

2 Open the Simulink Real-Time library. For example, in the MATLAB
window, type

slrtlib

3 Navigate to the Displays and Logging sublibrary and double-click that
library.

4 Drag the XCP Server block to the xpcosc model.

This block enables an XCP server process to run in the target application.

5 In the model, double-click the XCP Server block. Check the following
parameters:

• Target Address— Target IP address for target computer. The default
value is slrtGetTargetSettings(`TcpIpTargetAddress'). Typically,
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you will want to leave the default entry. Otherwise, enter the TCP/IP
address for the target computer.

• Server Port— Port for communication between target computer and
XCP server. The default value is 5555. This value must be the same as
the port number you specify for the Vector MATLAB device.

6 If you want to use the event mode to acquire signal data, set the priority
of the xcpserver block to be the lowest priority. For example, enter a
priority of 10000000. For Simulink blocks, the higher the priority number,
the lower the priority.

7 In the model Simulink window, click Simulation > Model Configuration
Parameters.

The Configuration Parameters dialog box is displayed for the model.

8 In the left pane, click the Simulink Real-Time Options node.

The associated pane is displayed.

9 In the Miscellaneous options area, select the Generate CANape
extensions check box.

This option enables target applications to generate data, such as that for
A2L (ASAP2), for Vector CANape.

10 Build the model.

The Simulink Real-Time software builds the target application, including
an A2L (ASAP2) data file for the target application.

11 On the target computer monitor, look for the following message. These
messages indicate that you have built the target application without
producing an error and can now connect to the target with Vector CANape.

XCP Server set up, waiting for connection

You can now create a new Vector CANape project (see “Creating a New Vector
CANape Project” on page 2-6.
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Creating a New Vector CANape Project
This procedure describes how to create a new Vector CANape project that can
communicate with an Simulink Real-Time application. It assumes that you
have set up, built, and downloaded your model (see “Setting Up and Building
the Model” on page 2-4).

1 In a DOS window, create a new folder to hold your project. This can be the
same folder as your Simulink Real-Time model files. For example, type

mkdir C:\MyProject

2 Start Vector CANape.

3 Select File > New project.

A new project wizard is displayed. Follow this dialog to create a new project.

4 After you create the new project, start it.

After the preliminary warning, the CANape window is displayed.

You can now configure the target computer and the loaded target application
as a Vector CANape device (see “Configuring the Model for Vector CANape”
on page 2-4).

Configuring the Vector CANape Device
This procedure describes how to configure the Vector CANape Device to work
with your target application. It assumes the following:

• You have created a new Vector CANape project to associate with a
particular target application. If you have not yet done so, see “Creating a
New Vector CANape Project” on page 2-6.

• You have set up, built, and downloaded your model. If you have not yet
done so, see “Setting Up and Building the Model” on page 2-4.

1 If you have not yet started your new Vector CANape project, start it now.

The Vector CANape window is displayed.
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2 In the CANape window, click Device > Device configuration.

The device configuration window is displayed.

3 In the device configuration window, click New.

4 In Device Name, enter a name for the device to describe your target
application. For example, type

SimulinkRealTime

Add the required comments.

5 Click Next.

6 From the driver-type menu list, select XCP.

7 Click Driver settings.

The XCP driver settings window is displayed.

8 In the Transport layer pane, from the Interface menu list, select TCP.

9 In the Transport layer pane, click Configuration.

10 In the Host field, enter the IP address of your target computer.

This is the target computer to which you have downloaded the target
application.

11 Set the port number to 5555.

12 Click OK.

13 If you have Vector CANape Version 5.6.32.3 and higher, and you want to
use the Simulink Real-Time software to acquire event driven data:

a In the Driver pane of the XCP driver settings window, click Extended
driver settings.

b Set the ODT_ENTRY_ADDRESS_OPT_DISABLED parameter to Yes.

2-7



2 Vector CANape® Support

With this setting, events that are generated in the Simulink Real-Time
environment will be based on the model base sample time. For example,
a sample time of 0.001 seconds will appear as 100 milliseconds.

c Click OK.

14 In the XCP driver settings window, verify the connection to the target
computer by clicking Test connection. This command succeeds only if the
target computer is running and connected to exactly one host computer.

15 Click OK.

The Device dialog is displayed.

16 Click Next.

Do not exit the dialog.

You can now configure the location of the target application A2L (ASAP2) file
for the CANape database. See “Configuring the Location of the A2L (ASAP2)
File” on page 2-8.

If you want to load a new target application, you must close Vector CANape,
download a new target application through the MATLAB interface, then
restart Vector CANape.

Configuring the Location of the A2L (ASAP2) File
Use this procedure to configure the location of the target application A2L
(ASAP2) file for Vector CANape. This procedure assumes that you have
already configured the Vector CANape device and are still in the device
configuration dialog.

1 Clear Automatic detection of the database name.

2 At the Database name parameter, click Browse.

The Select database dialog box for device SimulinkRealTime is displayed.

3 Browse to the folder that contains the A2L (ASAP2) file for the target
application.
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This might be the folder in which you built the target application, or
it might be the folder you specified during the target application build
configuration.

4 Select the A2L (ASAP2) file. Click Open.

A dialog requests confirmation of ASAP2 settings.

5 Click Yes.

6 Click Next.

7 Click Next.

8 Click Next.

9 Click OK.

10 You have completed the configuration of Vector CANape for the Simulink
Real-Time software environment.

You can now monitor and control your Simulink Real-Time system. The
CANape database should be populated with a comprehensive list of target
application signals and parameters that are available. See “Event Mode Data
Acquisition” on page 2-11.

During target application changes, you might need to manually reload the
A2L (ASAP2) that is generated by the Simulink Real-Time build process. You
can do this from the CANape Database editor.

Providing A2L (ASAP2) Files for Vector CANape
This topic assumes that:

• You have set up and built your model to generate data for Vector CANape.
If you have not yet done so, see “Setting Up and Building the Model” on
page 2-4.

• You have created a Vector CANape project folder and know the name of
that project folder.

To enable Vector CANape to load the A2L (ASAP2) file for the model xpcosc:

2-9



2 Vector CANape® Support

1 In a DOS window, change folder to the one that contains the A2L (ASAP2)
file from the previous procedure. For example:

cd D:\work\xpc

2 Look for and copy the A2L (ASAP2) file to your Vector CANape project
folder. For example:

copy xpcosc.a2l C:\MyProject

Vector CANape automatically loads the target application A2L (ASAP2) file
when it connects to the target computer.
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Event Mode Data Acquisition

In this section...

“Guidelines” on page 2-11

“Limitations” on page 2-11

Guidelines
To acquire event mode data rather than polling data, note the following
guidelines:

• Set the priority of the xcpserver block to the lowest possible. See suggested
priority values in “Setting Up and Building the Model” on page 2-4.

• The Simulink Real-Time software generates events at the base sample
rate; this execution rate is the fastest possible. If you are tracing a signal
that is updated at a slower rate than the base sample rate, you must
decimate the data to match the actual execution. (The Simulink Real-Time
software generates the event name with the ASAP2 generation during
model code generation.)

• You can associate signals with the event generation through the Vector
CANape graphical user interface.

See the Vector CANape documentation for further details on associating
events with signals.

Limitations
The event mode data acquisition has the following limitations:

• Every piece of data that the Simulink Real-Time software adds to the event
list slows down the target application. The amount of data that you can
observe depends on the model sample time and the speed of the target
computer. It is possible to overload the target computer CPU to the point
where data integrity is reduced.

• You can only trace signals and scalar parameters. You cannot trace vector
parameters.
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Fortran S-Functions
The Simulink Real-Time product supports Fortran in Simulink models using
S-functions. For more details, see “Create Level-2 Fortran S-Functions” and
“Port Legacy Code”.

In this section...

“Prerequisites” on page 3-2

“Simulink Demos Folder” on page 3-2

“Steps to Incorporate Fortran” on page 3-3

Prerequisites
You must have Simulink Real-Time Version 1.3 or later to use Fortran for
Simulink Real-Time applications. The Simulink Real-Time product supports
the Fortran compiler(s) listed here:

http://www.mathworks.com/support/compilers/current_release/

Simulink Demos Folder
The Simulink demos folder contains a tutorial and description on how to
incorporate Fortran code into a Simulink model using S-functions. To access
the tutorial and description,

1 In the MATLAB Command Window, type

demos

A list of MATLAB products appears on the left side of the MATLAB Online
Help window.

2 From the left side of the window, select Simulink > Demos > Modeling
Features.

A list of Simulink examples appears.

3 Click Custom Code and Hand Coded Blocks using the S-function
API.
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The associated Simulink examples page opens.

4 Click Open this model.

S-function examples are displayed.

5 Double-click the Fortran S-functions block.

Fortran S-functions and associated templates appear.

Steps to Incorporate Fortran
This topic lists the general steps to incorporate Fortran code into an Simulink
Real-Time application. Detailed commands follow in the accompanying
examples.

1 Using the Fortran compiler, compile the Fortran code (subroutines (*.f)).
You will need to specify particular compiler options.

2 Write a Simulink C-MEX wrapper S-function. This wrapper S-function
calls one or more of the Fortran subroutines in the compiled Fortran object
code from step 1.

3 Use the mex function to compile this C-MEX S-function using a Microsoft®

Visual C/C++ compiler. Define several Fortran run-time libraries to be
linked in.

This step creates the Simulink S-function MEX-file.

4 Run a simulation C-MEX file with the Simulink software to validate the
compiled Fortran code and wrapper S-function.

5 Copy relevant Fortran run-time libraries to the application build folder for
the Simulink Real-Time application build.

6 Define the Fortran libraries, and the Fortran object files from step 1, in
the Simulink Coder™ dialog box of the Simulink model. You must define
these libraries and files as additional components to be linked in when the
Simulink Real-Time application link stage takes place.
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7 Initiate the Simulink Real-Time specific Simulink Coder build procedure
for the example model. Simulink Coder builds and downloads Simulink
Real-Time onto the target computer.
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Fortran Atmosphere Model
This example uses the example Atmosphere model that comes with the
Simulink product. The following procedures require you to know how to
write Fortran code according to Simulink and Simulink Real-Time software
requirements.

Before you start, create an Simulink Real-Time Simulink model for the
Atmosphere model. See “Creating a Fortran Atmosphere Model” on page 3-5.

In this section...

“Creating a Fortran Atmosphere Model” on page 3-5

“Compiling Fortran Files” on page 3-7

“Creating a C-MEX Wrapper S-Function” on page 3-8

“Compiling and Linking the Wrapper S-Function” on page 3-12

“Validating the Fortran Code and Wrapper S-Function” on page 3-13

“Preparing the Model for the Simulink® Real-Time™ Application Build”
on page 3-14

“Building and Running the Simulink® Real-Time™ Application” on page
3-16

Creating a Fortran Atmosphere Model
To create an Simulink Real-Time Atmosphere model in Fortran, you need
to add an Simulink Real-Time Scope block to the sfcndemo_atmos model.
Perform this procedure if you do not already have an Simulink Real-Time
Atmosphere model for Fortran.

1 From the MATLAB window, change folder to the working folder, for
example, xpc_fortran_test.
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2 Type

sfcndemo_atmos

The sfcndemo_atmos model is displayed.

3 Add an Simulink Real-Time Scope block of type Target.

4 Connect this Scope block to the Tamb, K signal.

The model sfcndemo_atmos should look like the figure shown.

5 Double-click the target Scope block.

6 From the Scope mode parameter, choose Graphical rolling.

7 For the Number of samples parameter, enter 240.

8 Click Apply, then OK.

9 Double-click the Sine Wave block.
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10 For the Sample time parameter, enter 0.05.

11 Click OK.

12 From the File menu, click Save as. Browse to your current working folder,
for example, xpc_fortran_test. Enter a filename. For example, enter
fortran_atmos_xpc and then click Save.

Your next task is to compile Fortran code. See “Compiling Fortran Files”
on page 3-7.

Compiling Fortran Files

1 In the MATLAB Command Window, copy the file sfun_atmos_sub.F into
your Fortran working folder, for example, xpc_fortran_test. This is
sample Fortran code that implements a subroutine for the Atmosphere
model.

2 From Fortran_compiler_dir\lib\ia32, copy the following files to the
working folder:

• libifcore.lib

• libifcoremd.lib

• ifconsol.lib

• libifportmd.lib

• libifport.lib

• libmmd.lib

• libm.lib

• libirc.lib

• libmmt.lib

• libifcoremt.lib

• svml_disp.lib

3 From a DOS prompt, change folder to the working folder and create the
object file. For example:
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ifort /fpp /Qprec /c /nologo /MT /fixed /iface:cref -Ox sfun_atmos_sub.F

Your next task is to create a wrapper S-function. See “Creating a C-MEX
Wrapper S-Function” on page 3-8.

Creating a C-MEX Wrapper S-Function
This topic describes how to create a C-MEX wrapper S-function for the
Fortran code in sfun_atmos_sub.f. This function is a level 2 S-function. It
incorporates existing Fortran code into a Simulink S-function block and lets
you execute Fortran code from the Simulink software. Before you start:

• Compile your Fortran code. See “Compiling Fortran Files” on page 3-7.

• Become familiar with the guidelines and calling conventions for Simulink
Fortran level 2 S-functions (see “Create Level-2 Fortran S-Functions”).

• Implement the required callback functions using standard functions to
access the fields of the S-function’s simulation data structure,SimStruct
(see “Templates for C S-Functions”).

The following procedure outlines the steps to create a C-MEX wrapper
S-function to work with sfun_atmos_sub.f. It uses the template file
sfuntmpl_gate_fortran.c.

Note This topic describes how to create a level 2 Fortran S-function for the
fortran_atmos_xpc model. This file is also provided in sfun_atmos.c.

1 Copy the file sfuntmpl_gate_fortran.c to your working folder.

This is your C-MEX file for calling into your Fortran subroutine. It works
with a simple Fortran subroutine.

2 With a text editor of your choice, open sfuntmpl_gate_fortran.c.

3 Inspect the file. This is a self-documenting file.

This file contains placeholders for standard Fortran level 2 S-functions,
such as the S-function name specification and Simulink callback methods.
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4 In the #define S_FUNCTION_NAME definition, add the name of your
S-function. For example, edit the definition line to look like

#define S_FUNCTION_NAME sfun_atmos

5 In the file, read the commented documentation for fixed-step and
variable-step fixed algorithm support.

6 Delete or comment out the code for fixed-step and variable-step
fixed-algorithm support. You do not need these definitions for this example.

7 Find the line that begins extern void nameofsub_. Specify the function
prototype for the Fortran subroutine. For the sfun_atmos_sub.obj
executable, the Fortran subroutine is atmos_. Replace

extern void nameofsub_(float *sampleArgs, float *sampleOutput);

with

extern void atmos_(float *falt, float *fsigma, float *fdelta, float *ftheta);

Enter a #if defined/#endif statement like the following for Windows®

compilers.

#ifdef _WIN32
#define atmos_ atmos
#endif

8 Add a typedef to specify the parameters for the block. For example,

typedef enum {T0_IDX=0, P0_IDX, R0_IDX, NUM_SPARAMS } paramIndices;

#define T0(S) (ssGetSFcnParam(S, T0_IDX))

#define P0(S) (ssGetSFcnParam(S, P0_IDX))

#define R0(S) (ssGetSFcnParam(S, R0_IDX))

9 Use the mdlInitializeSizes callback to specify the number of inputs,
outputs, states, parameters, and other characteristics of the S-function.
S-function callback methods use SimStruct functions to store and retrieve
information about an S-function. Be sure to specify the temperature,
pressure, and density parameters. For example,

static void mdlInitializeSizes(SimStruct *S)
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{

ssSetNumSFcnParams(S,NUM_SPARAMS); /* expected number */

#if defined(MATLAB_MEX_FILE)

if (ssGetNumSFcnParams(S) != ssGetSFcnParamsCount(S)) goto EXIT_POINT;

#endif

{

int iParam = 0;

int nParam = ssGetNumSFcnParams(S);

for ( iParam = 0; iParam < nParam; iParam++ )

{

ssSetSFcnParamTunable( S, iParam, SS_PRM_SIM_ONLY_TUNABLE );

}

}

ssSetNumContStates( S, 0 );

ssSetNumDiscStates( S, 0 );

ssSetNumInputPorts(S, 1);

ssSetInputPortWidth(S, 0, 3);

ssSetInputPortDirectFeedThrough(S, 0, 1);

ssSetInputPortRequiredContiguous(S, 0, 1);

ssSetNumOutputPorts(S, 3);

ssSetOutputPortWidth(S, 0, 3); /* temperature */

ssSetOutputPortWidth(S, 1, 3); /* pressure */

ssSetOutputPortWidth(S, 2, 3); /* density */

#if defined(MATLAB_MEX_FILE)

EXIT_POINT:

#endif

return;

}

10 Use the mdlInitializeSampleTimes callback to specify the sample rates
at which this S-function operates.

static void mdlInitializeSampleTimes(SimStruct *S)
{

ssSetSampleTime(S, 0, INHERITED_SAMPLE_TIME);
ssSetOffsetTime(S, 0, 0.0);
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ssSetModelReferenceSampleTimeDefaultInheritance(S);
}

11 Use the mdlOutputs callback to compute the signals that this block emits.

static void mdlOutputs(SimStruct *S, int_T tid)
{

double *alt = (double *) ssGetInputPortSignal(S,0);
double *T = (double *) ssGetOutputPortRealSignal(S,0);
double *P = (double *) ssGetOutputPortRealSignal(S,1);
double *rho = (double *) ssGetOutputPortRealSignal(S,2);
int w = ssGetInputPortWidth(S,0);
int k;
float falt, fsigma, fdelta, ftheta;

for (k=0; k<w; k++) {

/* set the input value */
falt = (float) alt[k];

/* call the Fortran routine using pass-by-reference */
atmos_(&falt, &fsigma, &fdelta, &ftheta);

/* format the outputs using the reference parameters */
T[k] = mxGetScalar(T0(S)) * (double) ftheta;
P[k] = mxGetScalar(P0(S)) * (double) fdelta;
rho[k] = mxGetScalar(R0(S)) * (double) fsigma;

}
}

12 Use the mdlTerminate callback to perform the actions required at
termination of the simulation. Even if you do not have require such
operations, you must include a stub for this callback.

static void mdlTerminate(SimStruct *S)
{
}

13 In the file, read the commented documentation for the following callbacks:
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• mdlInitalizeConditions — Initializes the state vectors of this
S-function.

• mdlStart— Initializes the state vectors of this S-function. This function
is called once at the start of the model execution.

• mdlUpdate — Updates the states of a block.

These are optional callbacks that you can define for later projects. You do
not need to specify these callbacks for this example.

14 Delete or comment out the code for these callbacks.

15 Save the file under another name. For example, save this file as
sfun_atmos.c. Do not overwrite the template file.

16 Copy the file sfun_atmos.c into your Fortran working folder, for example,
xpc_fortran_test.

Your next task is to compile and link the wrapper S-function. See “Compiling
and Linking the Wrapper S-Function” on page 3-12.

Compiling and Linking the Wrapper S-Function
This topic describes how to create (compile and link) a C-MEX S-function
from the sfun_atmos.c file. Before you start, copy the following files into the
working folder, xpc_fortran_test. (You should have copied these files when
you performed the steps in “Compiling Fortran Files” on page 3-7.)

• libifcore.lib

• libifcoremd.lib

• ifconsol.lib

• libifportmd.lib

• libifport.lib

• libmmd.lib

• libm.lib

• libirc.lib

• libmmt.lib
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• libifcoremt.lib

• svml_disp.lib

Use the mex command with a C/C++ compiler such as Microsoft Visual C++®

Version 6.0.

This topic assumes that you have created a C-MEX wrapper S-function. See
“Creating a C-MEX Wrapper S-Function” on page 3-8.

Invoking the mex command requires you to compile the wrapper C file
sfun_atmos.c. Be sure to link in the following:

• Compiled Fortran code: sfun_atmos_sub.obj

• Fortran run-time libraries to resolve external function references and
provide the Fortran run-time environment

When you are ready, mex the code. For example

mex -v LINKFLAGS="$LINKFLAGS /NODEFAULTLIB:libcmt.lib libifcoremd.lib

ifconsol.lib libifportmd.lib libmmd.lib libirc.lib svml_disp.lib" sfun_atmos.c

sfun_atmos_sub.obj

Note The command and all its parameters must be on one line.

This command compiles and links the sfun_atmos_sub.c file. It creates the
sfun_atmos.mex file in the same folder.

Your next task is to validate the Fortran code and wrapper S-function. See
“Validating the Fortran Code and Wrapper S-Function” on page 3-13.

Validating the Fortran Code and Wrapper S-Function
Validate the generated C-MEX S-function, sfun_atmos.mex. Bind the C-MEX
S-function to an S-function block found in the Simulink block library. You
can mask the S-function block like other S-function blocks to give it a specific
dialog box.
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This topic assumes that you have compiled and linked a wrapper S-function.
See “Compiling and Linking the Wrapper S-Function” on page 3-12.

The Atmosphere model example has a Simulink model associated with it.

1 In the MATLAB window, type

fortran_atmos_xpc

This opens the Simulink model associated with the Atmosphere model.
This model includes an S-function block bound to sfun_atmos.mex.

2 Select Simulation > Run to simulate the model.

3 Examine the behavior of the Atmosphere model by looking at the signals
traced by the Scope block.

Your next task is to prepare the model to build an Simulink Real-Time
application. See “Preparing the Model for the Simulink® Real-Time™
Application Build” on page 3-14.

Preparing the Model for the Simulink Real-Time
Application Build
Before you build the Atmosphere model for Simulink Real-Time, define the
following build dependencies:

• The build procedure has access to sfun_atmos.sub.obj for the link stage.

• The build procedure has access to the Fortran run-time libraries (see
“Compiling and Linking the Wrapper S-Function” on page 3-12) for the
link stage.

This topic assumes that you have validated the Fortran code and wrapper
S-function (see “Validating the Fortran Code and Wrapper S-Function” on
page 3-13).

1 In the MATLAB window, type

fortran_atmos_xpc
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This opens the Simulink model associated with the Atmosphere model.

2 In the Simulink model, click Simulation > Model Configuration
Parameters.

The Configuration Parameters dialog box appears.

3 In the left pane, click the Code Generation node.

The Code Generation pane opens.

4 In the Target selection section, click the Browse button at the System
target file list.

5 Click slrt.tlc.

6 In the Make command field, replace make_rtw with one for the Fortran
compiler.

make_rtw S_FUNCTIONS_LIB="..\sfun_atmos_sub.obj ..\libifcoremt.lib ..\libmmt.lib

..\ifconsol.lib ..\libifport.lib ..\libirc.lib ..\svml_disp.lib"

Note The command and all its parameters must be on one line.

7 Click Apply.

8 Click OK.

9 From the File menu, click Save.

This command requires that the application build folder be the current folder
(one level below the working folder, xpc_fortran_test). Because of this, all
additional dependency designations must start with ..\.

Specify all Fortran object files if your model (S-Function blocks) depends
on more than one file. For this example, you specify the run-time libraries
only once.

Your next task is to build and run the Simulink Real-Time application. See
“Building and Running the Simulink® Real-Time™ Application” on page 3-16.
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Building and Running the Simulink Real-Time
Application
This topic assumes that you have prepared the model to build an Simulink
Real-Time application. See “Preparing the Model for the Simulink®

Real-Time™ Application Build” on page 3-14.

Build and run the Simulink Real-Time application as usual. Be sure that you
have defined Microsoft Visual C++ as the Simulink Real-Time C compiler
using slrtsetCC.

After the build procedure succeeds, Simulink Real-Time automatically
downloads the application to the target computer. The Atmosphere model
already contains an Simulink Real-Time Scope block. This allows you to verify
the behavior of the model. You will be able to compare the signals displayed on
the target screen with the signals obtained earlier by the Simulink simulation
run (see “Validating the Fortran Code and Wrapper S-Function” on page 3-13).
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Simulink Real-Time Options Configuration Parameters
The configuration parameters Simulink Real-Time Options node appears
when you select one of the Simulink Real-Time settings for the System
target file parameter in the Code Generation pane of the Configuration
Parameters dialog box:

• slrt.tlc

Generate system target code for Simulink Real-Time.

• slrtert.tlc

Generate system target code for an Simulink Real-Time using the required
Embedded Coder® software.

The Simulink Real-Time Options node allows you to specify how the
software generates the target application. Before you create (build) a target
application, you might need to enter and select these options. The default
values work well for target application creation.

Tip If you set up your model to Simulink Real-Time Embedded Coder
(slrtert.tlc), you can create a custom Code Replacement Library (CRL).
The CRL must be based upon the Simulink Real-Time BLAS (XPC_BLAS).
For more on CRLs, see:

• “Introduction to Code Replacement Libraries”

• Code Replacement Library (CRL) and Embedded Targets

For more information on the Simulink Real-Time Options node, see
“Configuration Parameters”.
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Simulink Real-Time Explorer Basic Operations
Simulink Real-Time Explorer is a graphical user interface for the Simulink
Real-Time product. It runs on your host computer and provides a single point
of contact for most interactions.

Note Do not use Simulink external mode while Simulink Real-Time Explorer
is running. Use only one interface or the other.

Through Simulink Real-Time Explorer, you can perform basic operations,
such as:

• Add and configure target computers for the Simulink Real-Time software,
up to 64 target computers.

• Create boot DVDs or CDs, removable drives, and network boot images for
particular target computers.

• Connect the target computers for your Simulink Real-Time system to the
host computers.

• Download a prebuilt target application, or DLM, to a target computer.

• Start and stop the application that has been downloaded to the target.

• Add and remove host, target, or file scopes associated with the downloaded
target application.

• Monitor signals.

• Add or remove signals associated with Simulink Real-Time scopes.

• Start and stop scopes.

• Adjust parameter values for the signals while the target application is
running.

To start Simulink Real-Time Explorer, type slrtexplr in the MATLAB
Command Window.

There are four major panes in Simulink Real-Time Explorer:

4-4



Simulink® Real-Time™ Explorer Basic Operations

• Targets pane — The top-left Targets pane lists the targets in your
Simulink Real-Time hierarchy. Under each target are nodes representing
the properties and (if accessible) the file system of the target.

• Applications pane — The bottom left Applications pane lists the target
applications running on the targets. Under each application are nodes
representing the properties, signal and parameter groupings, and (if
available) the model hierarchy of the application.

• Scopes pane — The top right Scopes pane lists the scopes defined on the
active target applications, whether predefined or dynamically created.

• Output pane — The bottom center Output pane receives status messages
from Simulink Real-Time Explorer.

• Center pane — The top center pane displays under separate tabs
information associated with nodes selected in one of the other panes.
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Default Target Computers
When you start Simulink Real-Time Explorer for the first time, it opens a
default node, TargetPC1. You can configure this node for a target computer,
then connect the node to the target computer. If you later build a target
application from a Simulink model, the Simulink Real-Time software builds
and downloads that application the default target computer.

You can add other target computer nodes and designate one of them as the
default target computer instead of the first one. To set a target computer node
as the default, right-click that node and select Set As Default Target from
the context-sensitive menu. The default target computer node is boldface.

If you delete a default target computer node, the target computer node
preceding it becomes the default target computer node. The last target
computer node becomes the default target computer node and cannot be
deleted.

If you want to use the Simulink Real-Time command-line interface to
work with the target computer, you must indicate which target computer
the command is interacting with. If you do not identify a particular target
computer, the Simulink Real-Time software uses the default target computer.

TheSimulinkRealTime target computer environment, manages collective
and individual target computer environments. See “Command-Line Setup”
on page 4-10.

When you instantiate the target object constructor without arguments (for
example, tg=slrt), the constructor uses the communication properties of
the default target computer to communicate with the target computer. The
target computer commands SimulinkRealTime.targetSettings.get and
SimulinkRealTime.targetSettings.set get and set environment properties
for the default target computer only.
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Save Environment Properties
The Simulink Real-Time Explorer environment consists of the property
settings you define for the Targets pane. You can save your settings for
the next session.

1 In the MATLAB Command Window, type slrtexplr.

2 Set properties in the Targets pane.

After you change one or more properties and press Enter, the Save icon
and menu item are available.

3 Click the Save icon in the toolbar.

If you do not explicitly save the environment settings, Simulink Real-Time
Explorer asks on exit if you want to save them.
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Command-Line C Compiler Configuration
To configure the host computer for the C compiler using MATLAB language,
use this procedure.

The command mex -setup sets the default compiler for Simulink Real-Time
builds, provided the MEX compiler is a supported Microsoft compiler. Use
slrtsetCC -setup only if you need to specify different compilers for MEX
and Simulink Real-Time.

1 Install a supported C compiler on the host computer.

For more about the Simulink Real-Time C compiler requirements, see
http://www.mathworks.com/support/compilers/current_release/

2 In the MATLAB Command Window, type:

slrtsetCC setup

The function queries the host computer for C compilers that the Simulink
Real-Time environment supports. It returns output like the following:

Select your compiler for Simulink Real-Time.

[1] Microsoft Visual C++ Compilers 2008 Professional Edition (SP1) in

c:\Program Files (x86)\Microsoft Visual Studio 9.0

[2] Microsoft Visual C++ Compilers 2010 Professional in

C:\Program Files (x86)\Microsoft Visual Studio 10.0

[0] None

Compiler:

3 At the Compiler prompt, enter the number for the compiler that you want
to use. For example, 2.

The function verifies that you have selected the required compiler:

Verify your selection:

Compiler: Microsoft Visual C++ Compilers 2010 Professional
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Command-Line C Compiler Configuration

Location: C:\Program Files (x86)\Microsoft Visual Studio 10.0

Are these correct [y]/n?

4 Type y or press Enter to verify the selection.

4-9



4 Target Application Environment

Command-Line Setup
Use the following procedures to set up the software and hardware
configuration for single- and multiple-target systems.

You must have installed and configured a C compiler and verified the target
computer BIOS settings. If not, see:

• “Command-Line C Compiler Configuration” on page 4-8.

• “BIOS Settings”

1 “Command-Line Ethernet Communication Setup” on page 4-11

2 “Command-Line RS-232 Communication Setup” on page 4-31

3 “Command-Line Target Computer Settings” on page 4-35

4 “Command-Line Target Boot Methods” on page 4-38

The next task is “Run Confidence Test on Configuration”.
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Command-Line Ethernet Communication Setup
On the host computer, set the properties that your host and target computers
require for network communication with multiple target computers. For
serial communication, see “Command-Line RS-232 Communication Setup”
on page 4-31.

• “Command-Line PCI Bus Ethernet Setup” on page 4-12

• “Command-Line USB-to-Ethernet Setup” on page 4-16

The next task is “Command-Line Target Computer Settings” on page 4-35.
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Command-Line PCI Bus Ethernet Setup
If your target computer has a PCI bus, use an Ethernet card for the PCI bus.
The PCI bus has a faster data transfer rate than the other bus types.

Follow these procedures:

1 “PCI Bus Ethernet Hardware” on page 4-13

2 “Command-Line PCI Bus Ethernet Settings” on page 4-14

The next task is “Command-Line Target Computer Settings” on page 4-35.
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PCI Bus Ethernet Hardware
To install the PCI bus Ethernet card:

1 Acquire a supported PCI bus Ethernet card.

For the most current network communications requirements, see
https://www.mathworks.com/products/xpctarget/supported/xpc-target-support

If you want to start the target computer from the network, the Ethernet
adapter must be compatible with the Preboot eXecution Environment
(PXE) specification.

2 Turn off your target computer.

3 If the target computer already has an unsupported Ethernet card, remove
the card.

4 Plug the supported Ethernet card into a free PCI bus slot.

5 Assign a static IP address to the target computer Ethernet card.

Although the target computer Ethernet card must have a static IP
address, the host computer network adapter card can have a Dynamic
Host Configuration Protocol (DHCP) address and can be accessed from the
network. When using the product with TCP/IP, you must configure the
DHCP server to reserve static IP addresses to prevent these addresses
from being assigned to other systems.

6 Connect your target computer Ethernet card to your LAN using an
unshielded twisted-pair (UTP) cable.

You can directly connect your computers using a crossover UTP cable with
RJ45 connectors. Both computers must have static IP addresses. If the
host computer has a second network adapter card, that card can have a
DHCP address.

The next task is “Command-Line PCI Bus Ethernet Settings” on page 4-14.
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Command-Line PCI Bus Ethernet Settings
After you install the PCI bus Ethernet card, before you can build and
download a target application, you must specify the environment properties
for the host and target computers.

Before you start, ask your system administrator for the following information
for your target computer:

• IP address

• Subnet mask address

• Port number (optional)

• Gateway (optional)

Use the following procedure for target TargetPC1:

1 At the MATLAB prompt, get the environment object for this target
computer and make it the default target:

env = SimulinkRealTime.getTargetSettings('TargetPC1');
env.setAsDefaultTarget;

All other settings will be made to this object.

2 Set the host-target communication type to 'TcpIp':

env.HostTargetComm='TcpIp';

3 Set the IP address for your target computer. For example:

env.TcpIpTargetAddress = '10.10.10.15';

4 Set the subnet mask address of your LAN. For example:

env.TcpIpSubNetMask = '255.255.255.0';

5 Set the TCP/IP port (optional) to a value higher than '20000' and less
than '65536'. For example:

env.TcpIpTargetPort = '22222';

4-14



Command-Line PCI Bus Ethernet Settings

This property is set by default to '22222', a value higher than the reserved
area (telnet, ftp, and so on).

6 Set the TCP/IP gateway (optional) to the gateway required to access the
target computer. For example:

env.TcpIpGateway = '255.255.255.255';

This property is set by default to '255.255.255.255', which means that
you do not use a gateway to connect to your target computer. If you
connect your computers with a crossover cable, leave this property as
'255.255.255.255'.

If you communicate with the target computer from within your LAN, you
might not need to change this setting. If you communicate from a host
computer located in a LAN different from your target computer (especially
via the Internet), you must define a gateway and enter its IP address in
this box.

7 Set the bus type to 'PCI'.

env.TcpIpTargetBusType = 'PCI';

8 Set the target driver to one of '3C90x', 'I8254x', 'I82559', 'NS83815',
'R8139', 'R8168', 'Rhine', 'RTLANCE', or 'Auto' (the default).

env.TcpIpTargetDriver = 'Auto';

For target driver 'Auto', the software determines the target computer
TCP/IP driver from the card installed on the target computer. If no
supported Ethernet card is installed in your target computer, the software
returns an error.

9 If the target computer has multiple Ethernet cards, follow the procedure in
“Command-Line Ethernet Card Selection by Index” on page 4-28.

Repeat this procedure as required for each target computer.

The next task is “Command-Line Target Computer Settings” on page 4-35.

4-15



4 Target Application Environment

Command-Line USB-to-Ethernet Setup
If the target computer has a USB 2.0 port but no supported PCI or ISA
Ethernet card, use a USB-to-Ethernet adapter.

Follow these procedures:

1 “USB-to-Ethernet Hardware” on page 4-17

2 “Command-Line USB-to-Ethernet Settings” on page 4-19

The next task is “Command-Line Target Computer Settings” on page 4-35.

4-16



USB-to-Ethernet Hardware

USB-to-Ethernet Hardware
To install the USB-to-Ethernet adapter:

1 Acquire a supported USB-to-Ethernet adapter.

For the most current network communications requirements, see
https://www.mathworks.com/products/xpctarget/supported/xpc-target-support

If you want to start the target computer from the network, the Ethernet
adapter must be compatible with the Preboot eXecution Environment
(PXE) specification.

2 Turn off your target computer.

3 Plug an Ethernet-to-USB adapter into the USB port on the target.

4 Connect the Ethernet-to-USB adapter to your LAN using an unshielded
twisted-pair (UTP) cable.

5 Assign a static IP address to the target computer USB-to-Ethernet adapter.

Although the target computer Ethernet adapter must have a static IP
address, the host computer network adapter can have a Dynamic Host
Configuration Protocol (DHCP) address and can be accessed from the
network. When using the product with TCP/IP, you must configure the
DHCP server to reserve static IP addresses to prevent these addresses
from being assigned to other systems.

6 Connect your target computer Ethernet adapter to your LAN using an
unshielded twisted-pair (UTP) cable.

You can directly connect your computers using a crossover UTP cable with
RJ45 connectors. Both computers must have static IP addresses. If the
host computer has a second network adapter, that adapter can have a
DHCP address.

Do not connect the host computer USB port to the target computer USB
port using a USB cable. A USB-to-Ethernet adapter plugged into the
target computer USB port behaves like an Ethernet card installed on the
target computer.
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The next task is “Command-Line USB-to-Ethernet Settings” on page 4-19.
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Command-Line USB-to-Ethernet Settings
After you install the USB-to-Ethernet adapter, before you can build and
download a target application, you must specify the environment properties
for the host and target computers.

Before you start, ask your system administrator for the following information
for your target computer:

• IP address

• Subnet mask address

• Port number (optional)

• Gateway (optional)

Use the following procedure for target TargetPC1:

1 At the MATLAB prompt, get the environment object for this target
computer and make it the default target:

env = SimulinkRealTime.getTargetSettings('TargetPC1');
env.setAsDefaultTarget;

All other settings will be made to this object.

2 Set the host-target communication type to 'TcpIp':

env.HostTargetComm='TcpIp';

3 Set the IP address for your target computer. For example:

env.TcpIpTargetAddress = '10.10.10.15';

4 Set the subnet mask address of your LAN. For example:

env.TcpIpSubNetMask = '255.255.255.0';

5 Set the TCP/IP port (optional) to a value higher than '20000' and less
than '65536'. For example:

env.TcpIpTargetPort = '22222';
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This property is set by default to '22222', a value higher than the reserved
area (telnet, ftp, and so on).

6 Set the TCP/IP gateway (optional) to the gateway required to access the
target computer. For example:

env.TcpIpGateway = '255.255.255.255';

This property is set by default to '255.255.255.255', which means that
you do not use a gateway to connect to your target computer. If you
connect your computers with a crossover cable, leave this property as
'255.255.255.255'.

If you communicate with the target computer from within your LAN, you
might not need to change this setting. If you communicate from a host
computer located in a LAN different from your target computer (especially
via the Internet), you must define a gateway and enter its IP address in
this box.

7 Set the bus type to 'USB'.

env.TcpIpTargetBusType = 'USB';

8 Set the target driver to one of 'USBAX772', 'USBAX172', or 'Auto'.

env.TcpIpTargetDriver = 'Auto';

If the target driver is 'Auto', the software sets the driver to 'USBAX772',
the driver most commonly used.

Repeat this procedure as required for each target computer.

The next task is “Command-Line Target Computer Settings” on page 4-35.
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Command-Line ISA Bus Ethernet Setup
Your target computer might not have an available PCI bus slot or USB 2.0
port. In these cases, use an Ethernet card for an ISA bus.

Note Host-target communication using ISA bus Ethernet adapters will be
removed in a future release. Use PCI or USB bus adapters instead.

1 “ISA Bus Ethernet Hardware” on page 4-22

2 “Command-Line ISA Bus Ethernet Settings” on page 4-24

The next task is “Command-Line Target Computer Settings” on page 4-35.
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ISA Bus Ethernet Hardware
To install an ISA bus Ethernet card, perform the following steps:

Note Host-target communication using ISA bus Ethernet adapters will be
removed in a future release. Use PCI or USB bus adapters instead.

1 Acquire a supported ISA bus Ethernet card.

For the most current network communications requirements, see
https://www.mathworks.com/products/xpctarget/supported/xpc-target-support

If you want to start the target computer from the network, the Ethernet
adapter must be compatible with the Preboot eXecution Environment
(PXE) specification.

2 Turn off your target computer.

3 On your ISA bus card, assign an IRQ and I/O-port base address by moving
the jumpers or switches on the card. Write down these settings, because
you must enter them in Simulink Real-Time Explorer.

Set the IRQ line to 5 and the I/O-port base address to around 0x300. If one
of these hardware settings leads to a conflict in your target computer, select
another IRQ or I/O-port base address.

If your ISA bus card does not contain jumpers to set the IRQ line and the
base address, after installation use the utility on the installation disk
supplied with your card to manually assign the IRQ line and base address.

If you use an Ethernet card for an ISA bus within a target computer that
has a PCI bus, after installation you must reserve the chosen IRQ line
number for the Ethernet card in the PCI BIOS. To set up the PCI BIOS,
refer to your BIOS setup documentation.

Do not configure the card as a PnP-ISA device.

4 If the target computer already has an unsupported Ethernet card, remove
the card. Plug the compatible network card into a free ISA bus slot.
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5 Assign a static IP address to the target computer Ethernet card.

Although the target computer Ethernet card must have a static IP
address, the host computer network adapter card can have a Dynamic
Host Configuration Protocol (DHCP) address and can be accessed from the
network. When using the product with TCP/IP, you must configure the
DHCP server to reserve static IP addresses to prevent these addresses
from being assigned to other systems.

6 Connect your target computer Ethernet card to your LAN using an
unshielded twisted-pair (UTP) cable.

You can directly connect your computers using a crossover UTP cable with
RJ45 connectors. Both computers must have static IP addresses. If the
host computer has a second network adapter card, that card can have a
DHCP address.

The next task is “Command-Line ISA Bus Ethernet Settings” on page 4-24.
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Command-Line ISA Bus Ethernet Settings
After you install the ISA bus Ethernet card, before you can build and
download a target application, you must specify the environment properties
for the host and target computers.

Before you start, ask your system administrator for the following information
for your target computer:

• IP address

• Subnet mask address

• Port number (optional)

• Gateway (optional)

Use the following procedure for target TargetPC1:

1 At the MATLAB prompt, get the environment object for this target
computer and make it the default target:

env = SimulinkRealTime.getTargetSettings('TargetPC1');
env.setAsDefaultTarget;

All other settings will be made to this object.

2 Set the host-target communication type to 'TcpIp':

env.HostTargetComm='TcpIp';

3 Set the IP address for your target computer. For example:

env.TcpIpTargetAddress = '10.10.10.15';

4 Set the subnet mask address of your LAN. For example:

env.TcpIpSubNetMask = '255.255.255.0';

5 Set the TCP/IP port (optional) to a value higher than '20000' and less
than '65536'. For example:

env.TcpIpTargetPort = '22222';
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This property is set by default to '22222', a value higher than the reserved
area (telnet, ftp, and so on).

6 Set the TCP/IP gateway (optional) to the gateway required to access the
target computer. For example:

env.TcpIpGateway = '255.255.255.255';

This property is set by default to '255.255.255.255', which means that
you do not use a gateway to connect to your target computer. If you
connect your computers with a crossover cable, leave this property as
'255.255.255.255'.

If you communicate with the target computer from within your LAN, you
might not need to change this setting. If you communicate from a host
computer located in a LAN different from your target computer (especially
via the Internet), you must define a gateway and enter its IP address in
this box.

7 Set the bus type to 'ISA'.

env.TcpIpTargetBusType = 'ISA';

8 Set the target driver to one of 'NE2000' or 'SMC91C9X'. For example:

env.TcpIpTargetDriver = 'NE2000';

Target driver 'Auto' is not supported for bus type 'ISA'.

9 Set the I/O-port base address and IRQ to values that correspond with the
jumper settings or ROM settings on your ISA bus Ethernet card. For
example:

env.TcpIpTargetISAMemPort = '0x300';
env.TcpIpTargetISAIRQ = '5';

Repeat this procedure as required for each target computer.

The next task is “Command-Line Target Computer Settings” on page 4-35.
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Ethernet Card Selection by Index
If the target computer has multiple Ethernet cards, you must specify which
card to use for host-target communication. Use the following procedure to
discover the Ethernet index of the PCI cards on the target computer and
to specify which card to use.

Note For this procedure, you must be able to burn CDs on your host
computer and use Network boot mode for routine target operations.

Use the following procedure for target TargetPC1:

1 At the MATLAB prompt, get the environment object for this target
computer and make it the default target:

env = SimulinkRealTime.getTargetSettings('TargetPC1');
env.setAsDefaultTarget;

All other settings will be made to this object.

2 At the MATLAB prompt, type:

env.ShowHardware = 'on';

3 At the MATLAB prompt, type: slrtexplr.

4 In the Targets pane, expand the target computer node.

5 In the toolbar, click the Target Properties icon .

6 Select Host-to-Target communication and set Target driver to Auto.
If you set Target driver to a specific driver, such as INTEL_I82559, the
kernel displays only information about boards that use that driver.

7 Select Target settings and clear the Graphics mode check box. This
setting causes the kernel to print text only.

8 Select Boot configuration and set Boot mode to CD.

9 Click Create boot disk and follow the prompts to create a new boot disk.
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10 Insert the new boot disk and restart the target computer from the computer
boot switch.

After the start is complete, the target monitor displays information about
the Ethernet cards in the target computer, for example :

index: 0, driver: RTLANCE, Bus: 16, Slot: 7, Func: 0
index: 1, driver: R8139, Bus: 16, Slot: 8, Func: 0
index: 2, driver: I82559, Bus: 16, Slot: 9, Func: 0

You might need to change the boot order from the target computer BIOS to
allow starting from your disk. After the kernel starts with ShowHardware
'on', the host computer cannot communicate with the target computer.

11 Note the index of the Ethernet card that you want to use for host-target
communication, for example, 2.

12 At the MATLAB prompt, type:

env.ShowHardware = 'off';
env.EthernetIndex = '#';

# is the index of the Ethernet card, for example, 2.

13 Select Target settings and select the Graphics mode check box.

14 Set Boot mode to Network.

15 Click Create boot disk.

16 Remove the boot disk from the target computer drive and start the target
computer from the computer boot switch.

The kernel selects the specified Ethernet card as the target computer card,
instead of the default card with index number 0.

Repeat this procedure as required for each target computer.
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Command-Line Ethernet Card Selection by Index
If you are using multiple target computers that have multiple Ethernet cards,
you must specify which card to use for host-target communication. Use the
following procedure to discover the Ethernet index of the PCI cards on a
specific target and specify which card to use.

Note For this procedure, you must be able to burn CDs on your host
computer and use network boot mode for routine target operations.

Use the following procedure for target TargetPC1:

1 At the MATLAB prompt, get the environment object for this target
computer and make it the default target:

env = SimulinkRealTime.getTargetSettings('TargetPC1');
env.setAsDefaultTarget;

All other settings will be made to this object.

2 At the MATLAB prompt, type:

env.ShowHardware = 'on';

3 Set the Ethernet driver to the default:

env.TcpIpTargetDriver = 'Auto';

If TcpIpTargetDriver is set to a specific driver, such as 'I82559', the
kernel displays only information about boards that use that driver.

4 Set the boot method to CD/DVD boot:

env.TargetBoot='CDBoot';

5 Set the target monitor to print text only:

env.TargetScope = 'Disabled' ;

6 Type SimulinkRealTime.createBootImage.
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The Simulink Real-Time software displays the following message and
creates the CD/DVD boot image.

Current boot mode: CDBoot
CD boot image is successfully created

Insert an empty CD/DVD. Available drives:
[1] d:\
[0] Cancel Burn

7 Insert the new boot disk and restart the target computer from the computer
boot switch.

After the start is complete, the target monitor displays information about
the Ethernet cards in the target computer, for example:

index: 0, driver: RTLANCE, Bus: 16, Slot: 7, Func: 0
index: 1, driver: R8139, Bus: 16, Slot: 8, Func: 0
index: 2, driver: I82559, Bus: 16, Slot: 9, Func: 0

You might need to change the boot order from the target computer BIOS to
allow starting from your disk. After the kernel starts with ShowHardware
'on', the host computer cannot communicate with the target computer.

8 Note the index of the Ethernet card you want to use for host-target
communication, for example, 2.

9 At the MATLAB prompt, type:

env.ShowHardware = 'off';
env.EthernetIndex = '#';

# is the index of the Ethernet card, for example, 2.

10 Set the boot method back to network boot:

env.TargetBoot= 'NetworkBoot';

11 Set the target monitor to graphics mode:

env.TargetScope = 'Enabled' ;

12 Type SimulinkRealTime.createBootImage.
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13 Start the target computer from the computer boot switch.

The kernel selects the specified Ethernet card as the target computer card,
instead of the default card with index number 0.

Repeat this procedure as required for each target computer.
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Command-Line RS-232 Communication Setup
On the host computer, set the properties that your host and target computers
require for serial communication with a single target computer. For network
communication, see “Command-Line Ethernet Communication Setup” on
page 4-11.

Note RS-232 Host-Target communication mode will be removed in a future
release. Use Ethernet instead.

• “RS-232 Hardware” on page 4-32

• “Command-Line RS-232 Settings” on page 4-33

The next task is “Command-Line Target Computer Settings” on page 4-35.
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RS-232 Hardware
Before you can use serial communication for host-target communication, you
must install the following RS-232 hardware:

1 Acquire a null modem cable:

6
7
8
9

9
8
7
6

1
2
3
4
5

5
4
3
2
1

DB9 Female DB9 Female

2 Connect the host and target computers with the null modem cable, using
either the COM1 or COM2 port.

Note which port is in use on the host computer. You need to set the host
computer port in the environment property settings.

The next task is “Command-Line RS-232 Settings” on page 4-33.
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Command-Line RS-232 Settings
After you have installed the serial communication hardware, before you can
build and download a target application, specify the environment properties
for the host and target computers.

• Do not use host scopes and a scope viewer on the host computer to acquire
and display large blocks of data. The slowness of the RS-232 connection
causes large delays for large blocks of data.

• When you use serial communication, boot mode type 'NetworkBoot' is
not supported.

Use the following procedure for target TargetPC1:

1 At the MATLAB prompt, get the environment object for this target
computer and make it the default target:

env = SimulinkRealTime.getTargetSettings('TargetPC1');
env.setAsDefaultTarget;

All other settings will be made to this object.

2 At the MATLAB prompt, set the host-target communication type to
'RS232':

env.HostTargetComm = 'RS232';

3 For host port, select one of 'COM1' or 'COM2'. For example:

env.RS232HostPort = 'COM1';

The default is 'COM1'. Simulink Real-Time selects the target computer
port automatically.

4 Select a baud rate as high as possible. For example:

env.RS232Baudrate = '115200';

The default is 115200. A baud rate less than 38400 can cause
communication failures.
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5 Save the changes to your environment:

tgs.save;

Repeat this procedure as required for each target computer.

The next task is “Command-Line Target Computer Settings” on page 4-35.
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Command-Line Target Computer Settings
To run an Simulink Real-Time model on a target computer, you must
configure the target settings to match the capabilities of the target computer.

Use the following procedure for target TargetPC1:

1 At the MATLAB prompt, get the environment object for this target
computer and make it the default target:

env = SimulinkRealTime.getTargetSettings('TargetPC1');
env.setAsDefaultTarget;

All other settings will be made to this object.

2 Assign the following target computer settings as required:

• Target scope display

– env.TargetScope='Enabled' (the default) — Use if you want to
display information, such as a target scope, in graphic format.

– env.TargetScope='Disabled' — Use if you want to display
information as text.

To use the full features of a target scope, install a keyboard on the target
computer.

• USB support

– env.USBSupport='on' (the default) — Use if you want to use a USB
port on the target computer; for example, to connect a USB mouse.

– env.USBSupport='off' — Otherwise.

• Secondary IDE support

– env.SecondaryIDE='on' — Use only if you want to use the disks
connected to a secondary IDE controller.

– env.SecondaryIDE='off' (the default) — Otherwise.

• Multicore support

env.MulticoreSupport='on' — Use if your target computer has
multicore processors that you want to take advantage of.
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env.MulticoreSupport='off' (the default) — Otherwise.

• Non-Pentium support

env.NonPentiumSupport='on' — Use if your target computer has a
386 or 486 compatible processor.

env.NonPentiumSupport='off' (the default) — Otherwise.

If your target computer has a Pentium or higher compatible processor,
setting this value to 'on' slows the performance of your target computer.

• Target RAM size

env.TargetRAMSizeMB='Auto' (the default) — Use if you want the target
application to read the target computer BIOS and determine the amount
of memory up to a maximum of 2 GB.

env.TargetRAMSizeMB='xxx' — Use if the target application cannot
read the BIOS. You must assign the amount of memory, in megabytes,
up to a maximum of 2 GB.

The Target RAM size parameter defines the total amount of installed
RAM in the target computer available for the kernel, target application,
data logging, and other functions that use the heap.

The Simulink Real-Time kernel can use only 2 GB of memory.

• Maximum model size

env.MaxModelSize='1MB' (the default) — Use if the target application
requires at most this much memory on the target computer.

env.MaxModelSize='4MB' — Otherwise.

Setting Maximum model size takes effect for
env.TargetBoot='StandAlone' only.

Memory not used by the target application is used by the kernel and
by the heap for data logging. Selecting too high a value leaves less
memory for data logging. Selecting too low a value does not reserve
enough memory for the target application and creates an error. You can
approximate the size of the target application by the size of the DLM
file produced by the build process.

Repeat this procedure as required for each target computer.
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The next task is “Command-Line Target Boot Methods” on page 4-38.
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Command-Line Target Boot Methods
You can start your target computer with the Simulink Real-Time kernel using
one of several methods.

Speedgoat systems come with DOS Loader software preinstalled. You can
set up the DOS Loader boot method on your host or configure another boot
method. See your Speedgoat system documentation or follow the link from
“Speedgoat Real-Time Target Machines” for further information.

1 Before creating a boot kernel, perform “Command-Line Kernel Creation
Prechecks” on page 4-39.

2 Select one of the following methods:

• “Command-Line Network Boot Method” on page 4-40

• “Command-Line CD/DVD Boot Method” on page 4-42

• “Command-Line DOS Loader Boot Method” on page 4-44

• “Command-Line Removable Disk Boot Method” on page 4-46

• “Command-Line Standalone Boot Method” on page 4-48.

3 If you select Stand Alone mode, restart the target computer and test your
application in Stand Alone mode. The confidence test is not intended for
standalone execution. You must create and execute your own confidence
test for standalone mode.

Otherwise, the next task is “Run Confidence Test on Configuration”.
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Command-Line Kernel Creation Prechecks
Before creating the target boot kernel, configure your Simulink Real-Time
system. At a minimum, do the following:

1 Check the physical connections between the host computer and the target
computer. If you are using TCP/IP, these are Ethernet connections that
may pass through a LAN.

2 Check your target computer BIOS settings (see “BIOS Settings”).

3 Check that you have write permission for your current working folder.

4 At the MATLAB prompt, get the environment object for this target
computer and make it the default target:

env = SimulinkRealTime.getTargetSettings('TargetPC1');
env.setAsDefaultTarget;

The contents of environment object env are printed in the command
window.

5 Check the host-to-target communication settings. As required, see:

• “Command-Line Ethernet Communication Setup” on page 4-11

• “Command-Line RS-232 Communication Setup” on page 4-31

6 Check that TargetBoot is set to the required value.

Repeat this procedure as required for each target computer.
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Command-Line Network Boot Method
After you have configured the target computer environment parameters, you
can use a dedicated Ethernet network to load and run the Simulink Real-Time
kernel. You do not need a boot CD or removable boot drive.

There are the following limitations:

• Do not use the network boot method on a corporate or nondedicated
network. Doing so might interfere with dynamic host configuration protocol
(DHCP) servers and cause problems with the network.

• Your Ethernet card must be compatible with the Preboot eXecution
Environment (PXE) specification.

• If the target computer and host computer communicate by serial
communication (RS-232), you cannot start the target computer across the
network.

• If Stand Alone mode is enabled, you cannot start the target computer
across the network.

Before you start, establish the required Ethernet connection between host
and target using the procedure in “Command-Line Ethernet Communication
Setup” on page 4-11.

Use the following procedure for target TargetPC1:

1 At the MATLAB prompt, get the environment object for this target
computer and make it the default target:

env = SimulinkRealTime.getTargetSettings('TargetPC1');
env.setAsDefaultTarget;

The contents of environment object env are printed in the command
window. Some properties may already have the required values.

2 Set network boot method:

env.TargetBoot='NetworkBoot'
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3 Set a TCP/IP address. Verify that the subnet of this IP address is the same
as the host computer. Otherwise your network boot fails. For example,
type:

env.TcpIpTargetAddress='10.10.10.11'

4 Set the target computer MAC address (in hexadecimal). For example, type:

env.TargetMACAddress='01:23:45:67:89:ab'

5 In the MATLAB Command Window, type:

SimulinkRealTime.createBootImage

The following message appears:

Current boot mode: NetworkBoot

The software creates and starts a network boot server process on the host
computer. You start the target computer using this process.

A minimized icon ( ) representing the network boot server process
appears on the bottom right of the host computer system tray.

Repeat this procedure as required for each target computer.

The next task is “Run Confidence Test on Configuration”.
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Command-Line CD/DVD Boot Method
After you have configured the target computer environment parameters, you
can use a target boot CD or DVD to load and run the Simulink Real-Time
kernel. This topic describes using the MATLAB command line to create a boot
CD or DVD for a single target computer system. To use this capability, your
host computer must run under one of the following Windows systems:

• Microsoft Windows 7

• Microsoft Windows Vista™

• Microsoft Windows XP Service Pack 2 or 3 with Image Mastering API v2.0
(IMAPIv2.0), available at http://support.microsoft.com/kb/KB932716.

Use the following procedure for target TargetPC1:

1 At the MATLAB prompt, get the environment object for this target
computer and make it the default target:

env = SimulinkRealTime.getTargetSettings('TargetPC1');
env.setAsDefaultTarget;

All other settings will be made to this object.

2 Set the CD boot method:

env.TargetBoot='CDBoot'

3 In the MATLAB window, type SimulinkRealTime.createBootImage.

The Simulink Real-Time software displays the following message and
creates the CD/DVD boot image.

Current boot mode: CDBoot
CD boot image is successfully created

Insert an empty CD/DVD. Available drives:
[1] d:\
[0] Cancel Burn

4 Insert the empty CD or DVD in the host computer.
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5 Type 1 and then press Enter.

6 When the write operation has finished, remove the CD or DVD from the
drive.

7 Insert the bootable CD/DVD into your target computer drive and restart
the target computer.

Repeat this procedure as required for each target computer.

The next task is “Run Confidence Test on Configuration”.
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Command-Line DOS Loader Boot Method
DOS Loader mode allows you to start the Simulink Real-Time kernel on a
target computer from a fixed or removable device with DOS boot capability,
such as a hard disk or flash memory. After starting the target computer,
you can download your application from the host computer over a serial or
network connection between the host and target computers.

Note To run in DOS Loader mode, the target computer boot device must
provide a minimal DOS environment complying with certain restrictions.
For details, see:

• “Create a DOS System Disk”

• “DOS Loader Mode Restrictions”

Use the following procedure for target TargetPC1:

1 At the MATLAB prompt, get the environment object for this target
computer and make it the default target:

env = SimulinkRealTime.getTargetSettings('TargetPC1');
env.setAsDefaultTarget;

All other settings will be made to this object.

2 Set the DOS Loader boot method:

env.TargetBoot = 'DOSLoader';

3 Set DOSLoaderLocation to the folder where you want to create the DOS
Loader boot files. This location can be a local folder on the host computer or
a removable storage device that you use to start the target computer. By
default, the folder is the current working folder.

env.DOSLoaderLocation = 'D:\';

4 In the MATLAB Command Window, type
SimulinkRealTime.createBootImage.
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The Simulink Real-Time software displays the following message:

Current boot mode: DOSLoader
Simulink Real-Time DOS Loader files are successfully created

This operation creates the following boot files in the specified location:

autoexec.bat
xpcboot.com
*.rtb

5 If you create boot files on a local hard disk, copy these files to a floppy disk,
CD/DVD, or other removable storage media.

6 Transfer the boot files to your target computer or insert the removable
media containing the boot files into the target computer drive or USB port.

7 Verify that autoexec.bat file is on the DOS boot path (typically the root
folder).

8 Select the required boot device in the BIOS of the target computer.

9 Start the target computer.

When the target computer starts, it loads DOS, which executes the
autoexec.bat file. This file starts the Simulink Real-Time kernel (*.rtb).
The target computer then awaits commands from the host computer.

Repeat this procedure as required for each target computer.

The next task is “Run Confidence Test on Configuration”.
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Command-Line Removable Disk Boot Method
After you have configured the target computer environment parameters,
you can use a target boot floppy disk, removable drive, or USB flash drive to
load and run the Simulink Real-Time kernel. This topic describes using the
MATLAB command line to create a removable boot disk.

If you are creating a removable boot drive from a USB flash drive, you must
create a bootable partition on the drive before performing this procedure.
See “Create a Bootable Partition”.

Use the following procedure for target TargetPC1:

1 At the MATLAB prompt, get the environment object for this target
computer and make it the default target:

env = SimulinkRealTime.getTargetSettings('TargetPC1');
env.setAsDefaultTarget;

All other settings will be made to this object.

2 In the output of the setAsDefaultTarget command, verify that property
TargetBoot is BootFloppy.

If required, update property TargetBoot, for instance by using the
command env.TargetBoot='BootFloppy'.

3 If you are creating a removable boot disk from a USB drive, insert the USB
drive in the host computer USB port and wait for it to be recognized.

4 In the MATLAB command window, type
SimulinkRealTime.createBootImage.

The Simulink Real-Time software creates the CD/DVD boot image and
displays the following message:

Current boot mode: BootFloppy
Insert a formatted floppy disk into your host PC's
disk drive and press a key to continue
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5 If required, insert an empty removable disk in the host computer drive
and then press a key.

6 When the write operation has finished, remove the removable disk from
the drive or USB port.

7 Insert the removable boot disk into your target computer drive or USB
port and restart the target computer.

Repeat this procedure as required for each target computer.

The next task is “Run Confidence Test on Configuration”.
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Command-Line Standalone Boot Method
Using the MATLAB command line, you can configure the Simulink Real-Time
software to run as a standalone embedded application. For information on
Boot mode Stand Alone, see “Standalone Mode”.

The target computer and its DOS environment must meet specific
requirements to run in Stand Alone mode:

• “Standalone Target Computer Prechecks”

• “Standalone Mode Restrictions”

To set up your target computer for Stand Alone mode:

1 “Command-Line Standalone Settings” on page 4-49

2 “Standalone Target Application Build”

3 “Standalone Target Application Transfer”

4 “Standalone Target Application Boot Configuration”

Continue by restarting the target computer and testing your application in
Stand Alone mode.
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Command-Line Standalone Settings
Use the command line to set the kernel environment properties. When you
are done, you can create a standalone kernel/target application.

For Boot mode Stand Alone, you do not create an Simulink Real-Time boot
disk or network boot image. Instead, you copy files created from the build
process to the target computer hard drive.

Use the following procedure for target TargetPC1:

1 At the MATLAB prompt, get the environment object for this target
computer and make it the default target:

env = SimulinkRealTime.getTargetSettings('TargetPC1');
env.setAsDefaultTarget;

All other settings will be made to this object.

2 Set network boot method:

env.TargetBoot='StandAlone';

Repeat this procedure as required for each target computer.

The next task is “Standalone Target Application Build”.
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Signals and Parameters

Changing parameters in your real-time target application while it is running,
viewing the resulting signal data, and checking the results, are important
prototyping tasks. The Simulink Real-Time software includes command-line
and graphical user interfaces to complete these tasks. This documentation
includes the following topics:

• “Signal Monitoring Basics” on page 5-4

• “Monitor Signals Using Simulink® Real-Time™ Explorer” on page 5-5

• “Monitor Signals Using MATLAB Language” on page 5-8

• “Configure Stateflow States as Test Points” on page 5-9

• “Monitor Stateflow States Using Simulink® Real-Time™ Explorer” on page
5-12

• “Monitor Stateflow States Using MATLAB Language” on page 5-14

• “Animate Stateflow Charts Using Simulink External Mode” on page 5-15

• “Signal Tracing Basics” on page 5-17

• “Configure Real-Time Target Scope Blocks” on page 5-18

• “Simulink® Real-Time™ Scope Usage” on page 5-24

• “Target Scope Usage” on page 5-25

• “Configure Real-Time Host Scope Blocks” on page 5-26

• “Host Scope Usage” on page 5-29

• “Create Target Scopes Using Simulink® Real-Time™ Explorer” on page
5-30

• “Configure Scope Sampling Using Simulink® Real-Time™ Explorer” on
page 5-36
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• “Trigger Scopes Interactively Using Simulink® Real-Time™ Explorer” on
page 5-39

• “Trigger Scopes Noninteractively Using Simulink® Real-Time™ Explorer”
on page 5-42

• “Configure Target Scopes Using Simulink® Real-Time™ Explorer” on page
5-48

• “Create Signal Groups Using Simulink® Real-Time™ Explorer” on page
5-52

• “Create Host Scopes Using Simulink® Real-Time™ Explorer” on page 5-56

• “Configure the Host Scope Viewer” on page 5-61

• “Configure Target Scopes Using MATLAB Language” on page 5-63

• “Trace Signals Using Simulink External Mode” on page 5-67

• “External Mode Usage” on page 5-70

• “Trace Signals Using a Web Browser” on page 5-71

• “Signal Logging Basics” on page 5-73

• “Configure Real-Time File Scope Blocks” on page 5-74

• “File Scope Usage” on page 5-79

• “Create File Scopes Using Simulink® Real-Time™ Explorer” on page 5-81

• “Configure File Scopes Using Simulink® Real-Time™ Explorer” on page
5-86

• “Log Signal Data into Multiple Files” on page 5-90

• “Configure Outport Logging Using Simulink® Real-Time™ Explorer” on
page 5-94

• “Configure Outport Logging Using MATLAB Language” on page 5-98

• “Configure File Scopes Using MATLAB Language” on page 5-103

• “Log Signals Using a Web Browser” on page 5-109

• “Parameter Tuning Basics” on page 5-111

• “Tune Parameters Using Simulink® Real-Time™ Explorer” on page 5-112
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• “Create Parameter Groups Using Simulink® Real-Time™ Explorer” on
page 5-117

• “Tune Parameters Using MATLAB Language” on page 5-120

• “Tune Parameters Using Simulink External Mode” on page 5-123

• “Tune Parameters Using a Web Browser” on page 5-125

• “Save and Reload Parameters Using MATLAB Language” on page 5-126

• “Configure Model to Tune Inlined Parameters” on page 5-129

• “Tune Inlined Parameters Using Simulink® Real-Time™ Explorer” on
page 5-131

• “Tune Inlined Parameters Using MATLAB Language” on page 5-135

• “Nonobservable Signals and Parameters” on page 5-137
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Signal Monitoring Basics
Signal monitoring acquires real-time signal data without time information
during target application execution. There is minimal additional load on the
real-time tasks. Use signal monitoring to acquire signal data without creating
scopes that run on the target computer.

In addition to signal monitoring, Simulink Real-Time enables you to monitor
Stateflow states as test points through the Simulink Real-Time Explorer
and MATLAB command-line interfaces. You designate data or a state in a
Stateflow diagram as a test point, making it observable during execution. You
can work with Stateflow states as you do with Simulink Real-Time signals,
such as monitoring or plotting Stateflow states.

When you monitor signals from referenced models, you must first set the test
point for the signal in the referenced model. The software ignores signal
labels in referenced models.

Note

• Simulink Real-Time Explorer works with multidimensional signals in
column-major format.

• Some signals are not observable. See “Nonobservable Signals and
Parameters” on page 5-137.

You can monitor signals using Simulink Real-Time Explorer and MATLAB
language. You can monitor Stateflow states using Simulink Real-Time
Explorer, MATLAB language, and Simulink External Mode.
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Monitor Signals Using Simulink Real-Time Explorer
This procedure uses the model xpcosc as an example. You must have already
completed the following setup:

1 Built and downloaded the target application to the target computer using

Simulink ( on the toolbar).

2 Run Simulink Real-Time Explorer (command slrtexplr).

3 Connected to the target computer in the Targets pane ( on the toolbar).

4 Set property Stop time to inf in the Applications pane ( on the
toolbar).

To monitor a signal:

1 In Simulink Real-Time Explorer, expand the Model Hierarchy node
under the target application node.

2 To view the signals in the target application, select the model node. On the
toolbar, click the View Signals icon . The Signals workspace opens.

3 To view the value of a signal, in the Signals workspace, select theMonitor
check box for the signal. For instance, select the check boxes for Signal
Generator and Integrator1. The signal values are shown in the
Monitoring Value column.

4 To start execution, click the target application. On the toolbar, click the
Start icon .

5 To stop execution, click the target application. On the toolbar, click the
Stop icon .

The Application Parameters and Signals workspaces look like this figure.
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• To group signals, see “Create Signal Groups Using Simulink® Real-Time™
Explorer” on page 5-52.

• When you are monitoring a signal group, you can change the output format
of the group by selecting one of the options in the Format column.

• To make both workspaces visible at the same time, click and hold the tab
for one workspace and drag it down until the following icon appears in the

middle of the dialog box: . Continue to drag until the cursor reaches the
required quadrant, and then release the mouse button.

• Click File > Save Layout to save your Simulink Real-Time Explorer
window layout. In a later session, you can click File > Restore Layout to
restore your layout.
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• If a block name consists only of spaces, Simulink Real-Time Explorer does
not display a node for or signals from that block. To reference such a block,
provide an alphanumeric name for that block, rebuild and download the
model to the target computer, and reconnect the MATLAB session to the
target computer.
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Monitor Signals Using MATLAB Language
This procedure uses the model xpc_osc3 as an example. You must have
already completed the setup in “Prepare Target Application Using MATLAB
Language”.

1 To get a list of signals, type:

tg.ShowSignals='on'

ShowSignals = on

Signals = INDEX VALUE BLOCK NAME LABEL

0 0.000000 Signal Generator

1 0.000000 Transfer Fcn

If your signal has a unique label, its label is displayed in the Label column.
If the label is not unique, the command returns an error. If the signal label
is in a referenced model, the software ignores it.

2 To get the value of a signal, use the getsignal method. In the MATLAB
Command Window, type:

tg.getsignal(0)

0 is the signal index. the MATLAB interface displays the value of signal 1.

ans=

3.731

See also “Configure Target Scopes Using MATLAB Language” on page 5-63.

Note The Simulink Real-Time software lists referenced model signals with
their full block path. For example, xpc_osc5/childmodel/gain.
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Configure Stateflow States as Test Points
This procedure uses the model old_sf_car as an example. It describes one
way to set Stateflow states as test points for monitoring.

1 In the MATLAB window, type old_sf_car.

2 In the Simulink window, click Simulation > Model Configuration
Parameters.

3 In the Configuration Parameters dialog box, click the Code Generation
node.

4 To build a basic target application, in the Target selection section of the
Code Generation pane, click Browse at the System target file list.
Click slrt.tlc, and then click OK.
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5 In the old_sf_car model, double-click the shift_logic chart.

6 In the shift_logic chart, click Tools > Model Explorer.

7 In the Model Explorer, expand old_sf_car, and then shift_logic.

8 Expand gear_state, and then select first.

9 In the State first pane Logging tab, select the Test point check box. This
selection creates a test point for the first state.

10 Click Apply.
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11 Build and download the old_sf_car target application to the target
computer.

12 View Stateflow states using one of:

• “Monitor Stateflow States Using Simulink® Real-Time™ Explorer” on
page 5-12

• “Monitor Stateflow States Using MATLAB Language” on page 5-14

• “Animate Stateflow Charts Using Simulink External Mode” on page 5-15

You can now view the states with Simulink Real-Time Explorer or the
MATLAB interface.
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Monitor Stateflow States Using Simulink Real-Time
Explorer

You must have already and built and downloaded the application to carry
out this procedure.

This procedure uses the model old_sf_car as an example. You must have
already completed the following setup:

1 Set Stateflow states as test points.

2 Built and downloaded the target application to the target computer using

Simulink ( on the toolbar).

3 Run Simulink Real-Time Explorer (command slrtexplr).

4 Connected to the target computer in the Targets pane ( on the toolbar).

To monitor a test point:

1 In the Applications pane, expand the target application and the Model
Hierarchy node.

2 To view the test point, select shift_logic and click the View Signals
icon on the toolbar.

The Signals workspace opens. The test point gear_state.first appears
like other signals in the Signals workspace.

3 In the Signals workspace, select the Monitor check box for
gear_state.first. The value of the signal is shown in the Monitoring
Value column.

4 To start execution, click the target application. On the toolbar, click the
Start icon .

5 To stop execution, click the target application. On the toolbar, click the
Stop icon .
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The Application Parameters and Signals workspaces look like this figure.

• To group signals, see “Create Signal Groups Using Simulink® Real-Time™
Explorer” on page 5-52.

• When you are monitoring a signal group, you can change the output format
of the group by selecting one of the options in the Format column.

• To make both workspaces visible at the same time, click and hold the tab
for one workspace and drag it down until the following icon appears in the

middle of the dialog box: . Continue to drag until the cursor reaches the
required quadrant, and then release the mouse button.

• Click File > Save Layout to save your Simulink Real-Time Explorer
window layout. In a later session, you can click File > Restore Layout to
restore your layout.
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Monitor Stateflow States Using MATLAB Language
You must have already set Stateflow states as test points. If you have not, see
“Configure Stateflow States as Test Points” on page 5-9.

1 To get a list of signals in the MATLAB Command Window, type:

tg = slrt

2 To display the signals in the target application, type:

tg.ShowSignals='on'

The latter causes the MATLAB window to display a list of the target object
properties for the available signals.

For Stateflow states that you have set as test points, the state appears
in the BLOCK NAME column. For example, if you set a test point for the
first state of gear_state in the shift_logic chart of the old_sf_car
model, the state of interest is first. In the list of signals in the MATLAB
interface, this state appears as follows:

shift_logic:gear_state.first

shift_logic is the path to the Stateflow chart. gear_state.first is the
path to the specific state.
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Animate Stateflow Charts Using Simulink External Mode
The Simulink Real-Time software supports the animation of Stateflow
charts in your model to provide visual verification that your chart behaves
as expected.

You must be familiar with the use of Stateflow animation. For more
information on Stateflow animation, see “Animate Stateflow Charts” in the
Stateflow documentation.

1 In the Simulink Editor window, select Simulation > Mode > External.

2 Select Code > External Mode Control Panel.

3 Select Signal & Triggering.

4 In the Trigger section of the External Signal & Triggering window:

• Set Mode to normal.

• In the Duration box, enter 5.

• Select the Arm when connecting to target check box.

5 Click Apply.

6 Select Simulation > Model Configuration Parameters.

7 Navigate to the Simulink Real-Time Options node.

8 Select the Enable Stateflow animation check box.

9 Click Apply.

10 To build and download the model to the target computer and start the

simulation, click the Run icon on the toolbar.

The simulation begins to run. You can observe the animation by opening
the Stateflow Editor for your model.

11 To stop the simulation, click the Stop icon on the toolbar.
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Note Enabling the animation of Stateflow charts also displays additional
Stateflow information. The Stateflow software requires this information to
animate charts. You can disregard this information.
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Signal Tracing Basics
Signal tracing acquires signal and time data from a target application. You
can then visualize the data on the target computer or upload the data and
visualize it on the host computer while the target application is running.

You trace signals using target and host scopes and view them using Simulink
Real-Time Explorer, Simulink External Mode, MATLAB language, and a
Web browser interface.

Simulink Real-Time Explorer can display multidimensional signals in
column-major format.

Some signals are not observable. See “Nonobservable Signals and
Parameters” on page 5-137.
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Configure Real-Time Target Scope Blocks
Simulink Real-Time includes a specialized Scope block that you can configure
to display signal and time data on the target computer monitor. To do this,
add a Scope block to the model, select Scope type Target, and configure the
other parameters as described in the following procedure.

• Do not confuse Simulink Real-Time Scope blocks with standard Simulink
Scope blocks.

• For more on using Simulink Real-Time Scope blocks, see “Simulink®

Real-Time™ Scope Usage” on page 5-24.

• For more on using target scopes, see “Target Scope Usage” on page 5-25.

• This procedure uses the model xpc_osc2 as an example. To access the
example folder, type:

addpath (fullfile(matlabroot, 'help', 'toolbox', 'xpc',

'examples'));

1 In the MATLAB window, type xpc_osc2.

The Simulink block diagram opens for the model xpc_osc2.

2 Double-click the block labeled Scope.

The Block Parameters: Scope dialog box opens. By default, the target scope
dialog box is displayed.

3 In the Scope number box, a unique number is displayed that identifies
the scope. This number is incremented each time you add a new Simulink
Real-Time Scope block.

This number identifies the Simulink Real-Time Scope block and the scope
screen on the host or target computers.

4 From the Scope type list, select Target if it is not already selected. The
updated dialog box is displayed.
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5 Select the Start scope when application starts check box to start the
scope automatically when the target application executes. The target scope
opens automatically on the target computer monitor.

In Stand Alone mode, this setting is mandatory because the host computer
is not available to issue a command to start scopes.

6 From the Scope mode list, select Numerical, Graphical redraw,
Graphical sliding, or Graphical rolling.

If you have a scope type of Target and a scope mode of Numerical, the
scope block dialog box adds a Numerical format box. You can define the
display format for the data. If you choose not to complete the Numerical
format box, the Simulink Real-Time software displays the signal using the
default format of %15.6f, which is a floating-point format, without a label.

7 If you have selected scope mode Numerical, in the Numerical format box,
type a label and associated numeric format type in which to display signals.
By default, the entry format is floating-point without a label, %15.6f. The
Numerical format box takes entries of the format:

'[LabelN] [%width.precision][type] [LabelX]'

• LabelN is the label for the signal. You can use a different label for each
signal or the same label for each signal. This argument is optional.

• width is the minimum number of characters to offset from the left of the
screen or label. This argument is optional.

• precision is the maximum number of decimal places for the signal
value. This argument is optional.

• type is the data type for the signal format. You can use one or more of
the following types.

Type Description

%e or %E Exponential format using e or E

%f Floating point
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Type Description

%g Signed value printed in f or e format depending on
which is smaller

%G Signed value printed in f or E format depending on
which is smaller

• LabelX is a second label for the signal. You can use a different label for
each signal or the same label for each signal. This argument is optional.

Enclose the contents of the Numerical format text box in single quotation
marks.

For example:

'Foo %15.2f end'

For a whole integer signal value, enter 0 for the precision value. For
example:

'Foo1 %15.0f end'

For a line with multiple entries, delimit each entry with a command and
enclose the entire string in single quotation marks. For example:

'Foo2 %15.6f end,Foo3 %15.6f end2'

You can have multiple Numerical format entries, separated by a comma.
If you enter one entry, that entry applies to each signal (scalar expansion).
If you enter fewer label entries than signals, the first entry applies to the
first signal, the second entry applies to the second signal, and so forth.
The last entry is scalar expanded for the remaining signals. If you have
two entries and one signal, the software ignores the second label entry and
applies the first entry. You can enter as many format entries as you have
signals for the scope. The format string has a maximum length of 100
characters, including spaces, for each signal.

8 Select the Grid check box to display grid lines on the scope. This parameter
is applicable only for target scopes with scope modes of type Graphical
redraw, Graphical sliding, or Graphical rolling.
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9 In the Y-Axis limits box, enter a row vector with two elements. The first
element is the lower limit of the y-axis and the second element is the
upper limit. If you enter 0 for both elements, scaling is set to auto. This
parameter is applicable only for target scopes with scope modes of type
Graphical redraw, Graphical sliding, or Graphical rolling.

10 In the Number of samples box, enter the number of values to be acquired
in a data package.

• If you select a Scope mode of Graphical redraw, the display redraws
the graph every Number of samples.

• If you select a Scope mode of Numerical, the block updates the output
every Number of samples.

• If you select a Trigger mode other than FreeRun, this parameter can
specify the Number of samples to be acquired before the next trigger
event.

11 In the Number of pre/post samples box, enter the number of samples to
save or skip. To save N samples before a trigger event, specify the value N.
To skip N samples after a trigger event, specify the value N. The default is 0.

12 In the Decimation box, enter a value to indicate that data must be
collected at each sample time (1) or at less than every sample time (2 or
greater).

13 From the Trigger mode list, select FreeRun.

• If you select FreeRun or Software Triggering, you do not need to enter
additional parameters.

• If you select Signal Triggering, then enter the following additional
parameters, as required:

– In the Trigger signal box, enter the index of a signal previously
added to the scope.

This parameter does not apply if the Add signal port to connect a
signal trigger source check box is selected.

– (Alternatively) Click the Add signal port to connect a signal
trigger source check box, then connect an arbitrary trigger signal to
the port Trigger signal.
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– In the Trigger level box, enter a value for the signal to cross before
triggering.

– From the Trigger slope list, select one of Either, Rising, or Falling.

• If you select Scope Triggering, then enter the following additional
parameters, as required:

– In the Trigger scope number box, enter the scope number of a
Scope block. If you use this trigger mode, you must also add a second
Scope block to your Simulink model.

– If you want the scope to trigger on a specific sample of the other scope,
enter a value in the text box Sample to trigger on (-1 for end of
acquisition). The default value is 0, and indicates that the triggering
scope and the triggered (current) scope start simultaneously.

For more information on this field, see “Trigger One Scope with
Another Scope” on page 11-24.

The target scope dialog box looks like this figure.
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14 Click OK.

15 From the File menu, click Save As. The model is saved as xpc_osc2.
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Simulink Real-Time Scope Usage
• To monitor an output signal from a Constant block by connecting it to
an Simulink Real-Time Scope block, you must add a test point for the
Constant block output signal.

• You can add an Simulink Real-Time scope only to the topmost model, not to
a referenced model. To log signals from referenced models, use Simulink
Real-Time Explorer scopes or Simulink Real-Time language scope objects.

• When the target application is built and downloaded, the Simulink
Real-Time kernel creates a scope representing the Scope block. To change
Simulink Real-Time Scope parameters after building the target application
or while it is running, assign the scope to a MATLAB variable using the
target object method SimulinkRealTime.target.getscope. If you use
SimulinkRealTime.target.getscope to remove a scope created during
the build and download process, and then restart the target application,
the Simulink Real-Time kernel recreates the scope.

• If the output of a Mux block is connected to the input of an Simulink
Real-Time Scope block, the signal might not be observable. To observe the
signal, add a unity gain block (a Gain block with a gain of 1) between the
Mux block and the Simulink Real-Time Scope block. See “Nonobservable
Signals and Parameters” on page 5-137.
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Target Scope Usage
• Simulink Real-Time supports ten target scopes. Each target scope can
contain up to 10 signals.

• For a target scope, logged data (sc.Data and sc.Time) is not accessible
over the command-line interface on the host computer. This is because
logged data is only accessible when the scope object status (sc.Status) is
set to Finished. When the scope completes one data cycle (time to collect
the number of samples), the scope engine automatically restarts the scope
instead of setting sc.Status to Finished.

If you create a scope object, for example, sc = getscopes(tg,1) for a
target scope, and then try to get the logged data by typing sc.Data, you
get an error message:

Scope # 1 is of type 'Target'! Property Data

is not accessible.

If you want the same data for the same signals on the host computer while
the data is displayed on the target computer, define a second scope object
with type host. Then synchronize the acquisitions of the two scope objects
by setting TriggerMode for the second scope to 'Scope'.
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Configure Real-Time Host Scope Blocks
Simulink Real-Time includes a specialized Scope block that you can configure
to display signal and time data on the host computer monitor. To do this, add
a Scope block to the model, select Scope type to Host and configure the other
parameters as described in the following procedure.

• Do not confuse Simulink Real-Time Scope blocks with standard Simulink
Scope blocks.

• For more on using Simulink Real-Time Scope blocks, see “Simulink®

Real-Time™ Scope Usage” on page 5-24.

• For more on host scopes, see “Host Scope Usage” on page 5-29.

• This procedure uses the model xpc_osc2 as an example. To access the
example folder, type:

addpath (fullfile(matlabroot, 'help', 'toolbox', 'xpc',

'examples'));

1 In the MATLAB window, type xpc_osc2.

The Simulink block diagram opens for the model xpc_osc2.

2 Double-click the block labeled Scope.

The Block Parameters: Scope dialog box opens. By default, the target scope
dialog box is displayed.

3 In the Scope number box, a unique number is displayed that identifies
the scope. This number is incremented each time that you add a new
Simulink Real-Time scope.

This number identifies the Simulink Real-Time Scope block and the scope
screen on the host or target computers.

4 From the Scope type list, select Host. The updated dialog box is displayed.

5 Select the Start scope when application starts check box to start the
scope automatically when the target application executes. You can then
open a host scope viewer window from Simulink Real-Time Explorer.
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In Stand Alone mode, this setting is mandatory because the host computer
is not available to issue a command to start scopes.

6 In the Number of samples box, enter the number of values to be acquired
in a data package.

7 In the Number of pre/post samples box, enter the number of samples to
save or skip. To save N samples before a trigger event, specify the value N.
To skip N samples after a trigger event, specify the value N. The default is 0.

8 In the Decimation box, enter a value to indicate that data must be
collected at each sample time (1) or at less than every sample time (2 or
greater).

9 From the Trigger mode list, select FreeRun.

• If you select FreeRun or Software Triggering, you do not need to enter
additional parameters.

• If you select Signal Triggering, then enter the following additional
parameters, as required:

– In the Trigger signal box, enter the index of a signal previously
added to the scope.

This parameter does not apply if the Add signal port to connect a
signal trigger source check box is selected.

– (Alternatively) Click the Add signal port to connect a signal
trigger source check box, then connect an arbitrary trigger signal to
the port Trigger signal.

– In the Trigger level box, enter a value for the signal to cross before
triggering.

– From the Trigger slope list, select one of Either, Rising, or Falling.

• If you select Scope Triggering, then enter the following additional
parameters, as required:

– In the Trigger scope number box, enter the scope number of a
Scope block. If you use this trigger mode, you must also add a second
Scope block to your Simulink model.

– If you want the scope to trigger on a specific sample of the other scope,
enter a value in the text box Sample to trigger on (-1 for end of
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acquisition). The default value is 0, and indicates that the triggering
scope and the triggered (current) scope start simultaneously.

For more information on this field, see “Trigger One Scope with
Another Scope” on page 11-24.

The host scope dialog box looks like this figure.

10 Click OK.

11 From the File menu, click Save As. The model is saved as xpc_osc2.
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Host Scope Usage
• Simulink Real-Time supports as many host scopes as the target computer
resources can support. Each host scope can contain as many signals as the
target computer resources can support.

• Use host scopes to log signal data triggered by an event while your target
application is running. The host scope acquires the first N samples into a
buffer. You can retrieve this buffer into the scope object property sc.Data.
The scope then stops and waits for you to manually restart the scope.

The number of samples N to log after triggering an event is equal to the
value that you entered in the Number of samples parameter.

Select the type of trigger event in the Block Parameters: Scope dialog box
by setting Trigger Mode to Signal Triggering, Software Triggering,
or Scope Triggering.
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Create Target Scopes Using Simulink Real-Time Explorer
You can create a virtual target scope on the target computer using Simulink
Real-Time Explorer. These scopes have the full capabilities of the Scope block
in Target mode, but do not persist past the current execution.

Note For information on using target scope blocks, see “Configure Real-Time
Target Scope Blocks” on page 5-18 and “Target Scope Usage” on page 5-25.

This procedure uses the model xpcosc as an example. You must have already
completed the following setup:

1 Built and downloaded the target application to the target computer using

Simulink ( on the toolbar).

2 Run Simulink Real-Time Explorer (command slrtexplr).

3 Connected to the target computer in the Targets pane ( on the toolbar).

4 Set property Stop time to inf in the Applications pane ( on the
toolbar).

To configure a virtual target scope:

1 In the Scopes pane, expand the xpcosc node.

2 To add a target scope, select Target Scopes and then click the Add Scope
icon on the toolbar.

The new scope appears under node Target Scopes, for example Scope 1.

3 Select Scope 1 and then click the Properties icon on the toolbar.

4 In the Scope Properties workspace, click Signals. You add signals from
the Applications Signals workspace.
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5 In the Applications pane, expand the target application node and then
node Model Hierarchy.

6 Select the model node and then click the View Signals icon on the
toolbar.

The Signals workspace opens, showing a table of signals with properties
and actions.

7 In the Signals workspace, to add signal Signal Generator to Scope1,
click the down arrow next to the Scopes icon in its Actions column.

A list of scope types appears. Scope 1 appears under node Target Scopes.

8 Click the Add Signal(s) icon next to Scope1 under node Target Scopes.

9 Add signal Integrator1 to Scope 1 in the same way.

The dialog box looks like this figure.
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10 To start execution, click the target application and then click the Start
icon on the toolbar.

The application starts running. No output appears on the target computer
monitor.

11 To start Scope 1, click Scope 1 in the Scopes pane and then click the
Start Scope icon on the toolbar.

Output for signals Signal Generator and Integrator1 appears on the
target computer monitor.

12 To stop Scope 1, click Scope 1 in the Scopes pane and then click the
Stop Scope icon on the toolbar.
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The signals shown on the target computer stop updating while the target
application continues running. The target computer monitor displays a
message like this message:

Scope: 1, set to state 'interrupted'

13 To stop execution, click the target application and then click the Stop
icon on the toolbar.

The target application on the target computer stops running, and the target
computer displays messages like these messages:

minimal TET: 0.0000006 at time 0.001250

maximal TET: 0.0000013 at time 75.405500

The target computer screen looks like this figure.
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• You can create a virtual target scope from the scope types list by clicking
Add Scope next to scope type Target Scopes.

• You can add or remove signals from a virtual target scope while the scope
is either stopped or running.
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• To group signals, see “Create Signal Groups Using Simulink® Real-Time™
Explorer” on page 5-52.

• To configure the target computer display, see “Configure Target Scopes
Using Simulink® Real-Time™ Explorer” on page 5-48.

• To configure data sampling, see “Configure Scope Sampling Using
Simulink® Real-Time™ Explorer” on page 5-36.

• To configure scope triggering, see “Trigger Scopes Interactively Using
Simulink® Real-Time™ Explorer” on page 5-39 and “Trigger Scopes
Noninteractively Using Simulink® Real-Time™ Explorer” on page 5-42.

• To make both workspaces visible at the same time, click and hold the tab
for one workspace and drag it down until the following icon appears in the

middle of the dialog box: . Continue to drag until the cursor reaches the
required quadrant, and then release the mouse button.

• Click File > Save Layout to save your Simulink Real-Time Explorer
window layout. In a later session, you can click File > Restore Layout to
restore your layout.

• If a block is unnamed, Simulink Real-Time Explorer does not display
signals or a node for that block. To reference such a block, provide an
alphanumeric name for that block, rebuild and download the model to
the target computer, and reconnect the MATLAB session to the target
computer.
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Configure Scope Sampling Using Simulink Real-Time
Explorer

You can customize sampling for Simulink Real-Time scopes to facilitate data
access to the running model. You can configure sampling whether you added
a Scope block to the model or added the scope at run time.

This procedure uses the model xpcosc as an example. You must have
already completed the procedure in “Create Target Scopes Using Simulink®

Real-Time™ Explorer” on page 5-30. Target execution and scopes must be
stopped.

1 Select Scope 1 and open the Properties pane ( on the Scopes toolbar).

2 In the Scope 1 properties pane, click Sampling.

3 In the Number of Samples box, enter the number of values to be acquired
in a data package, here 250.

If you select a Display mode of Graphical redraw, the display redraws
the graph every Number of Samples.

If you select a Display mode of Numerical, the block updates the output
every Number of Samples.

If you select a Trigger Mode other than FreeRun, this parameter can
specify the number of samples to be acquired before the next trigger event.
See “Trigger Scopes Interactively Using Simulink® Real-Time™ Explorer”
on page 5-39 and “Trigger Scopes Noninteractively Using Simulink®

Real-Time™ Explorer” on page 5-42.

4 In the Decimation box, enter 10 to indicate that data must be collected at
every 10th sample time. The default is 1, to collect data at every sample
time.

5 In the Number of pre/post samples box, enter the number of samples to
save or skip. To save N samples before a trigger event, specify the value N.
To skip N samples after a trigger event, specify the value N. The default is 0.

The dialog box looks like this figure.
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6 To see the effect of these settings, start execution ( on the Applications
toolbar).

7 Start Scope 1 ( on the toolbar).

Output for signals Signal Generator and Integrator1 appears on the
target computer monitor.
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8 Stop Scope 1 ( on the toolbar).

9 Stop execution ( on the Applications toolbar).
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Trigger Scopes Interactively Using Simulink Real-Time
Explorer

You can customize scope triggering for Simulink Real-Time scopes to facilitate
your interaction with the running model. You can configure triggering
whether you created the scope by adding a Scope block to the model or by
adding the scope at run time.

The following procedures use the model xpcosc as an example. You must have
already completed the procedure in “Create Target Scopes Using Simulink®

Real-Time™ Explorer” on page 5-30. Target execution and scopes must be
stopped.

Freerun Triggering
In Trigger Mode Freerun, the scope triggers automatically as soon as it is
started. It displays data until it is stopped. By default, Trigger Mode is set
to Freerun.

1 Start execution ( on the Applications toolbar).

2 Select Scope 1 and open the Properties pane ( on the Scopes toolbar).

3 In the Scope 1 pane, click Triggering.

4 Select Trigger Mode Freerun.

5 Start and stop Scope 1 ( and on the toolbar).

Signal data is displayed on the target computer monitor when the scope
starts and stops when the scope stops.

6 Stop execution ( on the Applications toolbar).

Software Triggering
In Trigger Mode Software, the scope triggers when you select Scope 1 and
then click the Trigger icon on the toolbar.

1 Start execution ( on the Applications toolbar).
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2 Select Trigger Mode Software.

3 Start Scope 1 ( on the toolbar).

The Trigger icon is enabled on the toolbar.

4 Click the Trigger icon on the Scopes toolbar.

The current signal data is displayed on the target computer monitor when
you click the icon.

5 Stop Scope 1 ( on the toolbar).

The dialog box looks like this figure.

The target monitor looks like this figure.
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6 Stop execution ( on the Applications toolbar).
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Trigger Scopes Noninteractively Using Simulink Real-Time
Explorer

You can customize scope triggering for Simulink Real-Time scopes to facilitate
your control of the running model. You can configure triggering whether you
added a Scope block to the model or added the scope at run time.

The following procedures use the model xpcosc as an example. You must have
already completed the procedure in “Create Target Scopes Using Simulink®

Real-Time™ Explorer” on page 5-30. Target execution and scopes must be
stopped.

Signal Triggering
In Trigger Mode Signal, the scope triggers when a signal rises or falls
through a specified level.

1 Start execution ( on the Applications toolbar).

2 Select Scope 1 and open the Properties pane ( on the Scopes toolbar).

3 In the Scope 1 pane, click Triggering.

4 Select Trigger Mode Signal.

Settings Trigger Signal, Trigger Slope, and Trigger Level appear.

5 Type the number displayed on the target computer screen for Signal
Generator (here, 5) in the Trigger Signal text box.

6 Set Trigger Slope to Rising.

7 Leave Trigger Level as 0, indicating that the signal crosses 0 before
Scope 1 triggers.
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8 Start Scope 1 ( on the toolbar).

Signal data is displayed on the target computer monitor, with the rising
pulse of Signal Generator just beyond the left side.
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9 Stop Scope 1 ( on the toolbar).

10 Stop execution ( on the Applications toolbar).
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Scope Triggering
In Trigger Mode Scope, the scope triggers when another scope triggers. In
this example, Scope 2 triggers when signal-triggered Scope 1 triggers.

1 Start execution ( on the Applications toolbar).

2 Add scope Scope 2 ( on the Scopes toolbar).

3 Open the Signals pane ( on the Applications toolbar).

4 Add signal Integrator to Scope 2 in the Signals pane.

5 In the Scope 2 pane, click Triggering.

6 Select Trigger Mode Scope.

Settings Trigger scope and Trigger scope sample appear.

7 Set Trigger scope to 1. Press Enter. Scope 2 then triggers when Scope
1 triggers.

8 Leave Trigger scope sample set to 0. Scope 2 triggers on the same
sample as Scope 1.
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9 Start both Scope 1 and Scope 2 ( on the toolbar). You must explicitly
start and stop both scopes.

Scope 1 and Scope 2 display signal data on the target computer monitor.
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10 Stop both Scope 1 and Scope 2 ( on the toolbar).

11 Stop execution ( on the Applications toolbar).
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Configure Target Scopes Using Simulink Real-Time
Explorer

You can configure the target scope display to facilitate your view of the signal
data. You can configure the display whether you added a Scope block to the
model or added the scope at run time.

This procedure uses the model xpcosc as an example. You must have
already completed the procedure in “Create Target Scopes Using Simulink®

Real-Time™ Explorer” on page 5-30. Target execution and scopes must be
stopped.

1 Start execution ( on the Applications toolbar).

2 Select Scope 1 and open the Properties pane ( on the Scopes toolbar).

3 In the Scope 1 pane, click Display.

4 Select Display mode Redraw and then click in the Y-Limits box.

This value is the default. It causes the scope display to redraw as soon as it
has acquired as many samples as specified in Number of Samples.

5 Start Scope 1 ( on the toolbar).

Signal data is displayed on the target computer monitor, appearing to
move to the left.

6 Enter [0,10] in the Y-Limits box and then press Enter. The default
setting is [0,0], which automatically scales the output according to the
signal values.

The display changes to show only values at and above the zero line.

7 Clear the Grid (On/Off) check box. By default, the box is selected.
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The target computer monitor looks like this figure.
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8 Select Display mode Numerical and then click in the Y-Limits box.

The grid and axes disappear. The target computer monitor displays the
signals, color coded, in the default format of %15.6f (a floating-point format
without a label).
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9 Select Display mode Rolling and then click in the Y-Limits box.

The display changes to a display that continuously moves a window along
the signal stream. New data enters the display from the right and then
moves toward the left.

10 Select Display mode Sliding and then click in the Y-Limits box. In this
mode, the scope refreshes continuously. New data overwrites the display
from the left toward the right.

11 Stop Scope 1 ( on the toolbar).

12 Stop execution ( on the Applications toolbar).
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Create Signal Groups Using Simulink Real-Time Explorer
When testing a complex model with many signals, you frequently must select
signals for tracing or monitoring from multiple parts and levels of the model
hierarchy. You can make this task easier by using Simulink Real-Time
Explorer to create a signal group and save it to disk.

This procedure uses the model xpcosc as an example. You must have already
completed the following setup:

1 Built and downloaded the target application to the target computer using

Simulink ( on the toolbar).

2 Run Simulink Real-Time Explorer (command slrtexplr).

3 Connected to the target computer in the Targets pane ( on the toolbar).

To create a signal group:

1 In the Applications pane, expand the target application node and
right-click node Groupings.

2 Click New Signal Group.

The Add New Signal Group Item dialog box appears.

3 In the Add New Signal Group Item dialog box, enter a name in the Name
text box, for example signalgroup1.sig. In the Location text box, enter
a folder for the group file.

4 Click OK.

A new signal group appears, along with its Signal Group workspace.

5 In the Applications pane, expand the target application node and then
expand node Model Hierarchy.

6 Select the model node and then click the View Signals icon on the
toolbar.
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The Signals workspace opens, showing a table of signals with properties
and actions.

7 In the Signal Groups workspace, to add signal Signal Generator to
signalgroup1.sig, click the down arrow next to the Signals Grouping
icon in its Actions column.

A list of signal groups appears, including signalgroup1.sig.

8 Click the Add Signal(s) icon next to signalgroup1.sig.

9 Add signal Integrator1 to signalgroup1.sig in the same way.

10 Press Enter, and then click the Save icon on the toolbar.

When you are monitoring a signal group, you can change the output format
of the group by selecting one of the options in the Format column.
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• For more on monitoring individual signals in the group, see “Monitor
Signals Using Simulink® Real-Time™ Explorer” on page 5-5.

• For more on tracing individual signals using a target scope, see “Create
Target Scopes Using Simulink® Real-Time™ Explorer” on page 5-30.

• For more on tracing individual signals using a host scope, see “Create Host
Scopes Using Simulink® Real-Time™ Explorer” on page 5-56.

• For more on logging individual signals using a file scope, see “Create File
Scopes Using Simulink® Real-Time™ Explorer” on page 5-81.
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• To make both workspaces visible at the same time, click and hold the tab
for one workspace and drag it down until the following icon appears in the

middle of the dialog box: . Continue to drag until the cursor reaches the
required quadrant, and then release the mouse button.

• Click File > Save Layout to save your Simulink Real-Time Explorer
window layout. In a later session, you can click File > Restore Layout to
restore your layout.
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Create Host Scopes Using Simulink Real-Time Explorer
You can create a virtual host scope on the target computer using Simulink
Real-Time Explorer. These scopes have the full capabilities of the Scope block
in Host mode, but do not persist past the current execution.

Note For information on using host scope blocks, see “Configure Real-Time
Host Scope Blocks” on page 5-26 and “Host Scope Usage” on page 5-29.

This procedure uses the model xpcosc as an example. You must have already
completed the following setup:

1 Built and downloaded the target application to the target computer using

Simulink ( on the toolbar).

2 Run Simulink Real-Time Explorer (command slrtexplr).

3 Connected to the target computer in the Targets pane ( on the toolbar).

4 Set property Stop time to inf in the Applications pane ( on the
toolbar).

To configure a virtual host scope:

1 In the Scopes pane, expand the xpcosc node.

2 To add a host scope, select Host Scopes and then click the Add Scope
icon on the toolbar.

Under the Host Scopes node, the new scope is displayed, for example
Scope 1.

3 Expand Scope 1 and then click the Properties icon on the toolbar.

4 In the Scope Properties pane, click Signals. Add signals from the
Applications Signals workspace.
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5 In the Applications pane, expand the target application node and then
node Model Hierarchy.

6 Select the model node and then click the View Signals icon on the
toolbar.

7 In the Signals workspace, to add signal Signal Generator to Scope1,
click the down arrow next to the Scopes icon in its Actions column.

A list of scope types is displayed. Scope 1 appears under node Host
Scopes.

8 Click the Add Signal(s) icon next to Scope1 under node Host Scopes.

You can add or remove signals from a virtual host scope while the scope is
either stopped or running.

9 Add signal Integrator1 to Scope 1 in the same way.
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10 To view the host scope, select Scope 1 and then click the View Scope
icon on the toolbar.

The Host Scope Viewer window opens as a separate tab. The signals you
add to the scope appear at the top right of the viewer.

11 To start execution, click the target application and then click the Start
icon on the toolbar.

The application starts running. No output appears on the host scope viewer.

12 To start Scope 1, click Scope 1 in the Scopes pane and then click the
Start Scope icon on the toolbar.
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Output for signals Signal Generator and Integrator1 appears on the
host scope viewer.

13 To stop Scope 1, click Scope 1 in the Scopes pane and then click the
Stop Scope icon on the toolbar.

The signals shown on the target computer stop updating while the target
application continues running. The target computer monitor displays a
message like this one:
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Scope: 1, set to state 'interrupted'

14 To stop execution, click the target application and then click the Stop
icon on the toolbar.

The target application on the target computer stops running, and the target
computer displays messages like this message:

minimal TET: 0.0000006 at time 0.001250

maximal TET: 0.0000013 at time 75.405500

• To configure the host scope viewer, see “Configure the Host Scope Viewer”
on page 5-61

• You can create a virtual host scope from the scope types list by clicking
Add Scope next to scope type Host Scopes.

• To group signals, see “Create Signal Groups Using Simulink® Real-Time™
Explorer” on page 5-52.

• To configure data sampling, see “Configure Scope Sampling Using
Simulink® Real-Time™ Explorer” on page 5-36.

• To configure interactive scope triggering, see “Trigger Scopes Interactively
Using Simulink® Real-Time™ Explorer” on page 5-39.

• To configure noninteractive scope triggering, see “Trigger Scopes
Noninteractively Using Simulink® Real-Time™ Explorer” on page 5-42.

• To make both workspaces visible at the same time, click and hold the tab
for one workspace and drag it down until the following icon appears in the

middle of the dialog box: . Continue to drag until the cursor reaches the
required quadrant, and then release the mouse button.

• Click File > Save Layout to save your Simulink Real-Time Explorer
window layout. In a later session, you can click File > Restore Layout to
restore your layout.

• If a block is unnamed, Simulink Real-Time Explorer does not display
signals or a node for that block. To reference such a block, provide an
alphanumeric name for that block, rebuild and download the model to the
target computer, and then reconnect the MATLAB session to the target
computer.
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Configure the Host Scope Viewer
You can customize the viewer for each host scope to facilitate your interaction
with the running model.

This procedure uses the model xpcosc as an example. You must have already
completed the procedure in “Create Host Scopes Using Simulink® Real-Time™
Explorer” on page 5-56. Target execution and scopes must be stopped.

1 Start execution ( on the Applications toolbar).

2 To start Scope 1, click the Start icon on the Host Scope Viewer toolbar.

3 To trigger Scope 1, click the Trigger icon on the Host Scope Viewer
toolbar.

To interactively trigger a capture using the Trigger icon , you must
set the scope Trigger Mode to Software or Scope. See “Trigger Scopes
Interactively Using Simulink® Real-Time™ Explorer” on page 5-39.

4 In the Simulink Real-Time Host Scope Viewer, right-click anywhere in the
axis area of the viewer and then click Edit.

The Host Scope Viewer display parameter icons become enabled on the
toolbar.

5 Adjust the Host Scope Viewer display using:

• Auto Scale — To scale the display to accommodate the top and
bottom of the Y-axis.

• Axes Scroll — To move the content up and down and right and left
relative to the axes. The axes scroll as required.

• Axes Zoom — To stretch and compress the X-axis and Y-axis.

• Zoom In — To zoom in on the current center of the display.

• Zoom Out — To zoom out from the current center of the display.

• Zoom Box — To select an area of interest in the display. When you
release the mouse button, the display zooms in upon the selected area.
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• Data Cursor — To display data values using a set of cross-hairs in
the display.

Data is displayed as the pair x-value,y-value, indicating the value at
that point on the display. You can drag the center of the cross hairs and
observe the value at each point.

• Legends — To toggle display of the signal names.

6 To stop Scope 1, click the Stop icon on the Host Scope Viewer toolbar.

7 Stop execution ( on the Applications toolbar).
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Configure Target Scopes Using MATLAB Language
Creating a scope object allows you to select and view signals using Simulink
Real-Time functions instead of the Simulink Real-Time graphical user
interface.

This procedure uses the Simulink model xpcosc as an example. To do this
procedure, you must have already built the target application forxpcosc
and downloaded it to the default target computer. It describes how to trace
signals with target scopes.

1 Start running your target application. Type:

tg = slrt;

tg.start

The target computer displays the following message:

System: execution started (sample time: 0.0000250)

2 To get a list of signals, type:

tg.ShowSignals='on'

The MATLAB window displays a list of the target object properties for the
available signals. For example, the signals for the model xpcosc are:

ShowSignals = on

Signals = INDEX VALUE BLOCK NAME LABEL

0 0.000000 Integrator1

1 0.000000 Signal Generator

2 0.000000 Gain

3 0.000000 Integrator

4 0.000000 Gain1

5-63



5 Signals and Parameters

5 0.000000 Gain2

6 0.000000 Sum

For more information, see “Monitor Signals Using MATLAB Language”
on page 5-8.

3 Create a scope to be displayed on the target computer. For example, to
create a scope with an identifier of 1 and a scope object name of sc1, type:

sc1=tg.addscope('target', 1)

4 List the properties of the scope object. For example, to list the properties of
the scope object sc1, type:

sc1

The MATLAB window displays a list of the scope object properties. The
scope properties Time and Data are not accessible with a target scope.

Simulink Real-Time Scope Object

Application = xpcosc

ScopeId = 1

Status = Interrupted

Type = Target

NumSamples = 250

NumPrePostSamples = 0

Decimation = 1

TriggerMode = FreeRun

TriggerSignal = -1
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TriggerLevel = 0.000000

TriggerSlope = Either

TriggerScope = 1

TriggerSample = -1

Mode = Redraw (Graphical)

YLimit = Auto

Grid = On

Signals = no Signals defined

5 Add signals to the scope object. For example, to add Integrator1 and
Signal Generator, type:

sc1.addsignal ([0,1])

The target computer displays the following messages:

Scope: 1, signal 0 added

Scope: 1, signal 1 added

After you add signals to a scope object, the signals are not shown on the
target screen until you start the scope.

6 Start the scope. For example, to start the scope sc1, type:

sc1.start

The target screen plots the signals after collecting each data package.
During this time, you can observe the behavior of the signals while the
scope is running.

7 Stop the scope. Type:

sc1.stop

5-65



5 Signals and Parameters

The signals shown on the target computer stop updating while the target
application continues running. The target computer displays the following
message:

Scope: 1, set to state 'interrupted'

8 Stop the target application. In the MATLAB window, type:

tg.stop

The target application on the target computer stops running. The target
computer displays the following messages.:

minimal TET: 0.000023 at time 1313.789000

maximal TET: 0.000034 at time 407.956000
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Trace Signals Using Simulink External Mode
You can use Simulink external mode to establish a communication channel
between your Simulink block diagram and your target application. The
block diagram becomes a graphical user interface to your target application.
Simulink scopes can display signal data from the target application, including
from models referenced inside a top model. You can control which signals to
upload through the External Signal & Triggering dialog box (see “Signal
Selection” and “Control External Mode Operations”).

Note Do not use Simulink external mode while Simulink Real-Time Explorer
is running. Use only one interface or the other.

This procedure uses the model xpcosc as an example. xpcosc contains a
Simulink Scope block.

1 In the MATLAB window, type xpcosc.

2 In the Simulink window, from the Code menu, select External Mode
Control Panel.

3 In the External Mode Control Panel dialog box, click the Signal &
Triggering button.

4 In the External Signal & Triggering dialog box, set the Source parameter
to manual.

5 Set theMode parameter to normal. In this mode, the scope acquires data
continuously.

6 Select the Arm when connecting to target check box.

7 In the Delay box, enter 0.

8 In the Duration box, enter the number of samples for which external mode
is to log data, for example 1000.

The External Signal & Triggering dialog box looks like this figure.
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9 Click Apply, and then Close.

10 In the External Mode Control Panel dialog box, click OK.

11 In the Simulink toolbar, increase the simulation stop time to, for example,
50.

12 From the File menu, select Save As and enter a file name. For example,
enter xpc_osc6, and then click OK.

13 In the Simulink window, click Simulation > Mode > External. A check
mark appears next to the menu item External, indicating that Simulink
external mode is activated.
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14 If a Scope window is not displayed for the Scope block, double-click the
Scope block.

15 To start the simulation, click the Run icon on the toolbar.

The target application begins running on the target computer. The Scope
window displays plotted data.

16 To stop the simulation, click the Stop icon on the toolbar.
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External Mode Usage
• When setting up signal triggering (Source set to signal), you must explicitly
specify the element number of the signal in the Trigger signal:Element
box. If the signal is a scalar, enter a value of 1. If the signal is a wide
signal, enter a value from 1 to 10. When uploading Simulink Real-Time
signals to Simulink scopes, do not enter Last or Any in this box.

• The Direction:Holdoff value does not affect the Simulink Real-Time
signal uploading feature.

• Attempting to upload information from buses and virtual signals inside a
reference model generates a warning.
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Trace Signals Using a Web Browser
The Web browser interface allows you to visualize data using a graphical
user interface.

After you connect a Web browser to the target computer, you can use the
scopes page to add, remove, and control scopes on the target computer:

1 In the left frame, click the Scopes button. The browser loads the Scopes
List pane into the right frame.

2 Click the Add Scope button.

A target scope is created and displayed on the target computer. The
Scopes pane displays a list of the scopes present. You can add a new scope,
remove existing scopes, and configure the scopes from this page.

To create a host scope, use the drop-down list next to the Add Scope
button to select Host. This item is set to Target by default.

3 Click the Edit button.

From the scope editing pane, you can configure and control the scope.

4 Click the Add Signals button. The browser displays an Add New Signals
list.

5 Select the check boxes next to the signal names, and then click Apply. A
Remove Existing Signals list is added above the Add New Signals list.

You do not have to stop a scope to make changes. If the scope is running, the
Web interface stops the scope automatically and then restarts it when the
changes are made. It does not restart the scope if the state was originally
stopped.

When a host scope is stopped (Scope State is set to Interrupted) or finishes
one cycle of acquisition (Scope State is set to Finished), the Get Data
button becomes available. If you click this button, the scope data is retrieved
in comma-separated value (CSV) format. The signals in the scope are spread
across columns. Each row corresponds to one sample of acquisition. The first
column corresponds to the time each sample was acquired.
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If Scope State is set to Interrupted, the scope was stopped before it
completed a full cycle of acquisition. The number of rows in the CSV data
still correspond to a full cycle. The last few rows (for which data was not
acquired) are set to 0.
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Signal Logging Basics
Signal logging acquires signal data during a real-time run and stores it on
the target computer. After you stop the target application, you transfer the
data from target computer to host computer for analysis. Signal logging is
also known as real-time data streaming to the target computer. You can plot
and analyze the data, and later save it to a disk on the host computer.

Simulink Real-Time signal logging samples at the base sample time. If you
have a model with multiple sample rates, add Simulink Real-Time scopes to
the model to sample signals at the required sample rates.

• The Simulink Real-Time software does not support logging data with
decimation.

• Simulink Real-Time Explorer works with multidimensional signals in
column-major format.

• Some signals are not observable. See “Nonobservable Signals and
Parameters” on page 5-137.

You can log signals using file scopes in the model, virtual file scopes in
Simulink Real-Time Explorer, outports in the model, MATLAB language,
and a web browser.
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Configure Real-Time File Scope Blocks
Simulink Real-Time includes a specialized Scope block that you can configure
to save signal and time data to a file on the target computer hard drive, flash
drive, or removable drive. Add a Scope block to the model, select Scope type
File, and then configure the other parameters as described in the following
procedure.

• Do not confuse Simulink Real-Time Scope blocks with standard Simulink
Scope blocks.

• For more information about using Simulink Real-Time Scope blocks, see
“Simulink® Real-Time™ Scope Usage” on page 5-24.

• For more information about target scopes, see “File Scope Usage” on page
5-79.

• This procedure uses the model xpc_osc2 as an example. To access the
example folder, type:

addpath (fullfile(matlabroot, 'help', 'toolbox', 'xpc',

'examples'));

1 In the MATLAB window, type xpc_osc2.

2 In the Simulink block diagram, double-click the block labeled Scope.

The Block Parameters: Scope dialog box opens. By default, the target scope
dialog box is displayed.

3 In the Scope number box, a unique number is displayed that identifies
the scope. This number is incremented each time you add a new Simulink
Real-Time scope.

This number identifies the Simulink Real-Time Scope block and the scope
screen on the host or target computer.

4 From the Scope type list, select File. The updated dialog box opens.

5
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Caution The software overwrites previously acquired data in files of the
specified name or name pattern when the file scope starts. Copy previously
acquired data to the host computer before starting the scope, otherwise
it is lost.

Select the Start scope when application starts check box to start the
scope automatically when the target application executes.

In Stand Alone mode, this setting is mandatory because the host computer
is not available to issue a command to start scopes.

6 In the Number of samples box, enter the number of values to be
acquired in a data package. This parameter works in conjunction with
the AutoRestart check box. If you select the AutoRestart box, the file
scope collects data up to Number of samples, and then starts over again,
overwriting the buffer. If you do not select the AutoRestart box, the file
scope collects data only up to Number of samples, and then stops.

7 In the Number of pre/post samples box, enter the number of samples to
save or skip. To save N samples before a trigger event, specify the value N.
To skip N samples after a trigger event, specify the value N. The default is 0.

8 In the Decimation box, enter a value to indicate that data is collected at
each sample time (1) or at less than every sample time (2 or greater).

9 From the Trigger mode list, select FreeRun, Software Triggering,
Signal Triggering, or Scope Triggering.

• If you select FreeRun or Software Triggering, you do not need to enter
additional parameters.

• If you select Signal Triggering, then enter the following additional
parameters, as required:

– In the Trigger signal box, enter the index of a signal previously
added to the scope.

This parameter does not apply if the Add signal port to connect a
signal trigger source check box is selected.
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– (Alternatively) Click the Add signal port to connect a signal
trigger source check box, then connect an arbitrary trigger signal to
the port Trigger signal.

– In the Trigger level box, enter a value for the signal to cross before
triggering.

– From the Trigger slope list, select one of Either, Rising, or Falling.

• If you select Scope Triggering, then enter the following additional
parameters, as required:

– In the Trigger scope number box, enter the scope number of a
Scope block. If you use this trigger mode, you must also add a second
Scope block to your Simulink model.

– If you want the scope to trigger on a specific sample of the other scope,
enter a value in the text box Sample to trigger on (-1 for end of
acquisition). The default value is 0, and indicates that the triggering
scope and the triggered (current) scope start simultaneously.

For more information on this field, see “Trigger One Scope with
Another Scope” on page 11-24.

10 In the Filename box, enter a name for the file to contain the signal data.

By default, the target computer writes the signal data to C:\data.dat. For
more about files and file names, see “File Scope Usage” on page 5-79.

11 From the Mode list, select either Lazy or Commit.

With the Commit mode, each file write operation simultaneously updates
the FAT entry for the file. The file system maintains the actual file size
after each write. With the Lazy mode, the FAT entry is updated only when
the file is closed.

If your system stops responding, you lose WriteSize bytes of data.

12 In the WriteSize box, enter the block size, in bytes, of the data chunks.
This parameter specifies that a memory buffer of length Number of samples
is written to the file in chunks of size WriteSize. By default, this parameter
is 512 bytes. Using a block size that is the same as the disk sector size
improves performance.
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If your system stops responding, you lose WriteSize bytes of data.

13 In the Number of samples box, enter the number of values to be acquired
in a data package.

14 Select the AutoRestart check box to enable the file scope to collect up to
Number of samples data samples, write the buffer to the signal data file,
and then start over again, appending the new data to the end of the signal
data file. Clear the AutoRestart check box to have the file scope collect
up to Number of samples data samples, write the buffer to the signal data
file, and then stop.

If the named signal data file already exists, the Simulink Real-Time
software overwrites the old data with the new signal data.

The file scope dialog box looks like this figure.
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15 Click OK.

16 From the File menu, click Save As. The model is saved as xpc_osc2.
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File Scope Usage
• Simulink Real-Time supports eight file scopes. Each file scope can contain
as many signals as the target computer resources can support.

• When the file scope starts, the software overwrites previously acquired data
in files of the specified name or name pattern. Copy previously acquired
data to the host computer before starting the scope, otherwise it is lost.

• With file scopes, after you run the target application, the Simulink
Real-Time software generates a signal data file on the target computer, even
if it is running in Stand Alone mode. To access the contents of the signal
data file that a file scope creates, use the SimulinkRealTime.fileSystem
object from a host computer MATLAB window. To view or examine the
signal data, use the SimulinkRealTime.utils.getFileScopeData utility
in conjunction with the plot function. For further details on the file system
object, see “Using SimulinkRealTime.fileSystem Objects” on page 12-4.
Saving signal data to files lets you recover signal data from a previous
run in the event of system failure.

The signal data file can quickly increase in size. Examine the file size
between runs to gauge the growth rate for the file. If the signal data file
grows beyond the available space on the disk, the signal data might be
corrupted.

• File names on the target computer are limited to 8 characters in length,
not counting the file extension. If the name is longer than 8 characters,
the software truncates it to 6 characters and adds ’~1’ to the end of the
file name.

If you enter just the file name, the file appears in folder C:\. To
put the file in a folder, you must create the folder separately using
the target computer command line or MATLAB language (see
SimulinkRealTime.fileSystem.mkdir).

To configure the scope to generate multiple, dynamically named files in one
session, see “Log Signal Data into Multiple Files” on page 5-90.

• Both the Lazy and Commit settings of theMode box cause the model to open
a file, write signal data to the file, and then close that file at the end of the
session. With the Commit mode, each file write operation simultaneously
updates the FAT entry for the file. This mode is slower, but the file system
maintains the actual file size after each write. With the Lazymode, the FAT
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entry is updated only when the file is closed and not during each file write
operation. This mode is faster, but if the system stops responding before
the file is closed, the file system might not know the actual file size (the file
contents, however, will be intact). If the system stops responding, you lose
an amount of data equivalent to the setting of theWriteSize parameter.

• For a file scope, the scope acquires data and writes it to the file named in
the FileName parameter. The scope acquires the first N samples into a
memory buffer of size given by the Number of Samples parameter. The
scope writes data from the memory buffer to the file in blocks of size given
by the WriteSize parameter.

If you select the AutoRestart check box, the scope starts over, overwriting
the memory buffer. The additional data is appended to the end of the
existing file.

If you do not select the AutoRestart box, the scope collects data only up to
the number of samples, and then stops.

• Select the type of trigger event in the Block Parameters: Scope dialog box
by setting Trigger Mode to Signal Triggering, Software Triggering,
or Scope Triggering.

The number of samples N to log after triggering an event is equal to the
value that you entered in the Number of Samples parameter.
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Create File Scopes Using Simulink Real-Time Explorer
You can create a virtual file scope on the target computer using Simulink
Real-Time Explorer. These scopes have the full capabilities of the Scope block
in File mode, but do not persist past the current execution.

Note For information on using file scope blocks, see “Configure Real-Time
File Scope Blocks” on page 5-74 and “File Scope Usage” on page 5-79.

This procedure uses the model xpcosc as an example. You must have already
completed the following setup:

1 Built and downloaded the target application to the target computer using

Simulink ( on the toolbar).

2 Run Simulink Real-Time Explorer (command slrtexplr).

3 Connected to the target computer in the Targets pane ( on the toolbar).

4 Set property Stop time to inf in the Applications pane ( on the
toolbar).

To configure a virtual file scope:

1 In the Scopes pane, expand the xpcosc node.

2 To add a file scope, select File Scopes, and then click the Add Scope
icon on the toolbar.

3 Expand Scope 1, and then click the Properties icon on the toolbar.

4 In the Scope Properties pane, click Signals.

Add signals from the Applications Signals workspace.

5 In the Applications pane, expand both the target application node and
the node Model Hierarchy.
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6 Select the model node and then click the View Signals icon on the
toolbar.

7 In the Signals workspace, to add signal Signal Generator to Scope1,
click the down arrow next to the Scopes icon in its Actions column. A
list of scope types appears. Scope 1 appears under node File Scopes.

8 Click the Add Signal(s) icon next to Scope1 under the File Scopes
node.

9 Add signal Integrator1 to Scope 1 in the same way.

10 In the Scope Properties pane, click File.

11 Enter a name in the File name text box, for example scope1.dat.

12 Select the AutoRestart check box.

13 Leave the Dynamic File Mode check box cleared.

For information on using Dynamic File Mode to generate multiple,
dynamically named files in one session, see “Log Signal Data into Multiple
Files” on page 5-90.

14 To start execution, click the target application and then click the Start
icon on the toolbar.

15

Caution The software overwrites previously acquired data in files of the
specified name or name pattern when the file scope starts. Copy previously
acquired data to the host computer before starting the scope, otherwise
it is lost.

To start Scope 1, click Scope 1 in the Scopes pane, and then click the
Start Scope icon on the toolbar.

16 To stop Scope 1, click Scope 1 in the Scopes pane, and then click the
Stop Scope icon on the toolbar.
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For file scopes, before adding or removing signals, you must stop the scope
first.

17 To stop execution, click the target application, and then click the Stop
icon on the toolbar.

18 To view the file that you generated, in the Targets pane, expand the target
computer and then double-click File System.

19 Select C:\. The dialog box looks like this figure.
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20 To retrieve the file from the target computer, select the file in the target
computer File System pane and drag and drop it to the MATLAB Current
Folder pane or to a Windows Explorer window.

• To configure file scopes, see “Configure File Scopes Using Simulink®

Real-Time™ Explorer” on page 5-86.
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• To retrieve the file programmatically from the target computer for analysis,
see “Using SimulinkRealTime.fileSystem Objects” on page 12-4.

• To rename file SCOPE1.DAT, right click the file name, select Rename, type
the new name in the text box, and then click Enter.

To delete file SCOPE1.DAT, right click the file name and select Delete.

• You can create a virtual file scope from the list of scope types by clicking
Add Scope next to scope type File Scopes.

• To group signals, see “Create Signal Groups Using Simulink® Real-Time™
Explorer” on page 5-52.

• To configure data sampling, see “Configure Scope Sampling Using
Simulink® Real-Time™ Explorer” on page 5-36.

• To configure scope triggering, see “Trigger Scopes Interactively Using
Simulink® Real-Time™ Explorer” on page 5-39 and “Trigger Scopes
Noninteractively Using Simulink® Real-Time™ Explorer” on page 5-42.

• To make both workspaces visible at the same time, click and hold the tab
for one workspace and drag it down until the following icon appears in the

middle of the dialog box: . Continue to drag until the cursor reaches the
required quadrant, and then release the mouse button.

• Click File > Save Layout to save your Simulink Real-Time Explorer
window layout. In a later session, you can click File > Restore Layout to
restore your layout.

• If a block is unnamed, Simulink Real-Time Explorer does not display
signals or a node for that block. To reference such a block, provide an
alphanumeric name for that block, rebuild and download the model to
the target computer, and reconnect the MATLAB session to the target
computer.
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Configure File Scopes Using Simulink Real-Time Explorer
You can configure your file scopes to facilitate data logging. You can configure
a file scope whether you added a Scope block to your model or added the scope
at run time.

This procedure uses the model xpcosc as an example. You must have already
completed the procedure in “Create File Scopes Using Simulink® Real-Time™
Explorer” on page 5-81. Target execution and scopes must be stopped.

1 Select Scope 1, and then open the Properties pane ( on the Scopes
toolbar).

2 In the Scope 1 Properties pane, click File.

3 Enter a name in the File name text box, for example scope2.dat.

File names on the target computer are limited to 8 characters in length,
not counting the file extension. If the name is longer than 8 characters,
the software truncates it to 6 characters and adds ’~1’ to the end of the
file name.

If you enter just the file name, the file appears in folder C:\. To
put the file in a folder, you must create the folder separately using
the target computer command line or MATLAB language (see
SimulinkRealTime.fileSystem.mkdir).

If a file with this name already exists when you start the file scope, the file
scope overwrites the old data with the new data.

4 Select File mode Commit.

The default File mode is Lazy. In both Lazy and Commit mode, the kernel
opens a file, writes signal data to the file, and closes that file at the end of
the session.

• In Commit mode, each file write operation simultaneously updates the
FAT entry for the file. This mode is slower than Lazy mode, but the file
system maintains the actual file size after each write.

• In Lazy mode, the FAT entry is updated only when the file is closed and
not during each file write operation. This mode is faster than Commit
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mode, but if the system stops responding before the file is closed, the file
system might not know the actual file size, even though the contents will
be intact. If the system stops responding, you lose an amount of data
equivalent to the setting of the Write Size parameter.

5 Select the AutoRestart check box.

• When you select AutoRestart, the file scope collects data up to the
number of samples, and then restarts. It appends the new data to the
end of the file.

• When you clear AutoRestart, the file scope collects data up to the
number of samples, and then stops.

6 Leave the Dynamic File Mode check box cleared.

For information on using Dynamic File Mode to generate multiple,
dynamically named files in one session, see “Log Signal Data into Multiple
Files” on page 5-90.

7 Leave Write Size set to the default value of 512.

Using a block size that is the same as the disk sector size improves
performance.

8 Leave Max write file size set to the default value, which is a multiple of
Write Size.

9 Start execution ( on the Applications toolbar).

10

Caution The software overwrites previously acquired data in files of the
specified name or name pattern when the file scope starts. Copy previously
acquired data to the host computer before starting the scope, otherwise
it is lost.

Start Scope 1( on the Scopes toolbar). Let it run for up to a minute.

11 Stop Scope 1 ( on the Scopes toolbar).
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12 Stop execution ( on the Applications toolbar).

13 To retrieve the file from the target computer, select the file in the target
computer File System pane and drag and drop it to the MATLAB Current
Folder pane or to a Windows Explorer window.
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• To rename file SCOPE2.DAT, right-click the file name, select Rename, type
the new name in the text box, and then click Enter.

• To delete file SCOPE2.DAT, right-click the file name and select Delete.

• To retrieve the file programmatically from the target computer for analysis,
see “Using SimulinkRealTime.fileSystem Objects” on page 12-4.
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Log Signal Data into Multiple Files
You can acquire signal data to store in multiple, dynamically named files on
the target computer. You can then examine one file while the scope continues
to acquire data to store in other files. To acquire data for multiple files, add
a file scope to the target application, and then configure that scope to log
signal data to multiple files.

You must use model xpcosc and have completed the setup tasks in “Create
File Scopes Using Simulink® Real-Time™ Explorer” on page 5-81.

1 In Simulink Real-Time Explorer, in the Scopes pane, expand the xpcosc
node.

2 Select File Scopes and expand node File Scopes.

3 Expand Scope 1 and then click the Properties icon on the toolbar.

4 In the Scope Properties pane, click File.

5 To enable the file scope to create multiple log files based on the same name,
in the File name box, enter a name like scope1_<%>.dat.

This sequence directs the software to create up to nine log files,
scope1_1.dat to scope1_9.dat, on the target computer file system.

You can configure the file scope to create up to 99999999 files
(<%%%%%%%%>.dat). The length of a file name, including the specifier,
cannot exceed eight characters. See property Filename of class
SimulinkRealTime.fileSystem.

6 Select the AutoRestart and Dynamic File Mode check boxes.

7 In theMax write file size box, enter a value to limit the size of the signal
log files. This value must be a multiple of the Write Size value. For
example, if the write size is 512, enter 4096 to limit each log file size to
4096 bytes.

8 To start execution, click the target application and then click the Start
icon on the toolbar.
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9

Caution The software overwrites previously acquired data in files of the
specified name or name pattern when the file scope starts. Copy previously
acquired data to the host computer before starting the scope, otherwise
it is lost.

To start Scope 1, click Scope 1 in the Scopes pane and then click the
Start Scope icon on the toolbar.

Let Scope 1 run for up to a minute.

10 To stop Scope 1, click Scope 1 in the Scopes pane and then click the
Stop Scope icon on the toolbar.

11 To stop execution, click the target application and then click the Stop
icon on the toolbar.

12 To view the files that you generated, in the Targets pane, expand the
target computer, and then double-click File System.

13 Select C:\. The dialog box looks like this figure.
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The software creates a log file named SCOPE1_1.DAT and writes data to
that file. When the size of SCOPE1_1.DAT reaches 4096 bytes (the value
of Max write file size), the software closes SCOPE1_1.DAT and creates
SCOPE1_2.DAT, SCOPE1_3.DAT, and so on until it fills the last log file,
SCOPE1_9.DAT. If the target application continues to collect data after
the software closes SCOPE1_9.DAT, the software reopens SCOPE1_1.DAT,
SCOPE1_2.DAT, and so on, overwriting the existing contents.
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14 To retrieve the files from the target computer, select each file in the target
computer File System pane and drag and drop it to the MATLAB Current
Folder pane or to a Windows Explorer window.

To retrieve the files programmatically from the target computer, see “Using
SimulinkRealTime.fileSystem Objects” on page 12-4.
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Configure Outport Logging Using Simulink Real-Time
Explorer

To use Simulink Real-Time Explorer for signal logging, add an Outport block
to your Simulink model. Activate logging on the Data Import/Export pane
in the Configuration Parameters dialog box.

This procedure begins with tutorial model xpc_osc3:

1 In the MATLAB window, type xpc_osc3. The xpc_osc3 model opens.

2 In the Simulink window, select and delete the Simulink Real-Time Scope
block and its connecting signal.

3 Click Simulation > Model Configuration Parameters.

4 Select node Data Import/Export.

5 Select the Signal logging check box.

6 In Signal logging format, select value Dataset.
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7 From the File menu, click Save as. Enter xpc_osc4, and then click Save.

8 Click OK.

9 In the Simulink window, click the Build Model icon on the toolbar.

10 Run Simulink Real-Time Explorer using command slrtexplr.

11 Connect to the target computer in the Targets pane using the Connect
icon on the toolbar.

12 To start execution, click the target application, and then click the Start
icon on the toolbar.
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The outputs are the signals connected to Simulink Outport blocks. The
model xpcosc has one Outport block, labeled 1. There are two states. This
Outport block shows the signals leaving the blocks labeled Integrator1
and Signal Generator.

13 To stop execution, click the target application, and then click the Stop
icon on the toolbar.

14 Plot the signals from the Outport block and the states. In the MATLAB
window, type:

plot(tg.TimeLog,tg.Outputlog)

Values for the logs are uploaded to the host computer from the target
application on the target computer. To upload part of the logs, see the
target object method SimulinkRealTime.target.getlog.

The plotted output looks like this figure.
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Configure Outport Logging Using MATLAB Language
You plot the outputs and states of your target application to observe the
behavior of your model, or to determine the behavior when you vary the input
signals and model parameters. Before you configure data logging, you must
complete the following setup:

1 Before you build the target application, add Outport blocks to your
Simulink model. In the Data Import/Export pane of the Configuration
Parameters dialog box, select the Save to workspace check box . See
“Configure Simulation Parameters”.

2 To plot the task execution time, in the Simulink Real-Time Options
pane of the Configuration Parameters dialog box, verify that the Log Task
Execution Time check box is selected. This check box is selected by
default. See “Add Simulink Real-Time Scope Block”.

3 In the Simulink Real-Time Options pane of the Configuration
Parameters dialog box, set Signal logging buffer size in doubles to
a value large enough to accommodate the logged signals. The default is
100000. If the default buffer size is not large enough, approximate the
size using this formula:

Buffer size in doubles = 90% * Memory / sizeof(double)

Memory is the number of bytes available on the target computer after the
kernel starts. It is displayed in the upper-left corner of the target computer
screen. For example, for a Memory value of 2044MB, set Signal logging
buffer size in doubles to 255500000.

The Simulink Real-Time software calculates the number of samples N for
a signal as the value of Signal logging buffer size in doubles divided
by the number of logged signals (1 time, 1 task execution time ([TET]),
number of outputs, number of states). The scopes copy the last N samples
from the log buffer to the target object logs (tg.TimeLog, tg.OutputLog,
tg.StateLog, and tg.TETLog).

After you build, download, and run a target application, you can plot the
state and output signals. This procedure uses the Simulink model xpc_osc4
as an example. You must have already built and downloaded the target
application for that model.

5-98



Configure Outport Logging Using MATLAB® Language

1 Assign tg to the target computer. In the MATLAB window, type:

tg = slrt;

2 Start the target application. In the MATLAB window, type:

tg.start

The target application starts and runs until it reaches the final time set in
the target object property tg.StopTime.

The outputs are the signals connected to Simulink Outport blocks. The
model xpcosc has one Outport block, labeled 1. There are two states. This
Outport block shows the signals leaving the blocks labeled Integrator1
and Signal Generator.

3 Plot the signals from the Outport block and the states. In the MATLAB
window, type:

plot(tg.TimeLog,tg.Outputlog)

Values for the logs are uploaded to the host computer from the target
application on the target computer. To upload part of the logs, see the
target object method SimulinkRealTime.target.getlog.
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The plot shown is the result of a real-time execution. To compare this plot
with a plot for a non-real-time simulation, see “Simulate Simulink Model
Using MATLAB Language”.

4 In the MATLAB window, type:

plot(tg.TimeLog,tg.TETLog)

Values for the task execution time (TET) log are uploaded to the host
computer from the target computer. To upload part of the logs, see the
target object method SimulinkRealTime.target.getlog.
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The TET plot shown is the result of a real-time run.

The TET is the time to calculate the signal values for the model during
each sample interval. If you have subsystems that run only under certain
circumstances, plotting the TET shows when subsystems were executed
and the additional CPU time required for those executions.

5 In the MATLAB window, type:

tg.AvgTET

The MATLAB interface displays information about the average task
execution time, for example:
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ans =

5.7528e-006

The percentage of CPU performance is the average TET divided by the
sample time.

Each outport has an associated column vector in tg.OutputLog. You can
access the data that corresponds to a particular outport by specifying
the column vector for that outport. For example, to access the data that
corresponds to Outport 2, use tg.outputlog(:,2).
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Configure File Scopes Using MATLAB Language
This procedure shows how to trace signals with file scopes using the Simulink
model xpcosc as an example. You must have already built and downloaded
the target application for this model. It also assumes that you have a serial
communication connection.

Note The signal data file can quickly increase in size. Examine the file size
between runs to gauge the growth rate of the file. If the signal data file grows
beyond the available space on the disk, the signal data might be corrupted.

1 Create a target object tg that represents target computer TargetPC1. Type:

tg = SimulinkRealTime.target('TargetPC1')

2 To get a list of signals, type:

tg.ShowSignals='on'

The MATLAB window displays a list of the target object properties for the
available signals. For example, these are the signals for the model xpcosc:

ShowSignals = on

Signals = INDEX VALUE BLOCK NAME LABEL

0 0.000000 Integrator1

1 0.000000 Signal Generator

2 0.000000 Gain

3 0.000000 Integrator

4 0.000000 Gain1

5 0.000000 Gain2

6 0.000000 Sum
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For more information, see “Monitor Signals Using MATLAB Language”
on page 5-8.

3 Start running your target application. Type:

tg.start

The target computer displays the following message:

System: execution started (sample time: 0.0000250)

4 Create a scope to be displayed on the target computer. For example, to
create a scope with an identifier of 2 and a scope object name of sc2, type:

sc2 = tg.addscope('file', 2)

5 List the properties of the scope object. For example, to list the properties of
the scope object sc2, type sc2.

The MATLAB window displays a list of the scope object properties. Notice
that the scope properties Time and Data are not accessible with a target
scope.

Simulink Real-Time Scope Object

Application = xpcosc

ScopeId = 2

Status = Interrupted

Type = File

NumSamples = 250

NumPrePostSamples = 0

Decimation = 1

TriggerMode = FreeRun

TriggerScope = 2
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TriggerSample = 0

TriggerSignal = -1

TriggerLevel = 0.000000

TriggerSlope = Either

ShowSignals = off

FileName = unset

Mode = Lazy

WriteSize = 512

AutoRestart = off

DynamicFileName = off

MaxWriteFileSize = 536870912

No name is initially assigned to FileName. After you start the scope,
Simulink Real-Time assigns a name for the file to acquire the signal data.
This name typically consists of the scope object name, ScopeId, and the
beginning letters of the first signal added to the scope.

6 Add signals to the scope object. For example, to add Integrator1 and
Signal Generator, type:

sc2.addsignal ([4,5])

The target computer displays the following messages:

Scope: 2, signal 4 added

Scope: 2, signal 5 added

After you add signals to a scope object, the file scope does not acquire
signals until you start the scope.
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7

Caution The software overwrites previously acquired data in files of the
specified name or name pattern when the file scope starts. Copy previously
acquired data to the host computer before starting the scope, otherwise
it is lost.

Start the scope. For example, to start scope sc2, type:

sc2.start

The MATLAB window displays a list of the scope object properties.
FileName is assigned a default file name to contain the signal data for the
file scope. This name typically consists of the scope object name, ScopeId,
and the beginning letters of the first signal added to the scope.

Application = xpcosc

ScopeId = 2

Status = Pre-Acquiring

Type = File

NumSamples = 250

NumPrePostSamples = 0

Decimation = 1

TriggerMode = FreeRun

TriggerScope = 2

TriggerSample = 0

TriggerSignal = 4

TriggerLevel = 0.000000
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TriggerSlope = Either

ShowSignals = on

Signals = 4 : Integrator1

5 : Signal Generator

FileName = c:\sc7Integ.dat

Mode = Lazy

WriteSize = 512

AutoRestart = off

DynamicFileName = off

MaxWriteFileSize = 536870912

8 Stop the scope. Type:

sc2.stop

9 Stop the target application. In the MATLAB window, type:

tg.stop

The target application on the target computer stops running. The target
computer displays messages similar to the following:

minimal TET: 0.00006 at time 0.004250

maximal TET: 0.000037 at time 14.255250

To access the contents of the signal data file that the file scope creates, use the
Simulink Real-Time file system object (SimulinkRealTime.fileSystem) from
the host computer MATLAB window. To view or examine the signal data, you
can use the SimulinkRealTime.utils.getFileScopeData utility with the
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plot function. For further details on the SimulinkRealTime.fileSystem file
system object, see “Using SimulinkRealTime.fileSystem Objects” on page 12-4.
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Log Signals Using a Web Browser
When you stop the model execution, you see another section of the Web
browser interface where you can download logging data. This data is in
comma-separated value (CSV) format. This format can be read by most
spreadsheet programs and by the MATLAB interface using the dlmread
function.

You see this section of the Web browser interface only if you have enabled
data logging. Buttons become available only for those logs (states, output, and
TET) that are enabled. If time logging is enabled, the first column of the CSV
file is the time at which data (states, output, and TET values) was acquired.
If time logging is not enabled, only the data is in the CSV file, without time
information.

To perform data logging, you must complete the following setup:

1 Before you build the target application, add Outport blocks to your
Simulink model. In the Data Import/Export pane of the Configuration
Parameters dialog box, select the Save to workspace check box . See
“Configure Simulation Parameters”.

2 To plot the task execution time, in the Simulink Real-Time Options
pane of the Configuration Parameters dialog box, verify that the Log Task
Execution Time check box is selected. This check box is selected by
default. See “Add Simulink Real-Time Scope Block”.

3 In the Simulink Real-Time Options pane of the Configuration
Parameters dialog box, set Signal logging buffer size in doubles to
a value large enough to accommodate the logged signals. The default is
100000. If the default buffer size is not large enough, approximate the
size using this formula:

Buffer size in doubles = 90% * Memory / sizeof(double)

Memory is the number of bytes available on the target computer after the
kernel starts. It is displayed in the upper-left corner of the target computer
screen. For example, for a Memory value of 2044MB, set Signal logging
buffer size in doubles to 255500000.
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The Simulink Real-Time software calculates the number of samples N for
a signal as the value of Signal logging buffer size in doubles divided
by the number of logged signals (1 time, 1 task execution time ([TET]),
number of outputs, number of states). The scopes copy the last N samples
from the log buffer to the target object logs (tg.TimeLog, tg.OutputLog,
tg.StateLog, and tg.TETLog).

You analyze and plot the outputs and states of your target application to
observe the behavior of your model, or to determine the behavior when you
vary the input signals.
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Parameter Tuning Basics
By default, the Simulink Real-Time software lets you change parameters in
your real-time target application while it is running.

Note Some parameters are not observable. See “Nonobservable Signals and
Parameters” on page 5-137.

You can improve overall efficiency by inlining parameters. The Simulink
Real-Time product supports the Simulink Coder inline parameters
functionality. (For more information about inlined parameters, see the
Simulink Coder documentation.)

By default, inlined parameters are nontunable. If you want to make some
of the inlined parameters tunable, do so through the Model Parameter
Configuration dialog box (see “Configure Model to Tune Inlined Parameters”
on page 5-129).
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Tune Parameters Using Simulink Real-Time Explorer
You can use Simulink Real-Time Explorer to change parameters in your
real-time target application while it is running or between runs. You do not
need to rebuild the Simulink model, set the Simulink interface to external
mode, or connect the Simulink interface with the target application.

This procedure uses model xpcosc. You must have already completed the
setup tasks in “Create Host Scopes Using Simulink® Real-Time™ Explorer”
on page 5-56.

1 Select the target application in the Applications pane (for example,
xpcosc).

2 To start execution, click the target application and then click the Start
icon on the toolbar.

3 To start Scope 1, click Scope 1 in the Scopes pane and then click the
Start Scope icon on the toolbar.
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4 In the Applications pane, expand both the target application node and
node Model Hierarchy.

5 Select the model node, and then click the View Parameters icon on
the toolbar.
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The Parameters workspace opens, showing a table of parameters with
properties and actions.

6 Click the arrow next to the Gain for block Gain1. The Values text box
opens, containing the initial value 400.

7 Type 100 into the text box, and then press Enter.

To revert the Gain for block Gain1 to its previous value, click the Revert
icon .

8 Click the Apply parameter value(s) changes icon .

The Simulink Real-Time Explorer window looks like this figure.
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9 To stop Scope 1, click Scope 1 in the Scopes pane, and then click the
Stop Scope icon on the toolbar.

10 To stop execution, click the target application, and then click the Stop
icon on the toolbar.
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• To group parameters, see “Create Parameter Groups Using Simulink®

Real-Time™ Explorer” on page 5-117

• To make both workspaces visible at the same time, click and hold the tab
for one workspace and drag it down until the following icon appears in the

middle of the dialog box: . Continue to drag until the cursor reaches the
required quadrant, and then release the mouse button.

• Click File > Save Layout to save your Simulink Real-Time Explorer
window layout. In a later session, you can click File > Restore Layout to
restore your layout.
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Create Parameter Groups Using Simulink Real-Time
Explorer

When testing a complex model composed of many reference models, you must
tune parameters from multiple parts and levels of the model. To do so, create
a parameter group.

This procedure uses the model xpcosc as an example. You must have already
completed the following setup:

1 Built and downloaded the target application to the target computer using

Simulink ( on the toolbar).

2 Run Simulink Real-Time Explorer (command slrtexplr).

3 Connected to the target computer in the Targets pane ( on the toolbar).

To create a parameter group:

1 In the Applications pane, expand the target application node, and then
right-click the Groupings node.

2 Click New Parameter Group.

3 In the Add New Parameter Group Item dialog box, enter a name in the
Name text box (for example, ParamGroup1.par). In the Location text
box, enter a folder for the group file.

4 Click OK. A new parameter group appears, along with its Parameter
Group workspace.

5 In the Applications pane, expand both the target application node and
the node Model Hierarchy.

6 Select the model node, and then click the View Parameters icon on
the toolbar.

The Parameters workspace opens, showing a table of parameters with
properties and actions.
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7 In the Parameter Groups workspace, to add parameter Amplitude to
ParamGroup1.par, click the down arrow next to the Parameters
Grouping icon in its Actions column.

A list of parameter groups appears, including ParamGroup1.par.

8 Click the Add Parameter icon next to ParamGroup1.par.

9 Add parameter Frequency to ParamGroup1.par in the same way.

10 Press Enter, and then click the Save icon on the toolbar.
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• To tune individual parameters in the selected group, see “Tune Parameters
Using Simulink® Real-Time™ Explorer” on page 5-112.

• To make both workspaces visible at the same time, click and hold the tab
for one workspace and drag it down until the following icon appears in the

middle of the dialog box: . Continue to drag until the cursor reaches the
required quadrant, and then release the mouse button.

• Click File > Save Layout to save your Simulink Real-Time Explorer
window layout. In a later session, you can click File > Restore Layout to
restore your layout.
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Tune Parameters Using MATLAB Language
You use the MATLAB functions to change block parameters. With these
functions, you do not need to set the Simulink interface to external mode. You
also do not need to connect the Simulink interface with the target application.

You can download parameters to the target application while it is running or
between runs. You can change parameters in your target application without
rebuilding the Simulink model and, if required, change them back to their
original values. using Simulink Real-Time functions.

This procedure uses the Simulink model xpcosc as an example. You must
have already created and downloaded the target application to the default
target computer.

1 In the MATLAB window, type:

tg = slrt;

tg.start

The target computer displays the following message:

System: execution started (sample time: 0.001000)

2 Display a list of parameters. Type:

tg.ShowParameters='on'

The ShowParameters command displays a list of properties for the target
object.

ShowParameters = on

Parameters =

INDEX VALUE TYPE SIZE
PARAMETER
NAME

BLOCK
NAME

0 1000000 DOUBLE Scalar Gain Gain
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1 400 DOUBLE Scalar Gain Gain1

2 1000000 DOUBLE Scalar Gain Gain2

3 0 DOUBLE Scalar
Initial
Condition Integrator

4 0 DOUBLE Scalar Initial
Condition

Integrator1

5 4 DOUBLE Scalar Amplitude Signal
Generator

6 20 DOUBLE Scalar Frequency Signal
Generator

3 Change the gain. For example, to change the Gain1 block, type:

pt = tg.setparam(1,800)

The setparam method returns a structure that stores the parameter index,
the previous value, and the new value.

As soon as you change parameters, the changed parameters in the target
object are downloaded to the target application. The host computer displays
the following message:

pt =

parIndexVec: 1

OldValues: 400

NewValues: 800

The target application runs. The plot frame updates the signals for the
active scopes.

4 Stop the target application. In the MATLAB window, type:

tg.stop

The target application on the target computer stops running. The target
computer displays messages like the following:
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minimal TET: 0.000023 at time 1313.789000

maximal TET: 0.000034 at time 407.956000

5 To reset to the previous values, type:

setparam(tg,pt.parIndexVec,pt.OldValues)

ans =

parIndexVec: 5

OldValues: 800

NewValues: 100

Note Method names are case sensitive and must be complete. Property
names are not case sensitive and do not need to be complete, as long as they
are unique.
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Tune Parameters Using Simulink External Mode
You use Simulink external mode to connect your Simulink block diagram to
your target application. The block diagram becomes a graphical user interface
to your target application. You set up the Simulink interface in external mode
to establish a communication channel between your Simulink block window
and your target application.

In Simulink external mode, wherever you change parameters in the Simulink
block diagram, the Simulink software downloads those parameters to the
target application while it is running. You can change parameters in your
program without rebuilding the Simulink model to create a new target
application.

After you download your target application to the target computer, you can
connect your Simulink model to the target application. This procedure uses
the Simulink model xpcosc as an example. You must have already created
and downloaded the target application for that model.

1 In the Simulink window, click Simulation > Mode > External. A check
mark appears next to the menu item External, and Simulink external
mode is activated.

2 Click the Run icon on the toolbar.

The target application begins running on the target computer, and the
target computer displays the following message:

System: execution started (sample time: 0.000250)

3 From the Simulation block diagram, double-click the block labeled Gain1

4 In the Block Parameters: Gain1 parameter dialog box, the Gain text box,
enter 800. Click OK.

As soon as you change a model parameter and click OK, the changed
parameters in the model are downloaded to the target application.

5 From the Simulation menu, click Disconnect from Target.
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The Simulink model is disconnected from the target application. If you then
change a block parameter in the Simulink model, the target application
does not change.

6 In the MATLAB window, type:

tg = slrt('TargetPC1')

tg.stop

The target application on the target computer stops running, and the target
computer displays the following messages:

minimal TET: 0.000023 at time 1313.789000

maximal TET: 0.000034 at time 407.956000
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Tune Parameters Using a Web Browser
The Parameters pane displays the tunable parameters in your model. Row
and column indices for vector/matrix parameters are also shown.

After you connect a Web browser to the target computer, you can use the
Parameters page to change parameters in your real-time target application
while it is running.

1 In the left frame, click Parameters. The browser loads the Parameter
List pane into the right frame.

If the parameter is a scalar parameter, the current parameter value is
shown in a box that you can edit.

If the parameter is a vector or matrix, click a button to open another page
that displays the vector or matrix. You can then edit the parameter.

2 Enter a new parameter value into one or more of the parameter boxes,
and then click Apply.

The new parameter values are uploaded to the target application.
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Save and Reload Parameters Using MATLAB Language
After you have a set of target application parameter values that you are
satisfied with, you can save those values to a file on the target computer.
You can then later reload these saved parameter values to the same target
application.

You can save parameters from your target application while the target
application is running or between runs. You can save and restore parameters
in your target application without rebuilding the Simulink model. You must
load parameters to the same model from which you save the parameter file. If
you load a parameter file to a different model, the behavior is undefined.

You save and restore parameters with the target object methods
saveparamset and loadparamset.

Requirements:

• You have a target application object named tg.

• You have assigned tg to the target computer.

• You have downloaded a target application to the target computer.

• You have parameters to save. For more information, see:

- “Tune Parameters Using MATLAB Language” on page 5-120

- “Tune Parameters Using Simulink External Mode” on page 5-123

- “Tune Parameters Using a Web Browser” on page 5-125

Save the Current Set of Target Application Parameters
To save a set of parameters to a target application, use the saveparamset
method. The target application can be stopped or running.

1 Identify the set of parameter values that you want to save.

2 Select a descriptive file name to contain these values. For example, use
the model name in the file name.

3 In the MATLAB window, type either
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tg = slrt;

tg.saveparamset('xpc_osc4_param1')

The Simulink Real-Time software creates a file named xpcosc4_param1 in
the current folder of the target computer, for example, C:\xpcosc4_param1.

• To restore parameter values to a target application, see “Load Saved
Parameters to a Target Application” on page 5-127.

• To list the parameters and values stored in the parameter file, see “List the
Values of Parameters Stored in a File” on page 5-128.

Load Saved Parameters to a Target Application
To load a set of saved parameters to a target application, use the
loadparamset method.

You must load parameters to the same model from which you save the
parameter file. If you load a parameter file to a different model, the behavior
is undefined.

This section assumes that you have a parameters file saved from an earlier
run of saveparamset (see “Save the Current Set of Target Application
Parameters” on page 5-126).

1 From the collection of parameter value files on the target computer, select
the one that contains the parameter values you want to load.

2 In the MATLAB window, type:

tg = slrt;

tg.loadparamset('xpc_osc4_param1')

The Simulink Real-Time software loads the parameter values into the
target application.
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Tip

• To load the parameter set automatically during startup, see “Load a
parameter set from a file on the designated target file system”.

• To list the parameters and values stored in the parameter file, see “List the
Values of Parameters Stored in a File” on page 5-128.

List the Values of Parameters Stored in a File
To list parameters and their values, load the file for a target application, and
then turn on the ShowParameters target object property.

You must have a parameters file saved from an earlier run of saveparamset
(see “Save the Current Set of Target Application Parameters” on page 5-126).

1 Stop the target application. In the MATLAB window, type:

tg.stop

2 Load the parameter file. Type:

tg = slrt;

tg.loadparamset('xpc_osc4_param1');

3 Display a list of parameters. Type:

tg.ShowParameters='on'

The MATLAB window displays a list of parameters and their values for
the target object.
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Configure Model to Tune Inlined Parameters
This procedure describes how you can globally inline parameters for a model,
and then specify which of these parameters you still want to be tunable.

Note You cannot tune inlined parameters that are structures.

The following procedure uses the Simulink model xpcosc as an example.

1 In the MATLAB Command Window, type xpcosc. The model is displayed
in the Simulink window.

2 Select the blocks of the parameters that you want to make tunable. For
example, this procedure makes the signal generator’s amplitude parameter
tunable. Use the variable A to represent the amplitude.

3 Double-click the Signal Generator block, and then enter A for the Amplitude
parameter. Click OK.

4 In the MATLAB Command Window, assign a constant to that variable.
For example, type:

A = 4

The value is displayed in the MATLAB workspace.

5 From the Simulink window, click Simulation > Model Configuration
Parameters.

6 In the Configuration Parameters dialog box, select the Signals and
Parameters node under Optimization.

7 In the right pane, select the Inline parameters check box.

8 Click Configure.

The Model Parameter Configuration dialog box opens. The MATLAB
workspace contains the constant you assigned to A.

9 Select the line that contains your constant. Click Add to table.
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Add the remaining global parameters that you want to tune.

10 Click Apply, and then click OK.

11 In the Configuration Parameters dialog box, click Apply, and then OK.

12 Save the model. For example, save it as xpc_osc5.

13 Build and download the model to your target computer.

14 To tune inline parameters, see either:

• “Tune Inlined Parameters Using Simulink® Real-Time™ Explorer” on
page 5-131

• “Tune Inlined Parameters Using MATLAB Language” on page 5-135
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Tune Inlined Parameters Using Simulink Real-Time
Explorer

This procedure describes how you can tune inlined parameters through the
Simulink Real-Time Explorer.

The procedure uses the model xpc_osc5 from “Configure Model to Tune
Inlined Parameters” on page 5-129 as an example. You must have already
completed the setup tasks in “Create Host Scopes Using Simulink®

Real-Time™ Explorer” on page 5-56.

1 Select the target application in the Applications pane (for example,
xpc_osc5).

2 To start execution, click the target application, and then click the Start
icon on the toolbar.

3 To start Scope 1, click Scope 1 in the Scopes pane, and then click the
Start Scope icon on the toolbar.
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4 In the Applications pane, expand both the target application node and
the Model Hierarchy node.

5 Select the model node, and then click the View Parameters icon on the
toolbar. The Parameters workspace opens, showing a table of parameters
with properties and actions.
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6 Click the arrow next to parameter A for block Model Parameters. The
Values text box opens, containing the initial value 4.

7 Type 2 into the text box, and then press Enter.

To revert parameter A for block Model Parameters to its previous value,
click the Revert icon .

8 Click the Apply parameter value(s) changes icon .

The dialog looks like this figure.
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9 To stop Scope 1, click Scope 1 in the Scopes pane, and then click the
Stop Scope icon on the toolbar.

10 To stop execution, click the target application, and then click the Stop
icon on the toolbar.
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Tune Inlined Parameters Using MATLAB Language
This procedure describes how you can tune inlined parameters through the
MATLAB interface. You must have already built and downloaded the model
from the topic “Configure Model to Tune Inlined Parameters” on page 5-129 to
the target computer. The model must already be running.

You can tune inlined parameters using a parameter ID.

• Use the getparamid function to get the ID of the inlined parameter that
you want to tune. For the block_name parameter, leave a blank ('').

• Use the setparam function to set the new value for the inlined parameter.

1 Save the following code in a MATLAB file. For example, change_inlineA.

tg = slrt; %Create Simulink Real-Time object

pid=tg.getparamid('','A'); %Get parameter ID of A

if isempty(pid) %Check value of pid.

error('Could not find A');

end

tg.setparam(pid,100); %If pid is valid, set parameter value.

2 Execute that MATLAB file. Type:

change_inlineA

3 To see the new parameter value, type:

tg.showparameters='on'

The tg object information is displayed, including the parameter lines:

NumParameters = 1

ShowParameters = on
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Parameters = INDEX VALUE TYPE SIZE PARAMETER NAME BLOCK
NAME

0 100 DOUBLE Scalar A
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Nonobservable Signals and Parameters
Nonobservable signals are signals that exist in the target application, but
cannot be monitored, traced, or logged from the host computer.

You cannot monitor, trace, or log the following types of signals:

• Virtual or bus signals (including signals from bus and virtual blocks). You
can access these signals from nonvirtual source blocks.

- To access a virtual signal, add a Gain block with gain 1.0 (unit gain) and
observe its output.

- To access a virtual bus, add a Gain block with unit gain to each
individual signal.

• Signals that you have optimized with block reduction optimization. You
can access these signals by making them test points.

• Signals of complex or multiword data types.

Nonobservable parameters are parameters that exist in the target application,
but cannot be tuned from the host computer.

You cannot tune parameters of complex or multiword data types.

5-137



5 Signals and Parameters

5-138



6

Execution Modes

• “Execution Modes” on page 6-2

• “Interrupt Mode” on page 6-3

• “Polling Mode” on page 6-5



6 Execution Modes

Execution Modes
The Simulink Real-Time kernel has three mutually-exclusive execution
modes. You can execute the target application in one non-real-time mode
and in two real-time modes.

• Freerun mode — To use this non-real-time mode, on the Simulink
Real-Time Options pane in the Configuration Parameters dialog box,
set Execution mode to Freerun.

In this mode, the target application thread does not wait for the timer and
the kernel runs the application as fast as possible. If the target application
has conditional code, the time between each execution can vary. Multirate
models cannot be executed in Freerun execution mode. On the Solver
pane in the Configuration Parameters dialog box, set Tasking mode for
periodic sample times to SingleTasking. For more information, see “Set
Configuration Parameters” and “Execution mode”.

• Interrupt mode — To use this real-time mode, on the Simulink Real-Time
Options pane in the Configuration Parameters dialog box, set Execution
mode to Real-Time.

In this mode, the scheduler implements real-time single-tasking and
multitasking execution of single-rate or multirate systems, including
asynchronous events (interrupts). This implementation allows you to
interact with the target computer while the real-time target application
is executing at high sample rates. For more information, see “Interrupt
Mode” on page 6-3.

• Polling mode — To use this real-time mode, on the Simulink Real-Time
Options pane in the Configuration Parameters dialog box, set Execution
mode to Real-Time. Then, set a polling rate using the TLCOptions model
property.

In this mode, the kernel executes target applications at sample times close
to the limit of the hardware (CPU). Using polling mode with high-speed and
low-latency I/O boards and drivers allows you to achieve target application
sample times that you cannot achieve using the interrupt mode of the
Simulink Real-Time software. Because polling mode disables interrupts
on the processor core where the model runs, it imposes restrictions on
the model architecture and on host-target communication. For more
information, see “Polling Mode” on page 6-5.
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Interrupt Mode
When you set Execution mode to Real-Time on the Simulink Real-Time
Options pane in the Configuration Parameters dialog box, interrupt mode is
the real-time execution mode set by default. This mode provides the greatest
flexibility. Choose this mode for applications that execute at the given base
sample time without overloading the CPU.

In interrupt mode, the scheduler implements real-time single-tasking
and multitasking execution of single-rate or multirate systems, including
asynchronous events (interrupts). Additionally, background tasks like
host-target communication or updating the target screen run in parallel with
sample-time-based model tasks. This implementation allows you to interact
with the target system while the real-time target application is executing
at high sample rates. Interaction is made possible by an interrupt-driven
real-time scheduler responsible for executing the various tasks according to
their priority. The base sample time task can interrupt other tasks (larger
sample time tasks or background tasks). Execution of the interrupted tasks
resumes as soon as the base sample time task completes operation. This
capability gives a quasi parallel priority execution scheme.

In interrupt mode, the kernel is close to optimal for executing code on a
PC-compatible system. However, using interrupt mode introduces a constant
overhead, or latency, that reduces the minimal possible base sample time
to a constant number. The overhead is the sum of various factors related
to the interrupt-driven execution scheme. The overhead is referred to as
overall interrupt latency. Assuming that the currently executing task is not
executing a critical section and has therefore not disabled interrupt sources,
the overall latency consists of the following parts:

• Interrupt controller latency — In a PC-compatible system the interrupt
controller is not part of the x86-compatible CPU. It is part of the CPU
chip set. The controller is accessed over the I/O-port address space, which
introduces a read or write latency for each register access.

• CPU hardware latency — Modern CPUs try to predict the next couple
of instructions, including branches, using instruction pipelines. If an
interrupt occurs, the prediction fails and the pipeline has to be fully
reloaded. This process introduces additional latency.
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• Interrupt handler entry and exit latency — An interrupt can stop the
currently executing task at an arbitrary instruction. When the interrupting
task completes execution, the interrupted task has to resume. Its state has
to be saved and restored accordingly. The CPU data and address registers,
including the stack pointer, must be saved. If the interrupted task executed
floating-point unit (FPU) operations, the FPU stack must also be saved.
Therefore, additional latency is introduced.

• Interrupt handler content latency — If a background task has been
executing for some time, say in a loop, its data is available in cache
memory. When an interrupt occurs and the interrupt service handler is
executed, the interrupt handler data potentially is purged from the cache.
Purging the data from the cache causes the CPU to reload the data from
slower RAM. Additional latency is introduced.

The overall latency of interrupt mode is equivalent to a Simulink model
containing a hundred nontrivial blocks. Because lower priority tasks have to
be serviced as well, at least 5% of headroom is required. This requirement can
cause additional cache misses and therefore nonoptimal execution speed.
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Polling Mode
Polling mode for the kernel is designed to execute target applications at
sample times close to the limit of the hardware (CPU). Polling mode with
high-speed and low-latency I/O boards and drivers allows you to achieve
smaller sample times for applications. You cannot achieve these smaller
sample times using the interrupt mode of the Simulink Real-Time software.

Polling mode has two main applications:

• Control applications — Control applications of average model size and I/O
complexity that are executed at very small sample times (Ts = 5 to 50 µs).

• DSP applications — Sample-based DSP applications (mainly audio and
speech) of average model size and I/O complexity that are executed at very
high sample rates (Fs = 20 to 200 kHz).

Polling mode for the kernel does not have the constant latency that interrupt
mode does. The kernel does not allow interrupts, so the CPU can use this
extra time for executing model code.

Polling mode is sometimes seen as a “primitive” or “brute force” real-time
execution scheme. When a real-time application executes at a given base
sample time in interrupt mode and overloads the CPU, switching to polling
mode is often the only alternative for the application to execute at the
required sample time.

Polling means that the kernel waits in an empty while loop until the time of
the next model step is reached. Then the next model step is executed. A
counter implemented in hardware must be accessible to the kernel to get a
base reference for when the next model step execution must begin. The kernel
polls this hardware counter. If this hardware counter must be outside the
CPU, e.g., in the chip set or on an ISA or PCI board, the counter value can
be retrieved only by an I/O or memory access cycle that again introduces
latency. This latency consumes the freed-up time of polling mode. Since the
introduction of the Pentium CPU family from Intel®, the CPU is equipped
with a 64-bit counter on the CPU substrate itself. This counter commences
counting at CPU start time and counts up driven by the actual clock rate
of the CPU. A highly clocked CPU is unlikely to cause a 64-bit counter to
overflow. For a 1 GHz CPU:
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overflow_time = 264 * 1e-9 = 584 years

The Pentium counter comes with the following features:

• More precise measurements — Because the counter counts up with the
CPU clock rate, time measurements, even in the microsecond range, are
very precise, so there are small real-time errors.

• Overflow handler not required— Because the counter is 64 bits wide,
overflow does not occur, avoiding the CPU-time overhead of handling
overflows.

• Minimal latency — The counter resides on the CPU. Reading the counter
value can be done within one CPU cycle, introducing minimal latency.

The polling execution scheme does not depend on interrupt sources to
notify the code to continue calculating the next model step. The CPU is
freed up. Target application code timed by the polling loop is executed as
real-time code– even components, which in interrupt mode were executed in
background tasks. Do not execute background tasks in polling mode, because
these tasks are usually non-real-time tasks and can use a lot of CPU time.
To be efficient, execute only the target application’s relevant parts. For the
Simulink Real-Time software, the relevant parts are the code segments that
represent the Simulink model itself.

Host-target communication and target display updating are disabled. Polling
mode reduces the features of the Simulink Real-Time product to a minimum.
Choose this mode only as the last alternative to reach the required base
sample time for a given model. Before considering polling mode, do the
following:

• Optimize the model execution speed — First, run the model through the
Simulink profiler to find possible speed optimizations using alternative
blocks. If the model contains continuous states, discretizing these states
reduces model complexity significantly. You can avoid a costly fixed-step
integration algorithm. If continuous states cannot be discretized, use the
integration algorithm with the lowest order that still produces the required
numerical results.

• Use the fastest available computer hardware — Use the CPU with the
highest clock rate available for a given target computer form factor. For the

6-6



Polling Mode

desktop form factor, use a CPU with a clock rate above 3 GHz. For a mobile
application (e.g., PC/104 form factor), use a CPU with a clock rate above 1
GHz. When running typical target applications, executing slrtbench at
the MATLAB prompt gives a relative measure of CPU performance.

• Use the lowest latency I/O hardware and drivers available — Many
Simulink Real-Time applications communicate with hardware through I/O
hardware over either an ISA or PCI bus. Each register access to such I/O
hardware introduces a comparably high latency time. Using the lowest
latency hardware/driver technology available is crucial.

Set Polling Mode
Polling mode is an alternative to the default interrupt mode of the kernel.
The kernel on the bootable media created by the UI allows running the target
application in both modes without using another boot disk.

By default, the target application executes in interrupt mode. To switch
to polling mode, you must set a polling rate using the TLCOptions model
property.

For a Pentium-class processor, set the polling rate to the target computer
CPU clock rate. You can find the CPU clock rate of the target computer by
restarting the target computer and checking the screen output during BIOS
execution time. The BIOS usually displays the CPU clock rate in MHz right
after you start the target computer.

The following example uses xpcosc.

1 Open model xpcosc.

2 In the Configuration Parameters dialog box, on the Simulink Real-Time
Options pane, set Execution mode to Real-Time.

3 In the Command Window, type:

set_param('xpcosc','TLCOptions',
'-axpcCPUClockPoll=CPUClockRateMHz')

For example, if your target computer is a 1.2 GHz AMD Athlon™, type:

set_param('xpcosc','TLCOptions','-axpcCPUClockPoll=1200')
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4 Build and download the target application.

After you have downloaded the target application, the target screen displays
the execution mode. If polling mode is activated, it displays the CPU clock
rate in MHz. You can check the setting.

If you want to execute the target application in interrupt mode again, either
remove the option or assign a CPU clock rate of 0 to the option:

set_param('xpcosc','TLCOptions','')
set_param('xpcosc','TLCOptions','-axpcCPUClockPoll=0')

Restrictions on Single- and Multicore Processors
Polling mode runs best on a multicore processor target computer with
multicore processing enabled. For more information, see “Multicore Processor
Configuration” on page 10-4.

Polling mode disables interrupts on the core where the model is running.
Background tasks are inactive on this core, including those for host-target
communication, target screen updating, and UDP transfers. Because the
model uses only one core of a multicore target computer, interrupts are still
enabled on the other cores. Therefore, the only restriction on a multicore
computer is for multirate models. See “Multirate Models Cannot Be Executed
in Multitasking Mode” on page 6-8.

The following restrictions apply to single-core target computers:

• “Multirate Models Cannot Be Executed in Multitasking Mode” on page 6-8

• “I/O Drivers Cannot Use Kernel Timing Information” on page 6-9

• “Host-Target Communication Unavailable” on page 6-9

• “Target Screen Does Not Update” on page 6-10

• “Session Time Does Not Advance” on page 6-11

• “Only Data Logging Is Available” on page 6-11

Multirate Models Cannot Be Executed in Multitasking Mode
You cannot execute target applications in multitasking mode because of
the polling mode execution scheme. You also cannot model function-call

6-8



Polling Mode

subsystems to handle asynchronous events (interrupts). You can execute
multirate systems in single-tasking mode. However, because of the CPU’s
scheme for sequential execution of subsystems with different rates, the CPU
can overload for the given base sample time. Consequently, polling mode is a
feasible alternative to interrupt mode only if the model has a single rate or if
it can be converted to a single-rate model.

A single-rate model implies one of the following combinations of states:

• Continuous states only

• Discrete states only

• Mixed continuous and discrete states, provided the continuous and discrete
subsystems have the same rate

Select Simulink Display > Sample Time > Colors to check for the single
rate requirement. To avoid a possible switch to multitasking mode, on the
Solver pane in the Configuration Parameters dialog box, set the Tasking
Mode property to SingleTasking.

I/O Drivers Cannot Use Kernel Timing Information
Some Simulink Real-Time drivers use timing information exported from the
kernel to, for example, detect timeouts. Because the standard timing engine
of the kernel does not run in polling mode, the required timing information
is not passed back to the drivers. Therefore, in polling mode you cannot use
drivers that import the header file time_xpcimport.h. In a future version of
polling mode, drivers will use the Pentium counter for timing.

Host-Target Communication Unavailable
If you start target application execution in polling mode, for example with

start(tg)

host-target communication is disabled throughout the entire run, until the
stop time is reached. Each attempt to issue a command like

tg
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results in a communication-related error message. Even the start(tg)
command returns such an error message, because the host side does not
receive an acknowledgment from the target before timing out. During the
entire run, it is best not to issue target-related commands on the host.

You cannot issue a stop(tg) command to stop the target application execution
from the host side. To stop executing in polling mode, the target application
has to reach its set stop time. Before starting the execution, you can use

tg.stoptime=x

but once started, the application executes until the stop time is reached.

To stop the execution interactively before it reaches the target application stop
time, see “Control Target Application on Single-Core Processor” on page 6-11.

If the target application execution reaches the stop time and polling mode
execution is stopped, host-target communication begins functioning again.
After polling mode execution stops, if you still get communication error
messages, type the command:

slrtpingtarget

to reset the host-target communication link.

After the communication link is working again, type:

tg

to resynchronize the target object on the host side with the most current
status of the target application.

Target Screen Does Not Update
Target screen updating is disabled during the entire execution of the target
application. The Graphics mode check box in the Target Properties pane
of Simulink Real-Time Explorer is not operational. Clear the Graphics
mode check box, thereby producing text output only.
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Session Time Does Not Advance
Because interrupts are disabled during a run, the session time does not
advance. Therefore, the session time right before and after the run is the
same. This same session time does not cause an issue.

Only Data Logging Is Available
Because host-target communication and target screen updating are disabled
during the entire run, these rapid-prototyping features are not available in
polling mode:

• Parameter tuning

• Signal monitoring

• Scope objects

• Applications using the Simulink Real-Time APIs

• The Internet browser interface

• SimulinkRealTime.target.viewTargetScreen and similar utilities

The only rapid-prototyping feature available is signal data logging. The
signal data is acquired independently of the host and logged data is retrieved
only after the execution is stopped. Logging data gathers useful information
about the behavior of the target application. Signal logging is an important
part of polling mode.

Control Target Application on Single-Core Processor
When you use polling mode on a single-core processor, you cannot interact
with the running target application until execution reaches its predefined
stop time. However, you can use I/O drivers to implement a minimal level
of interactivity.

To stop a target application, use a low-latency digital input driver for the
digital PCI board in your model. The driver reads in a single digital TTL
signal, by default TTL low. You change it to TTL high when the model
execution must be stopped.
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Connect the output port of the digital input driver block to the input port of
a Stop simulation block, found in the standard Simulink block library. The
Stop block stops the execution of the target application, depending on the
state of the digital input signal. To generate the TTL signal, you can use a
hardware switch connected to the board-specific input pin. Alternatively, you
can install another digital I/O board in the host machine and connect the
two boards (one in the host, the other in the target) by wires. You can then
use Data Acquisition Toolbox™ to drive the corresponding TTL output pin
of the host board to stop the target application execution from within the
MATLAB interface.

You can use the same software and hardware setup to pass other control
information back and forth at target application run time. However, you must
implement features other than signal logging at the model level. You must
minimize the additional latency introduced by the feature. For example,
interactively stopping the target application execution requires an additional
1 µs latency to read the digital signal over the digital I/O board.
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Execution Using Graphical
User Interface Models

You can use the Simulink interface to create a custom graphical user
interface (GUI) for your Simulink Real-Time application. To do this, create an
user interface model with the Simulink interface and add-on products like
Simulink 3D Animation™ or Altia® Design (a third-party product).



7 Execution Using Graphical User Interface Models

Simulink Real-Time Interface Blocks to Simulink Models

In this section...

“Simulink User Interface Model” on page 7-2

“Creating a Custom Graphical Interface” on page 7-3

“To Target Block” on page 7-4

“From Target Block” on page 7-5

“Creating a Target Application Model” on page 7-5

“Marking Block Parameters” on page 7-6

“Marking Block Signals” on page 7-8

Simulink User Interface Model
A user interface model is a Simulink model containing Simulink blocks from
add-on products and interface blocks from the Simulink Real-Time block
library. This user interface model can connect to a custom graphical interface
using Simulink 3D Animation or Altia products. The user interface model
runs on the host computer and communicates with your target application
running on the target computer using To Target and From Target blocks.

The user interface allows you to change parameters by downloading them to
the target computer, and to visualize signals by uploading data to the host
computer.

Simulink 3D Animation — The Simulink 3D Animation product enables
you to display a Simulink user interface model in 3-D. It provides Simulink
blocks that communicate with Simulink Real-Time interface blocks. These
blocks then communicate to a graphical interface. This graphical interface is
a Virtual Reality Modeling Language (VRML) world displayed with a Web
browser using a VRML plug-in.

Altia Design — Altia also provides Simulink blocks that communicate with
Simulink Real-Time interface blocks. These blocks then communicate with
Altia’s graphical interface or with a Web browser using the Altia ProtoPlay
plug-in.
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Creating a Custom Graphical Interface
The Simulink Real-Time block library provides Simulink interface blocks to
connect graphical interface elements to your target application. The steps for
creating your own custom user interface are listed below:

1 In the Simulink target application model, decide which block parameters
and block signals you want to have access to through graphical interface
control devices and graphical interface display devices.

2 Tag the block parameters in the Simulink model that you want to be
connected to a control device. See “Marking Block Parameters” on page 7-6.

3 Tag the signals in Simulink model that you want to be connected to a
display device. See “Marking Block Signals” on page 7-8.

4 In the MATLAB interface, run the function
SimulinkRealTime.utils.createInstrumentationModel('model_name')
to create the user interface template model. This function generates a new
Simulink model containing only the Simulink Real-Time interface blocks
(To Target and From Target) defined by the tagged block parameters and
block signals in the target application model.

5 To the user interface template model, add Simulink interface blocks from
add-on products (Simulink 3D Animation, Altia Design).
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• You can connect Altia blocks to the Simulink Real-Time To PC Target
interface blocks. To Target blocks on the left should be connected to
control devices.

• You can connect Altia and Simulink 3D Animation blocks to the
Simulink Real-Time From Target interface blocks. From Target blocks
on the right should be connected to the display devices.

You can position these blocks to your liking.

6 Start both the Simulink Real-Time application and the Simulink user
interface model that represents the Simulink Real-Time application.

To Target Block
This block behaves as a sink and usually receives its input data from a
control device. The purpose of this block is to write a new value to a specific
parameter on the target application.

This block is implemented as a MATLAB S-function. The block is optimized
so that it only changes a parameter on the target application when the input
value differs from the value that existed at the last time step. This block uses
the parameter downloading feature of the Simulink Real-Time command-line
interface. This block is available from the slrtlib/Displays and Logging
block sublibrary. See To Target for further configuration details.

Note The use of To Target blocks requires a connection between the host
and target computer. Operations such as opening a model that contains
these blocks or copying these blocks within or between models will take
significantly longer than normal without a connection between the host and
target computers.
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From Target Block
This block behaves like a source and its output is usually connected to the
input of a display device.

Because only one numerical value per signal is uploaded during a time
step, the number of samples of a scope object is set to 1. The block uses
the capability of the Simulink Real-Time command-line interface and is
implemented as a MATLAB S-function. This block is available from the
slrtlib/Displays and Logging sublibrary. See From Target for further
configuration details.

Note The use of From Target blocks requires a connection between the host
and target computers. Operations such as opening a model that contains
these blocks or copying these blocks within or between models will take
significantly longer than normal without a connection between the host and
target computers.

Creating a Target Application Model
A target application model is a Simulink model that describes your physical
system, a controller, and its behavior. You use this model to create a real-time
target application, and you use this model to select the parameters and
signals you want to connect to a custom graphical interface.

Creating a target application model is the first step you need to do before you
can tag block parameters and block signals for creating a custom graphical
interface.

See “Marking Block Parameters” on page 7-6 and “Marking Block Signals” on
page 7-8 for descriptions of how to mark block properties and block signals.
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Marking Block Parameters
Tagging parameters in your Simulink model allows the function
SimulinkRealTime.utils.createInstrumentationModel to create To
Target interface blocks. These interface blocks contain the parameters you
connect to control devices in your user interface model.

After you create a Simulink model, you can mark the block parameters. This
procedure uses the model xpctank as an example.

Tip The xpctank model blocks and signals may contain placeholder tags
illustrating the syntax. As you create your own copy of the model using these
procedures, replace these tags with your new tags or add the new tags using
the multiple label syntax.

1 Open a Simulink model. For example, in the MATLAB Command Window,
type

xpctank

2 Point to a Simulink block, and then right-click.

3 From the menu, click Properties.

A Block Properties dialog box opens.

4 In the Description box, delete the existing tag and enter a tag to the
parameters for this block.

For example, the SetPoint block is a constant with a single parameter that
selects the level of water in the tank. Enter the tag:

xPCTag(1)=water_level;

The tag has the following syntax

xPCTag(1, . . . index_n)= label_1 . . . label_n;

For single dimension ports, the following syntax is also valid:

xPCTag=label;
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index_n -- Index of a block parameter. Begin numbering parameters
with an index of 1.

label_n -- Name for a block parameter that will be connected to a To
Target block in the user interface model. Separate the labels with a space,
not a comma.

label_1...label_n must consist of the same identifiers as those used by
C/C++ to name functions, variables, and so forth. Do not use names like
-foo.

5 Repeat steps 1 through 3 for the remaining parameters you want to tag.

For example, for the Controller block, enter the tag:

xPCTag(1,2,3)=upper_water_level lower_water_level
pump_flowrate;

For the PumpSwitch and ValveSwitch blocks, enter the following tags
respectively:

xPCTag(2)=pump_switch;
xPCTag(1)=drain_valve;

To create the To Target blocks in an user interface model for a block with
four properties, use the following syntax:

xPCTag(1,2,3,4)=label_1label_2label_3label_4;

To create the To Target blocks for the second and fourth properties in a
block with at least four properties, use the following syntax:

xPCTag(2,4)=label_1 label_2;

6 From the File menu, click Save as. Enter a filename for your model. For
example, enter

xpctank1

You next task is to mark block signals if you have not already done so, and
then create the user interface template model. See “Marking Block Signals”
on page 7-8 and “Creating a Custom Graphical Interface” on page 7-3.
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Marking Block Signals
Tagging signals in your Simulink model allows the function
SimulinkRealTime.utils.createInstrumentationModel to create From
Target interface blocks. These interface blocks contain the signals you connect
to display devices in your user interface model.

After you create a Simulink model, you can mark the block signals. This
procedure uses the model xpctank1 (or xpctank) as an example. See
“Creating a Target Application Model” on page 7-5.

Tip The xpctank model blocks and signals may contain placeholder tags
illustrating the syntax. As you create your own copy of the model using these
procedures, replace these tags with your new tags or add the new tags using
the multiple label syntax.

Note that you cannot select signals on the output ports of virtual blocks,
such as Subsystem and Mux blocks. Also, you cannot select signals on
software-triggered signal output ports.

1 Open a Simulink model. For example, in the MATLAB Command Window,
type:

xpctank

or

xpctank1

2 Point to a Simulink signal line, and then right-click.

3 From the menu, click Properties.

A Signal Properties dialog box opens.

4 Select the Documentation tab.

5 In the Description box, enter a tag to the signals for this line.
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For example, the block labeled TankLevel is an integrator with a single
signal that indicates the level of water in the tank. Replace the existing
tag with the tag:

xPCTag(1)=water_level;

The tag has the following format syntax:

xPCTag(1, . . . index_n)=label_1 . . . label_n;

For single dimension ports, the following syntax is also valid:

XPCTag=label:

• index_n— Index of a signal within a vector signal line. Begin numbering
signals with an index of 1.

• label_n — Name for a signal that will be connected to a From Target
block in the user interface model. Separate the labels with a space, not a
comma.

label_1...label_n must consist of the same identifiers as those used by
C/C++ to name functions, variables, and so forth. Do not use names like
-foo.

To create the From Target blocks in an user interface model for a signal
line with four signals (port dimension of 4), use the following syntax:

xPCTag(1,2,3,4)=label_1 label_2 label_3 label_4;

To create the From Target blocks for the second and fourth signals in a
signal line with at least four signals, use the following syntax:

xPCTag(2,4)=label_1 label_2;

Note Only tag signals from nonvirtual blocks. Virtual blocks are only
graphical aids (see “Virtual Blocks”). For example, if your model combines
two signals into the inputs of a Mux block, do not tag the signal from the
output of the Mux block. Instead, tag the source signal from the output
of the originating nonvirtual block.
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6 From the File menu, click Save as. Enter a filename for your model. For
example, enter

xpc_tank1

You next task is to mark block parameters if you have not already done so.
See “Marking Block Parameters” on page 7-6. If you have already marked
block signals, return to “Creating a Custom Graphical Interface” on page 7-3
for additional guidance on creating a user interface template model.
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• “Control Application at Target Computer Command Line” on page 8-2

• “Trace Signals at Target Computer Command Line” on page 8-3

• “Tune Parameters at Target Computer Command Line” on page 8-5

• “Alias Commands at Target Computer Command Line” on page 8-6

• “Find Signal and Parameter Indexes” on page 8-7
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Control Application at Target Computer Command Line
The Simulink Real-Time software provides a set of commands that you can
use to interact with the target application after it has been loaded to the
target computer, to configure and control the scopes for that application,
and to tune parameters.

These commands are particularly useful with standalone applications that
are not connected to the host computer. You type commands directly from a
keyboard attached to the target computer. As you start to type, a command
window appears on the target computer screen.

The target computer commands are case sensitive, but the arguments are not.
For more information, see “Target Computer Commands”
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Trace Signals at Target Computer Command Line
After you have built and downloaded a target application to the target
computer, you can use target computer commands to run your application
and to create and configure scopes.

To add signals to a scope, you must specify the signals by signal number. For
more information, see “Find Signal and Parameter Indexes” on page 8-7.

1 To start the target application, in the command line, type:

start

2 To add a target scope (scope 2), type

addscope 2

The Simulink Real-Time software adds another scope monitor to the target
computer screen. The command window displays a message to indicate
that the new scope has registered.

Scope: 2, created, type is target S0

3 To add a signal (0) to the new scope, type:

addsignal 2=0

The command window displays a message to indicate that the new
parameter has registered.

Scope: 2, signal 0 added

You can add more signals to the scope.

4 To start scope 2, type:

startscope 2

The target scope 2 starts and displays the signals you added in the default
format (graphical).

8-3



8 Execution Using the Target Computer Command Line

If you add a target scope from the target computer, you must start that
scope manually. If a target scope is in the model, starting the target
application starts that scope automatically.

5 To stop scope 2, type:

stopscope 2

6 To check the value of signal 0, type:

s0

The command window displays a message to indicate that the new
parameter has registered.

System: S0 has value 5.1851

7 To change the number of samples (to 1000) to acquire in scope 2, type:

numsamples 2=1000

You must stop the scope before changing a scope parameter.

8 To start scope 2, type:

startscope 2

The target scope 2 starts and displays the signals you added with the
updated sample count.

9 To stop scope 2, type:

stopscope 2

10 To stop the application, type:

stop
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Tune Parameters at Target Computer Command Line
After you have built and downloaded a target application to the target
computer, you can use target computer commands to tune parameters.

To tune parameters, you must specify them by parameter number. For more
information, see “Find Signal and Parameter Indexes” on page 8-7.

1 To check the frequency of the signal generator (parameter 6) of the model
xpcosc, type:

p6

The command window displays a message to indicate that the new
parameter has registered.

System: p[6] is set to 20.00000

2 To change the frequency of the signal generator, type:

setpar 6=30

The command window displays a message to indicate that the new
parameter has registered.

System: p[6] is set to 30.00000

The target computer command setpar does not work for vector parameters.

3 To change the stop time to 1000, type:

stoptime = 1000

The parameter changes are made to the target application but not to the
target object. When you type an Simulink Real-Time command in the
MATLAB Command Window, the target computer returns the current
properties of the target object.
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Alias Commands at Target Computer Command Line
You can use target computer command line variables to tag (or alias)
unfamiliar commands, parameter indexes, and signal indexes with more
descriptive names.

1 To create the aliases on and off for a parameter (7) that controls a motor,
type

setvar on = p7 = 1
setvar off = p7 = 0

The target computer command window is activated when you start to type,
and a command line opens.

2 Type the variable name to run that command sequence. For example, to
turn the motor on, type

on

The parameter P7 is changed to 1, and the motor turns on.
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Find Signal and Parameter Indexes
To fomd signal and parameter indexes using MATLAB language:

1 Build and download the model to the target computer.

2 At the Command Line, type:

tg = slrt

Target: TargetPC1
Connected = Yes
Application = xpcosc

.

.

.
Scopes = No Scopes defined
NumSignals = 7
ShowSignals = off

NumParameters = 7
ShowParameters = off

3 To display signal numbers, type:

tg.ShowSignals='on'

Target: TargetPC1
Connected = Yes
Application = xpcosc

.

.

.
Scopes = No Scopes defined
NumSignals = 7
ShowSignals = on
Signals = INDEX VALUE BLOCK NAME . . .

0 0.000000 Gain . . .
1 0.000000 Gain1 . . .
2 0.000000 Gain2 . . .
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3 0.000000 Integrator . . .
4 0.000000 Integrator1 . . .
5 0.000000 Signal Generator . . .
6 0.000000 Sum . . .

NumParameters = 7
ShowParameters = off

Use the Signals INDEX number in target computer commands such as
addsignal.

4 To display parameter numbers, type:

tg.ShowParameters='on'

Target: TargetPC1
Connected = Yes
Application = xpcosc

.

.

.
NumParameters = 7
ShowParameters = on
Parameters = INDEX VALUE . . . PARAMETER NAME . . .

0 1000000 . . . Gain . . .
1 400 . . . Gain . . .
2 1000000 . . . Gain . . .
3 0 . . . InitialCondition . . .
4 0 . . . InitialCondition . . .
5 4 . . . Amplitude . . .
6 20 . . . Frequency . . .

Use the Parameters INDEX number in target computer commands such as
setpar.

For more information about using signal and parameter numbers, see “Target
Computer Commands”.
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Web Browser Interface

In this section...

“Introduction” on page 9-2

“Connecting the Web Interface Through TCP/IP” on page 9-2

“Connecting the Web Interface Through RS-232” on page 9-3

“Using the Main Pane” on page 9-6

“Changing WWW Properties” on page 9-9

“Viewing Signals with a Web Browser” on page 9-9

“Viewing Parameters with a Web Browser” on page 9-10

“Changing Access Levels to the Web Browser” on page 9-11

Introduction
The Simulink Real-Time software has a Web server that allows you to interact
with your target application through a Web browser. You can access the Web
browser with either a TCP/IP or serial (RS-232) connection.

Note RS-232 Host-Target communication mode will be removed in a future
release. Use TCP/IP instead.

The Simulink Real-Time Web server is built into the kernel that allows you
to interact with your target application using a Web browser. If the target
computer is connected to a network, you can use a Web browser to interact
with the target application from a host computer connected to the network.

Connecting the Web Interface Through TCP/IP
If your host computer and target computer are connected with a network
cable, you can connect the target application on the target computer to a
Web browser on the host computer.

The TCP/IP stack on the Simulink Real-Time kernel supports only one
simultaneous connection, because its main objective is real-time applications.
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This connection is shared between the MATLAB interface and the Web
browser. You must close the other open connections to the target computer
before you connect using the host computer Web browser. This also means
that only one browser or the MATLAB interface is able to connect at one time.

Before you connect your Web browser on the host computer, you must load a
target application onto the target computer. The target application does not
have to be running, but it must be loaded. Also, your browser must have
JavaScript® and StyleSheets turned on.

Note Close the other connections to the target computer. For example, if you
are currently connected to the target computer through Simulink Real-Time
Explorer, right-click on that target computer icon and select Disconnect or
click the Disconnect icon on the toolbar.

1 In the MATLAB window, type

close(slrt)

The MATLAB interface is disconnected from the target computer, and the
connection is reset for connecting to another client. If you do not use this
command immediately before opening the Web interface, your browser
might not be able to connect to the target computer.

2 Open a Web browser. In the address box, enter the IP address and port
number you entered in the Simulink Real-Time Explorer window. For
example, if the target computer IP address is 192.168.0.10 and the port is
22222, type

http://192.168.0.10:22222/

The browser loads the Simulink Real-Time Web interface frame and panes.

Connecting the Web Interface Through RS-232
If the host computer and target computer are connected with a serial cable
instead of a network cable, you can still connect the target application on
the target computer to a Web browser on the host computer. The Simulink
Real-Time software includes a TCP/IP to RS-232 mapping application. This
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application runs on the host computer and writes whatever it receives from
the RS-232 connection to a TCP/IP port, and it writes whatever is receives
from the TCP/IP port to the RS-232 connection. TCP/IP port numbers must be
less than 216 = 65536.

Before you connect your Web browser on the host computer, you must load a
target application onto the target computer. The target application does not
have to be running, but it must be loaded. Also, your Web browser must have
JavaScript and StyleSheets turned on.

1 In the MATLAB window, type

close(slrt)

The MATLAB interface is disconnected from the target computer, leaving
the target computer ready to connect to another client. The TCP/IP stack of
the Simulink Real-Time kernel supports only one simultaneous connection.
If you do not use this command, the TCP/IP to RS-232 gateway might not
be able to connect to the target computer.

2 Open a DOS command window, and enter the command to start the TCP/IP
to RS-232 gateway. For example, if the target computer is connected to
COM1 and you would like to use the TCP/IP port 22222, type the following:

c:\<MATLAB root>\toolbox\rtw\targets\xpc\xpc\bin\xpctcp2ser
-v -t 22222 -c 1

For a description of the xpctcp2ser command, see “Syntax for the
xpctcp2ser Command” on page 9-5.

The TCP/IP to RS-232 gateway starts running, and the DOS command
window displays the message

*--------------------------------------------------------------*

* Simulink Real-Time TCP/IP to RS-232 gateway *

* Copyright 2000 The MathWorks *

*--------------------------------------------------------------*

Connecting COM to TCP port 22222

Waiting to connect
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If you did not close the MATLAB to target application connection,
xpxtcp2ser displays the message Could not initialize COM port.

3 Open a Web browser. In the address box, enter

http://localhost:22222/

The Web browser loads the Simulink Real-Time Web interface panes.

4 Using the Web interface, start and stop the target application, add scopes,
add signals, and change parameters.

5 In the DOS command window, press Ctrl+C.

The TCP/IP to RS-232 Gateway stops running, and the DOS command
window displays the message

interrupt received, shutting down

The gateway application has a handler that responds to Ctrl+C by
disconnecting and shutting down cleanly. In this case, Ctrl+C is not used
to abort the application.

6 In the MATLAB Command Window, type

slrt

The MATLAB interface reconnects to the target application and lists the
properties of the target object.

If you did not close the gateway application, the MATLAB window displays
the message

Error in ==>
C:\MATLABR13\toolbox\rtw\targets\xpc\xpc\@xpc\xpc.m
On line 31 ==> sync(xpcObj);

You must close the MATLAB interface and then restart it.

Syntax for the xpctcp2ser Command
The xpctcp2ser command starts the TCP/IP to RS-232 gateway. The syntax
for this command is
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xpctcp2ser [-v] [-n] [-t tcpPort] [-c comPort]
xpctcp2ser -h

The options are described in the following table.

Command-
Line Option Description

-v Verbose mode. Produces a line of output every time a
client connects or disconnects.

-n Allows nonlocal connections. By default, only clients
from the same computer that the gateway is running
on are allowed to connect. This option allows anybody
to connect to the gateway.

If you do not use this option, only the host computer
that is connected to the target computer with a serial
cable can connect to the selected port. For example,
if you start the gateway on your host computer, with
the default ports, you can type in the Web browser
http://localhost:2222. However, if you try to connect
to http://Domainname.com:22222, you will probably
get a connection error.

-t tcpPort Use TCP port tcpPort. Default t is 22222. For example,
to connect to port 20010, type -t 20010.

-h Print a help message.

-c comPort Use COM port comPort (1 <= comPort <= 4). Default is
1. For example, to use COM2, type -c 2.

Using the Main Pane
TheMain pane is divided into four parts, one below the other. The four parts
are System Status, Simulink Real-Time Properties, Navigation, and
WWW Properties.

After you connect a Web browser to the target computer, you can use the
Main pane to control the target application:

1 In the left frame, click the Refresh button.
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System status information in the top cell is uploaded from the target
computer. If the right frame is either the Signals List pane or the Screen
Shot pane, updating the left frame also updates the right frame.

2 Click the Start Execution button.

The target application begins running on the target computer, the Status
line is changed from Stopped to Running, and the Start Execution
button text changes to Stop Execution.

3 Update the execution time and average task execution time (TET).
Click the Refresh button. To stop the target application, click the Stop
Execution button.

4 Enter new values in the StopTime and SampleTime boxes, then click
the Apply button. You can enter -1 or Inf in the StopTime box for an
infinite stop time.

The new property values are downloaded to the target application. Note
that the SampleTime box is visible only when the target application is
stopped. You cannot change the sample time while a target application
is running. (See “Alternative Configuration and Control Methods” for
limitations on changing sample times.)

5 Select scopes to view on the target computer. From the ViewMode list,
select one or all of the scopes to view.
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After entering values, the screen looks like this:
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Note The ViewMode control is visible in the Simulink Real-Time
Properties pane only if you add two or more scopes to the target computer.

Changing WWW Properties
The WWW Properties cell in the left frame contains fields that control the
display on the Web interface itself, and not the application. There are two
fields: maximum signal width to display and refresh interval.

1 In the Maximum Signal Width box enter -1, Inf (show all signals), 1
(show only scalar signals), 2 (show scalar and vector signals less than or
equal to 2 wide), or n (show signals with a width less than or equal to n).

Signals with a width greater than the value you enter are not displayed
on the Signals pane.

2 In the Refresh Interval box, enter a value greater than 10. For example,
enter 20.

The signal pane updates automatically every 20 seconds. Entering -1 or
Inf does not automatically refresh the pane.

Sometimes, both the frames try to update simultaneously, or the auto refresh
starts before the previous load has finished. This problem can happen with
slow network connections. In this case, increase the refresh interval or
manually refresh the browser (set the Refresh Interval = Inf).

This can also happen when you are trying to update a parameter or property
at the same time that the pane is automatically refreshing.

Sometimes, when a race condition occurs, the browser becomes confused about
the format, and you might have to refresh it. This should not happen often.

Viewing Signals with a Web Browser
The Signals pane is a list of the signals in your model.

After you connect a Web browser to the target computer you can use the
Signals pane to view signal data:
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1 In the left frame, click the Signals button.

The Signals pane is loaded in the right frame with a list of signals and the
current values.

2 On the Signals pane in the right frame, click the Refresh button.

The Signals pane is updated with the current values. Vector/matrix
signals are expanded and indexed in the same column-major format that
the MATLAB interface uses. This can be changed by the Maximum
Signal Width value you enter in the left frame.

3 In the left frame, click the Screen Shot button.

The Screen Shot pane is loaded and a copy of the current target computer
screen is displayed. The screen shot uses the portable network graphics
(PNG) file format.

Viewing Parameters with a Web Browser
The Parameters pane displays the tunable parameters in your model. Row
and column indices for vector/matrix parameters are also shown.

After you connect a Web browser to the target computer, you can use the
Parameters pane to change parameters in your target application while it is
running in real time:

1 In the left frame, click the Parameters button.

The Parameter List pane is loaded into the right frame.

If the parameter is a scalar parameter, the current parameter value is
shown in a box that you can edit.

If the parameter is a vector or matrix, click the Edit button to view the
vector or matrix. You can edit the parameter in this pane.

2 In the Value box, enter a new parameter value, and then click the Apply
button.
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Changing Access Levels to the Web Browser
The Web browser interface allows you to set access levels to the target
application. The different levels limit access to the target application. The
highest level, 0, is the default level and allows full access. The lowest level, 4,
only allows signal monitoring and tracing with your target application.

1 In the Simulink window, click Simulation > Model Configuration
Parameters.

The Configuration Parameters dialog box for the model is displayed.

2 Click the Code Generation node.

The code generation pane opens.

3 In the Target selection section, access levels are set in the System
target file box. For example, to set the access level to 1, enter

slrt.tlc -axpcWWWAccessLevel=1

If you do not specify -axpcWWWAccessLevel, the highest access level (0) is
set.

4 Click OK.

The various fields disappear, depending on the access level. For example, if
your access level does not allow you access to the parameters, you do not see
the button for parameters.

There are various access levels for monitoring, which allow different levels
of hiding. The proposed setup is described below. Each level builds on
the previous one, so only the incremental hiding of each successive level is
described.

Level 0 — Full access to the panes and functions.

Level 1 — Cannot change the sample and stop times. Cannot change
parameters, but can view parameters.

Level 2 — Cannot start and stop execution of the target application or log
data.
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Level 3 — Cannot view parameters. Cannot add new scopes, but can edit
existing scopes.

Level 4 — Cannot edit existing scopes on the Scopes pane. Cannot add or
remove signals on the Scopes pane. Cannot view the Signals pane and the
Parameters pane, and cannot get scope data.
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Building Referenced Models in Parallel
The Simulink Real-Time software allows you to build referenced models in
parallel on a compute cluster. In this way, you can more quickly build and
download Simulink Real-Time applications to the target computer.

The following procedure assumes you have a functioning Simulink Real-Time
installation on your host computer.

1 Identify a set of worker computers, which might be separate cores on your
host computer or computers in a remote cluster running under Windows.

2 If you intend to use separate cores on the host computer, install Parallel
Computing Toolbox™ on the host computer.

3 If you intend to use computers in a remote cluster:

a Install the following on each cluster computer:

• MATLAB

• Parallel Computing Toolbox

• MATLAB Distributed Computing Server™

• Simulink Real-Time

• Build compiler

Install the same compiler and compiler version at the same location
as on the host computer.

b Start and configure the remote cluster according to the instructions at
http://www.mathworks.com/support/product/DM/installation/ver_current/.

4 Run MATLAB on the host computer.

5 In MATLAB, call the parpool function to open a parallel pool on the cluster.

6 Call the pctRunOnAll function to configure the compiler for the remote
workers as a group. For example:

pctRunOnAll('slrtsetCC(''VisualC'',

''C:\Program Files\Microsoft Visual Studio 9.0'')')
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In this configuration, the host computer and the remote workers have
installed Microsoft Visual Studio® 9.0 at C:\Program Files\Microsoft
Visual Studio 9.0.

7 Build and download your model.

See “Reduce Build Time for Referenced Models” for more about increasing
the speed of parallel builds.
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Multicore Processor Configuration
For better performance on your target computer, you can run multirate target
applications on multiple cores. Use this capability if your target computer
has a multicore processor and you want to take advantage of it for multirate
models. Before you consider enabling this capability, see “BIOS Settings” for
the effects of BIOS settings.

To build and download multirate models on your multiple core target
computer:

1 Type slrtexplr in the MATLAB Command Window.

2 In the Targets pane, expand the target computer node.

3 Click the Target Properties icon in the toolbar or double-click
Properties.

4 Select theMulticore CPU check box in the Target settings pane.

5 Open your model in Simulink Editor.

6 Add a Rate Transition block to transition between rates.

Note Multirate models must use Rate Transition blocks. If your model
uses other blocks for rate transitions, building the model generates an error.

7 Select the Ensure data integrity during data transfer check box of the
Rate Transition block parameters.

8 Clear the Ensure deterministic data transfer (maximum delay)
check box of the Rate Transition block parameters. This forces the Rate
Transition block to use the most recent data available.

Note Because this box is cleared, the transferred data might differ from
run to run.
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9 In Simulink Editor, select View > Model Explorer.

10 In Simulink Model Explorer, right click in theModel Hierarchy pane and
select Configuration > Add configuration for concurrent execution

11 In the new configuration, select Solver.

12 Check Enable concurrent tasking.

13 Click Configure Tasks.

For more on configuring your model for concurrent execution, see “How
Simulink Solves Parallel and Multicore Processing Problems”.
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Execution Profiling for Target Applications
You can profile the task execution time of your target application running
on the target computer. Using that information, you can then tune its
performance.

Profiling is especially useful if the target application is configured to take
advantage of multicore processors on the target computer. See “Multicore
Processor Configuration” on page 10-4.

To profile the target application:

1 Configure the model to enable the collection of profile data during execution.

2 Build, download, and execute the model.

3 Display and evaluate the profile data.

Profiling slightly increases the execution time of the target application.
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Configure Target Application for Profiling
This example shows how to configure model dxpcmds6t for task execution
profiling.

1 Open model dxpcmds6t.

2 In the top model, open the Configuration Parameters dialog box, and select
Code Generation > Verification.

3 Select the Measure task execution time check box.

4 In the Workspace variable text box, specify a name. After you execute
the target application and call the profile_xpc function, the software
generates a workspace variable of type coder.profile.ExecutionTime.
The software stores the execution time measurements in this variable.

5 From the Save options drop-down list, select one of the following:

• Summary data only — Generates only a Code Execution Profiling
Report, reduces memory usage during a long simulation.

• All measurement and analysis data — Generates an Execution
Profile plot and a Code Execution Profiling Report. Stores execution
time data in the base workspace.

You can use methods from the coder.profile.ExecutionTime and
coder.profile.ExecutionTimeSection classes to plot execution times
and compare various scenarios.

10-7



10 Tuning Performance

6 Under Code Generation, select Simulink Real-Time Options.

7 Type a value for Number of profiling events (each uses 20 bytes).

By default, the software logs 5000 events for profiling. You can
increase or decrease this number to manage memory usage. When
the software logs the specified number of events or the model stops,
the software stops collecting the data. The software writes the data to
current_working_folder\xPCTrace.csv on the target computer.
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8 Click OK.

9 Save model dxpcmds6t.
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Generate Target Application Execution Profile
This example shows how to generate profile data for model dxpcmds6t using
default settings on a multicore target computer.

This procedure assumes that you have configured the target computer to take
advantage of multiple cores. It also assumes that you have configured the
model for task execution profiling.

Build and download the model.

mdl='dxpcmds6t';

open_system(mdl);

rtwbuild(mdl);

When you include profiling, the Code Generation Report is generated by
default. It contains links to the generated C code and include files. By clicking
these links, you can examine the generated code and understand the Code
Execution Profile Report better.
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Execute the target application.

tg = slrt;

tg.start;

pause(2);

tg.stop;

Profile the target application execution.

profileInfo.modelname = 'dxpcmds6t.mdl';

profData = profile_xpc(profileInfo);
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The Execution Profile plot shows the allocation of execution cycles across the
four processors, indicated by the colored horizontal bars.
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The Code Execution Profiling Report displays model execution profile results
for each task.

Profile Data Description

Maximum
turnaround time

Longest time between when the task starts and
finishes. This time includes task preemptions
(interrupts).

Average turnaround
time

Average time between when the task starts and
finishes. This time includes task preemptions
(interrupts).
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Profile Data Description

Maximum execution
time

Longest time between when the task starts
and finishes. This time does not include task
preemptions (interrupts).

Average execution
time

Average time between when the task starts
and finishes. This time does not include task
preemptions (interrupts).

Calls Number of times the generated code section is called.

To display the profile data for the generated code section, click theMembrane

icon in the Coder Execution Profiling Report.

Close the model.

close_system(mdl,0);

See Also profile_xpc

Related
Examples

• “Multicore Processor Configuration” on page 10-4
• “Configure Target Application for Profiling” on page 10-7
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An important part of the “Rapid Control Prototyping” and
“Hardware-in-the-Loop Simulation” workflows is preparing stress test
and regression test scripts. The Simulink Real-Time product includes
specialized MATLAB classes and functions for setting up the target
environment, booting the target computer, loading and running the
target application, and displaying and recording the results. You can do
these tasks using MATLAB functions and target and scope class objects.

• Chapter 11, “Targets and Scopes in the MATLAB Interface”

• Chapter 12, “Logging Signal Data with File System Objects”
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• “Target Driver Objects” on page 11-2

• “Create Target Objects” on page 11-3

• “Display Target Object Properties” on page 11-4

• “Set Target Object Property Values” on page 11-5

• “Get Target Object Property Values” on page 11-6
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Target Driver Objects
The Simulink Real-Time software uses a SimulinkRealTime.target object
to represent the target kernel and your target application. Use target object
functions to run and control real-time applications on the target computer
with scope objects to collect signal data.

An understanding of the target object properties and methods helps you to
control and test your application on the target computer.

A target object on the host computer represents the interface to a target
application and the kernel on the target computer. You use target objects to
run and control the target application.

When you change a target object property on the host computer, information
is exchanged with the target computer and the target application.

To create a target object:

1 Build a target application. The Simulink Real-Time software creates a
target object during the build process.

2 Use the target object constructor function SimulinkRealTime.target
(constructor). In the MATLAB Command window, type tg =
SimulinkRealTime.target.

A SimulinkRealTime.target object has properties and methods specific to
that object. The target application object methods allow you to control a target
application on the target computer from the host computer. You enter target
application object methods in the MATLAB window on the host computer, or
you can use MATLAB code scripts. To access the help for these methods from
the command line, use the syntax:

doc SimulinkRealTime.target/method_name

If you want to control the target application from the target computer, use
target computer commands (see “Control Application at Target Computer
Command Line” on page 8-2).
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Create Target Objects
To create a target object:

1 Build a target application. The Simulink Real-Time software creates a
target object during the build process.

2 To create a single target object, or to create multiple target
objects in your system, use the target object constructor function
SimulinkRealTime.target with arguments. For example, the following
creates a target object for target TargetPC1. In the MATLAB Command
Window, type:

tg = SimulinkRealTime.target('TargetPC1')

The resulting target object is tg.

Using this method clarifies which target object is associated with a
particular target computer.

3 To check a connection between a host and a target, use the target function
SimulinkRealTime.target.ping. For example, type:

tg.targetping

4 To create a single target object, or to create the first of many
targets in your system, use the target object constructor function
SimulinkRealTime.target without arguments. For example, in the
MATLAB Command Window, type:

tg = SimulinkRealTime.target

The resulting target object is tg.

Note If you use SimulinkRealTime.target without arguments to create
a target object, use Simulink Real-Time Explorer to configure your target
computer. Doing so clarifies which target object is associated with a particular
target computer.
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Display Target Object Properties
You might want to list the target object properties to monitor a target
application. The properties include the execution time and the average task
execution time.

After you build a target application and target object from a Simulink model,
you can list the target object properties. This procedure uses the default
target object name tg as an example.

1 In the MATLAB window, type:

tg = slrt;

The current target application properties are uploaded to the host
computer. MATLAB displays a list of the target object properties with
the updated values.

The target object properties for TimeLog, StateLog, OutputLog, and TETLog
are not updated at this time.

2 Type:

tg.start

The Status property changes from stopped to running. The log properties
change to Acquiring.

For a list of target object properties with a description, see the target object
function SimulinkRealTime.target.get.

11-4



Set Target Object Property Values

Set Target Object Property Values
You can change a target object property by using the Simulink Real-Time
software set method or the dot notation on the host computer. (For
limitations on target property changes to sample times, see “Alternative
Configuration and Control Methods”.)

With the Simulink Real-Time software, you can use a function syntax
or an object property syntax to change the target object properties. The
syntax set(target_object, property_name, new_property_value) can be
replaced by:

target_object.property_name = new_property_value

For example, to change the stop time for the target application running on
target tg, in the MATLAB window, type one of the following:

tg = slrt;
tg.StopTime = 1000
tg.set('stoptime',1000)
set(tg,'stoptime',1000)

When you change a target object property, the new property value is
downloaded to the target computer. The Simulink Real-Time kernel then
receives the information and changes the behavior of the target application.

To get a list of the writable properties, type set(target_object). The build
process assigns the default name of the target object to tg.
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Get Target Object Property Values
You can list a property value in the MATLAB window or assign that value
to a MATLAB variable. With the Simulink Real-Time software, you can
use either a function syntax or an object property syntax. The syntax
get(target_object, property_name) can be replaced by:

target_object.property_name

For example, to access the stop time for the target application running on
target tg, in the MATLAB window, type one of the following:

tg = slrt;
endrun = tg.StopTime
endrun = tg.get('stoptime')
endrun = get(tg,'stoptime')

To get a list of readable properties, type target_object. Without assignment
to a variable, the property values are listed in the MATLAB window.

Signals are not target object properties. To get the value of the Integrator1
signal from the model xpcosc, in the MATLAB window, type one of the
following:

tg.getsignal(0)
outputvalue = getsignal(tg,0)

0 is the signal index.

Note Method names are case sensitive. You must type the entire name.
Property names are not case sensitive. You do not need to type the entire
name, as long as the characters you do type are unique for the property.
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Use Target Object Methods
Use the method syntax to run a target object method. The syntax
method_name(target_object, argument_list) can be replaced with:

target_object.method_name(argument_list)

Unlike properties, for which partial but unambiguous names are permitted,
you must enter method names in full, in lowercase. For example, to add
a target scope with a scope index of 1, in the MATLAB window, type one
of the following:

tg = slrt;
tg.addscope('target',1)
addscope(tg,'target',1)
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Target Scope Objects
The Simulink Real-Time software uses scope objects to represent scopes on the
target computer. Use scope object functions to view and collect signal data.

The Simulink Real-Time software uses scopes and scope objects as an
alternative to using Simulink scopes and external mode. A scope can exist as
part of a Simulink model system or outside a model system.

• A scope that is part of a Simulink model system is a scope block. You add
an Simulink Real-Time scope block to the model, build an application from
that model, and download that application to the target computer.

• A scope that is outside a model is not a scope block. For example, if you
create a scope with the SimulinkRealTime.target.addscope method, that
scope is not defined within the model. After the model has been downloaded
and initialized, you add this scope to the model.

This difference affects when and how the scope executes to acquire data.

Scope blocks inherit sample times. A scope block in the root model or a normal
subsystem executes at the sample time of its input signals. A scope block in a
conditionally executed (triggered/enabled) subsystem executes whenever the
containing subsystem executes. In the latter case, the scope might acquire
samples at irregular intervals.

A scope that is not part of a model executes at the base sample time of the
model. Therefore, it might acquire repeated samples. For example, if the
model base sample time is 0.001, and you add to the scope a signal whose
sample time is 0.005, the scope acquires five identical samples for this signal,
and then the next five identical samples, and so on.

Understanding the structure of scope objects helps you to use the MATLAB
command-line interface to view and collect signal data. A scope object on the
host computer represents a scope on the target computer. You use scope
objects to observe the signals from your target application during a real-time
run or analyze the data after the run is finished.

To create a scope object:
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• Add an Simulink Real-Time scope block to your Simulink model, build
the model to create a scope, and then use the target object method
SimulinkRealTime.target.getscope to create a scope object.

• Use the target object method SimulinkRealTime.target.addscope to
create a scope, create a scope object, and assign the scope properties to
the scope object.

Upon creation, the Simulink Real-Time software assigns the required scope
object class for the scope type:

• Target scopes — SimulinkRealTime.targetScope, created by calling
SimulinkRealTime.target.getscope with scope type target.

• Host scopes — SimulinkRealTime.hostScope, created by calling
SimulinkRealTime.target.getscope with scope type host.

• File scopes – SimulinkRealTime.fileScope, created by calling
SimulinkRealTime.target.getscope with scope type file.

A scope object has associated properties and methods specific to that scope
type, as well as properties and methods held in common with the other scopes.
The scope object methods allow you to control scopes on your target computer.

If you want to control the target application from the target computer, use
target computer commands (see “Control Application at Target Computer
Command Line” on page 8-2).
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Display Scope Object Properties for One Scope
To list the properties of a single scope object, sc1, in the MATLAB window,
type one of the following:

tg = slrt;
sc1 = tg.getscope(1)
sc1 = getscope(tg,1)

MATLAB creates the scope object sc1 from a previously created scope.

The current scope properties are uploaded to the host computer. MATLAB
displays a list of the scope object properties with the updated values. Because
sc1 is a vector with a single element, you could also type sc1(1) or sc1([1]).

Note Only scopes of type host store data in the properties
scope_object.Time and scope_object.Data.

For a list of target object properties with a description, see the target function
SimulinkRealTime.target.get.
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Display Scope Object Properties for All Scopes
To list the properties of the current scope objects associated with the target
object tg, in the MATLAB window, type one of the following:

tg = slrt;
tg.getscope
getscope(tg)

MATLAB displays a list of the scope objects associated with the target object.

Alternatively, type one of the following:

allscopes = tg.getscope
allscopes = getscope(tg)

The current scope properties are uploaded to the host computer. MATLAB
displays the scope object properties with updated values. To list some of the
scopes, use the vector index. For example, to list the first and third scopes,
type allscopes([1,3]).

For a list of target object properties with a description, see the target function
SimulinkRealTime.target.get.
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Set Scope Property Values
With the Simulink Real-Time software, you can use either a function syntax or
an object property syntax. The syntax set(scope_object, property_name,
new_property_value) can be replaced by:

scope_object(index_vector).property_name = new_property_value

For example, to change the trigger mode for scope 1, in the MATLAB window,
type one of the following:

tg = slrt;
sc1 = tg.getscope(1);
sc1.triggermode = 'signal'
sc1.set('triggermode', 'signal')
set(sc1,'triggermode', 'signal')

You cannot use dot notation to set vector object properties. To assign
properties to a vector of scopes, use the set method. For example, assume you
have a variable sc12 for two scopes, 1 and 2. To set the NumSamples property
of these scopes to 300, in the MATLAB window, type the following:

set(sc12,'NumSamples',300)

To get a list of the writable properties, type set(scope_object).

Note Method names are case sensitive. You must type the entire name.
Property names are not case sensitive. You do not need to type the entire
name as long as the characters you do type are unique for the property.
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Get Scope Property Values
You can list a property value in the MATLAB window or assign that value
to a MATLAB variable. With the Simulink Real-Time software, you can use
either a function syntax or an object property syntax.

The syntax get(scope_object_vector, property_name) can be replaced by:

scope_object_vector(index_vector).property_name

For example, to assign the number of samples from scope 1, in the MATLAB
window, type one of the following:

tg = slrt;
sc1 = tg.getscope(1);
numsamples = sc1.NumSamples
numsamples = sc1.get('NumSamples')
numsamples = get(sc1,'NumSamples')

You cannot use dot notation to get the values of vector object properties. To
get properties of a vector of scopes, use the get method. For example, assume
you have two scopes, 1 and 2, assigned to the variable sc12.

To get the value of NumSamples for these scopes, in the MATLAB window,
type the following:

get(sc12,'NumSamples')

You get a result like the following:

ans =
[300]
[300]

To get a list of readable properties, type scope_object. The property values
are listed in the MATLAB window.
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Note Method names are case sensitive. You must type the entire name.
Property names are not case sensitive. You do not need to type the entire
name as long as the characters you do type are unique for the property.
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Use Scope Object Methods
Use the method syntax to run a scope object method. The syntax
method_name(scope_object_vector, argument_list) can be replaced with
either of:

scope_object.method_name(argument_list)
scope_object_vector(index_vector).method_name(argument_list)

Unlike properties, for which partial but unambiguous names are permitted,
enter method names in full, in lowercase. For example, to add signals to
the first scope in a vector of all scopes, in the MATLAB window, type one
of the following:

allscopes = tg.getscope
allscopes = getscope(tg)
allscopes(1).addsignal([0,1])
addsignal(allscopes(1), [0,1])
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Acquire Signal Data with File Scopes
You can acquire signal data into a file on the target computer. To do so,
you add a file scope to the application. After you build an application and
download it to the target computer, you can add a file scope to that application.

For example, to add a file scope named sc to the application, and to add signal
4 to that scope:

1 In the MATLAB window, type:

tg = slrt;
sc=tg.addscope('file')

The Simulink Real-Time software creates a file scope for the application.

2 To add signal 4, type:

sc.addsignal(4)

3

Caution The software overwrites previously acquired data in files of the
specified name or name pattern when the file scope starts. Copy previously
acquired data to the host computer before starting the scope, otherwise
it is lost.

To start the scope, type:

sc.start

4 To start the target application, type:

tg.start

The Simulink Real-Time software adds signal 4 to the file scope. When you
start the scope and application, the scope saves the signal data for signal 4 to
a file, by default named C:\data.dat.
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• For more information on file scopes, see “Configure Real-Time File Scope
Blocks” on page 5-74.

• To retrieve the file programmatically from the target computer for analysis,
see “Using SimulinkRealTime.fileSystem Objects” on page 12-4.

• To acquire signal data into multiple files, see “Acquire Signal Data into
Dynamically Named Files” on page 11-18.
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Acquire Signal Data into Dynamically Named Files
You can acquire signal data into multiple, dynamically named files on the
target computer. For example, you can acquire data into multiple files to
examine one file while the scope continues to acquire data into other files. To
acquire data in multiple files, add a file scope to the application. After you
build an application and download it to the target computer, you can add a
file scope to that application. You can then configure that scope to log signal
data to multiple files.

For example, configure a file scope named sc to the application with the
following characteristics:

• Logs signal data into up to nine files whose sizes do not exceed 4096 bytes.

• Creates files whose names contain the string file_.dat.

• Contains signal 4.

1 In the MATLAB window, type:

tg = slrt;
tg.StopTime = Inf;

This parameter value directs the target application to run indefinitely.

2 To add a file scope, type:

sc=tg.addscope('file');

3 To enable the file scope to create multiple log files, type:

sc.DynamicFileName='on';

Enable this setting to enable logging to multiple files.

4 To enable file scopes to collect data up to the number of samples, and then
start over again, type:

sc.AutoRestart='on';

Use this setting for the creation of multiple log files.
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5 To limit each log file size to 4096, type:

sc.MaxWriteFileSize=4096;

You must use this property. Set MaxWriteFileSize to a multiple of the
WriteSize property.

6 To enable the file scope to create multiple log files with the same name
pattern, type:

sc.Filename='file_<%>.dat';

This sequence directs the software to create up to nine log files, file_1.dat
to file_9.dat on the target computer file system.

7 To add signal 4 to the file scope, type:

sc.addsignal(4);

8

Caution The software overwrites previously acquired data in files of the
specified name or name pattern when the file scope starts. Copy previously
acquired data to the host computer before starting the scope, otherwise
it is lost.

To start the scope, type

sc.start

9 To start the target application, type

tg.start

The software creates a log file named file_1.dat and writes data to that file.
When the size of file_1.dat reaches 4096 bytes (value of MaxWriteFileSize),
the software closes the file and creates file_2.dat. When its size reaches
4096 bytes, the software closes it and creates file_3.dat, and so on.
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The software repeats this sequence until it fills the last log file, file_9.dat.
If the target application continues to run and collect data after file_9.dat,
the software reopens file_1.dat and overwrites the existing contents. It
cycles through the other log files sequentially.

• For more information on file scopes, see “Configure Real-Time File Scope
Blocks” on page 5-74.

• To retrieve the file programmatically from the target computer for analysis,
see “Using SimulinkRealTime.fileSystem Objects” on page 12-4.

• To acquire signal data into a single file, see “Acquire Signal Data with
File Scopes” on page 11-16.

11-20



Scope Trigger Configuration

Scope Trigger Configuration
You can configure Simulink Real-Time scopes to acquire data right away, or
define triggers for scopes so that the Simulink Real-Time scopes wait until
they are triggered to acquire data. You can configure Simulink Real-Time
scopes to start acquiring data when a predefined trigger condition is met. The
exact condition depends on the trigger mode that you select.

• Freerun— Acquires data as soon as the scope is started (default).

• Software — Acquires data in response to a user request, such as a call
to one of the scope methods SimulinkRealTime.fileScope.trigger,
SimulinkRealTime.hostScope.trigger, and
SimulinkRealTime.targetScope.trigger or a call to the C API function
xPCScSoftwareTrigger.

• Signal— Acquires data when a particular signal has crossed a preset level.

• Scope— Acquires data when another (triggering) scope starts.

You can use several properties to further refine when a scope starts to acquire
data. For example, if you want the scope to be triggered when another signal
crosses a certain value, use Signal trigger mode. Specify the following:

• The signal to trigger the scope.

• The trigger level that the signal must cross to trigger the scope to start
acquiring data.

• Whether the scope is triggered on a rising signal, falling signal, or either
one.

The trigger point is the sample at which the scope trigger condition is
satisfied. For signal triggering, the trigger point is the sample at which the
trigger signal passes through the trigger level. At the trigger point, the
scope acquires the first sample. By default, scopes start acquiring data from
the trigger point onwards. You can modify this behavior using pre- and
post-triggering with the NumPrePostSamples scope property. See “Pre- and
Post-Triggering of Scopes” on page 11-22.
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Pre- and Post-Triggering of Scopes
By default, the scope starts acquiring data at the same time as the trigger
event (the trigger point). In some cases, you want to observe the sequence of
values that led to the trigger, so you start acquiring data a given number
of samples before the trigger event (pre-triggering). In other cases, you
want to observe the system settling down after the trigger event, so you
delay acquiring data a given number of samples after the trigger event
(post-triggering).

Use the NumPrePostSamples scope property to specify pre- and post-triggering.
A negative value indicates pre-triggering and a positive value indicates
post-triggering. For example, suppose P is the value of NumPrePostSamples for
Scope 1 and TP is the trigger point, the sample where the trigger event occurs.

• P = 0— Scope 1 starts acquiring data immediately at trigger point TP.
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• P < 0— Scope 1 starts acquiring data |P| samples before trigger point TP.

• P > 0— Scope 1 starts acquiring data P samples after trigger point TP.
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Trigger One Scope with Another Scope
When you have started two scopes that you want to keep synchronized, you
can trigger one scope with another to acquire data. Set up the first scope with
the trigger of your choice, and then trigger the second scope from the first.

In the following setup, Scope 1 triggers Scope 2.

1 Two scope objects are configured as a vector with the command:

tg = slrt;
sc = tg.addscope('host', [1 2]);

2 For Scope 1, set the following values:

sc(1).ScopeId = 1
sc(1).NumSamples = N1
sc(1).NumPrePostSamples = P1

3 For Scope 2, set the following values:

sc(2).ScopeId = 2
sc(2).NumSamples = N2
sc(2).TriggerMode = 'Scope'
sc(2).TriggerScope = 1
sc(2).NumPrePostSamples = P2

Because Scope 2 is triggered by Scope 1, the trigger point TP is the same for
both scopes. However, different samples can be acquired by Scopes 1 and 2.

Scope-Triggered Data Acquisition
Some representative relationships between data acquisitions by Scope 1
and Scope 2 are shown in the following figures. P1 and P2 are the values
of NumPrePostSamples for Scopes 1 and 2. TP is the trigger point, the
sample where a trigger event occurs, for both Scopes 1 and 2. Scope 2 begins
acquiring data as described.
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• P1 = 0 and P2 = 0— Scopes 1 and 2 start acquiring data immediately at
trigger point TP.
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• P1 < 0 and P2 > 0 — Scope 1 starts acquiring data |P1| samples before
trigger point TP. Scope 2 starts acquiring data P2 samples after trigger
point TP.
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• P1 > 0 and P2 < 0— Scope 1 starts acquiring data P1 samples after trigger
point TP. Scope 2 starts acquiring data |P2| samples before trigger point TP.

Trigger Sample Setting
For additional flexibility in scope triggering, you can use the Scope 2 trigger
sample setting.

sc(2).TriggerSample = range 0 to (N + P1 - 1)
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• sc(2).TriggerSample = 0 (default) — Scope 2 triggers when Scope 1
triggers. Trigger point TP is the same sample for both scopes.
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• sc(2).TriggerSample = ts > 0 — Scope 2 triggers ts samples after
Scope 1 is triggered. Trigger point TP2 for Scope 2 is ts samples after TP1
for Scope 1.

Setting sc(2).TriggerSample to a value ts larger than (N + P - 1) does
not cause an error. It implies that Scope 2 cannot be triggered, because
Scope 1 cannot acquire more than (N + P - 1) samples after TP.
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• sc(2).TriggerSample = -1 (special case) — Causes Scope 2 to start
acquiring data from the sample after Scope 1 stops acquiring.
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Acquire Gap-Free Data Using Two Scopes
With two scopes, you can acquire gap-free data. Gap-free data is data that
two scopes acquire consecutively, without overlap. The first scope acquires
data up to sample N, then stops. The second scope begins to acquire data at
sample N+1.

In the following example, the TriggerMode property of Scope 1 is set to
'Software'. This setting allows Scope 1 to be triggered when it receives the
MATLAB command sc1.trigger.

To programmatically acquire gap-free data with two scopes:

1 Build and download the Simulink model xpcosc to the target computer.

2 In the MATLAB Command Window, assign tg to the target computer and
set the StopTime property to 1. For example:

tg = slrt;
tg.StopTime = 1;
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3 Add two host scopes to the target application. You can assign the two scopes
to a vector, sc, so that you can work with both scopes with one command.

sc = tg.addscope('host', [1 2]);

4 Add the signals of interest (0 and 1) to both scopes.

addsignal(sc,[0 1]);

5 Set the NumSamples property for both scopes to 500 and the TriggerSample
property for both scopes to -1. With this property setting, each scope
triggers the next scope at the end of its 500 sample acquisition.

set(sc, 'NumSamples', 500, 'TriggerSample', -1)

6 Set the TriggerMode property for both scopes to 'Scope'. Set the
TriggerScope property such that each scope is triggered by the other.

set(sc, 'TriggerMode', 'Scope');
sc(1).TriggerScope = 2;
sc(2).TriggerScope = 1;

7 Set up storage for time, t, and signal, data acquisition.

t = [];
data = zeros(0, 2);

8 Start both scopes and the model.

start(sc);
start(tg);

Both scopes receive exactly the same signals, 0 and 1.

9 Trigger scope 1 to start acquiring data.

scNum = 1;
sc(scNum).trigger;

Setting scNum to 1 indicates that scope 1 will acquire data first.

10 Start acquiring data using the two scopes to double buffer the data.
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while (1)
% Wait until this scope has finished acquiring 500 samples
% or the model stops (scope is interrupted).
while ~(strcmp(sc(scNum).Status, 'Finished') || ...

strcmp(sc(scNum).Status, 'Interrupted')), end
% Stop buffering data when the model stops.
if strcmp(tg.Status, 'stopped')

break
end
% Save the data.
t( end + 1 : end + 500) = sc(scNum).Time;
data(end + 1 : end + 500, :) = sc(scNum).Data;
% Restart this scope.
start(sc(scNum));
% Switch to the next scope.

%Shortcut for if(scNum==1) scNum=2;else scNum=1,end
scNum = 3 - scNum;
end

11 When done, remove the scopes.

% Remove the scopes we added.
remscope(tg,[1 2]);

Following is a complete code listing for the preceding double-buffering data
acquisition procedure. After you download the model (xpcosc) to the target
computer, you can copy and paste this code into a MATLAB file and run it.
The communication speed between the host and target computer must be fast
enough to handle the number of samples and can acquire the full data set
before the next acquisition cycles starts. In a similar way, you can use more
than two scopes to implement a triple- or quadruple-buffering scheme.

% Assumes model xpcosc.mdl has been built and loaded on the target computer.

% Attach to the target computer and set StopTime to 1 sec.

tg = slrt;

tg.StopTime = 1;

% Add two host scopes.

sc = tg.addscope('host', [1 2]);

% [0 1] are the signals of interest. Add to both scopes.

addsignal(sc,[0 1]);

% Each scope triggers next scope at end of a 500 sample acquisition.
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set(sc, 'NumSamples', 500, 'TriggerSample', -1);

set(sc, 'TriggerMode', 'Scope');

sc(1).TriggerScope = 2;

sc(2).TriggerScope = 1;

% Initialize time and data log.

t = [];

data = zeros(0, 2);

% Start the scopes and the model.

start(sc);

start(tg);

% Start things off by triggering scope 1.

scNum = 1;

sc(scNum).trigger;

% Use the two scopes as a double buffer to log the data.

while (1)

% Wait until this scope has finished acquiring 500 samples

% or the model stops (scope is interrupted).

while ~(strcmp(sc(scNum).Status, 'Finished') || ...

strcmp(sc(scNum).Status, 'Interrupted')), end

% Stop buffering data when the model stops.

if strcmp(tg.Status, 'stopped')

break

end

% Save the data.

t( end + 1 : end + 500) = sc(scNum).Time;

data(end + 1 : end + 500, :) = sc(scNum).Data;

% Restart this scope.

start(sc(scNum));

% Switch to the next scope.

scNum = 3 - scNum;

end

% Remove the scopes we added.

remscope(tg,[1 2]);

% Plot the data.

plot(t,data); grid on; legend('Signal 0','Signal 1');
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File Systems
Simulink Real-Time file scopes create files on the target computer. To
work with these files from the host computer, you need to work with the
SimulinkRealTime.fileSystem object. The SimulinkRealTime.fileSystem
object allows you to perform file system-like operations on the target computer
file system.

You cannot direct the scope to write the data to a file on the Simulink
Real-Time host computer. Once the software has written the signal data file
to the target computer, you can access the contents of the file for plotting or
other inspection from the host computer. The software can write data files to

• The C:\ or D:\ drive of the target computer. This can be a serial ATA
(SATA) or parallel ATA (PATA)/Integrated Device Electronics (IDE) drive.
The Simulink Real-Time software supports file systems of type FAT-12,
FAT-16, or FAT-32. Verify that the hard drive is not cable-selected and
that the BIOS can detect it. The type of file system (FAT-12, FAT-16,
or FAT-32) limits the maximum size of the file. The target computer
file system uses the 8.3 file name convention. This means that a target
computer file name cannot exceed eight characters. Its file extension
cannot exceed 3 characters.

If you have a target computer with multiple partitions on a hard drive, the
Simulink Real-Time software file scope can access those partitions if they
are formatted with FAT-12, FAT-16, or FAT-32. It will ignore unsupported
file systems.

• A 3.5-inch disk drive.

• Disks connected to a secondary IDE controller. The software supports up to
four drives through the second IDE controller. By default, it works with
drives configured as the primary master. If you want to use a secondary
IDE controller, you must configure the Simulink Real-Time software for it
(see “Converting Simulink® Real-Time™ File Format Content to Double
Precision Data” on page 12-9). The software searches for another drive in
the first four ports of the target computer.

The largest single file that you can create is 4 GB.
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Note that writing data files to 3.5-inch disk drives is considerably slower
than writing to hard drives.

You can access signal data files, or other target computer system files, in one
of the following ways:

• If you are running the target computer as a standalone system, you can
access a file by rebooting the target computer under an operating system
such as DOS and accessing the file through the operating system utilities.

• If you are running the target computer in conjunction with a host computer,
you can access the target computer file system from the host computer by
representing it as a SimulinkRealTime.fileSystem object.

You can perform file transfer operations using the
functions SimulinkRealTime.copyFileToHost and
SimulinkRealTime.copyFileToTarget.

You can perform file system-like tasks using methods
such as SimulinkRealTime.fileSystem.fopen and
SimulinkRealTime.fileSystem.fread on the signal data file. File system
methods work like the corresponding MATLAB file I/O methods.

The SimulinkRealTime.fileSystem class also includes file system utilities
that allow you to collect target computer file system information for the disk
and disk buffers.

This topic focuses primarily on using the SimulinkRealTime.fileSystem
methods to work with target computer data files that you generate from a
real-time Scope of type file.

For an example of how to perform data logging with file scopes, see Data
Logging With a File Scope.
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Using SimulinkRealTime.fileSystem Objects

In this section...

“Overview” on page 12-4

“Copying a File from the Target Computer to the Host Computer” on page
12-5

“Copying a File from the Host Computer to the Target Computer” on page
12-6

“Accessing File Systems from a Specific Target Computer” on page 12-6

“Reading the Contents of a File on the Target Computer” on page 12-8

“Removing a File from the Target Computer” on page 12-10

“Getting a List of Open Files on the Target Computer” on page 12-11

“Getting Information about a File on the Target Computer” on page 12-12

“Getting Information about a Disk on the Target Computer” on page 12-13

Overview
The fs object enables you to work with the target computer file system from
the host computer. You enter target object methods in the MATLAB window
on the host computer or use scripts. The fs object has methods that allow
you to use

• SimulinkRealTime.fileSystem.cd to change folders

• SimulinkRealTime.fileSystem.dir to list the contents of the current
folder

• SimulinkRealTime.fileSystem.mkdir to make a folder

• SimulinkRealTime.fileSystem.pwd to get the current working folder path

• SimulinkRealTime.fileSystem.rmdir to remove a folder

• SimulinkRealTime.fileSystem.diskinfo to get information about the
specified disk

• SimulinkRealTime.fileSystem.fclose to close a file (similar to MATLAB
fclose)
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• SimulinkRealTime.fileSystem.fileinfo to get information about a
particular file

• SimulinkRealTime.fileSystem.filetable to get information about files
in the file system

• SimulinkRealTime.fileSystem.fopen to open a file (similar to MATLAB
fopen)

• SimulinkRealTime.fileSystem.fread to read a file (similar to MATLAB
fread)

• SimulinkRealTime.fileSystem.fwrite to write a file (similar to MATLAB
fwrite)

• SimulinkRealTime.fileSystem.getfilesize to get the size of a file in
bytes

• SimulinkRealTime.fileSystem.removefile to remove a file from the
target computer

Useful global functions:

• SimulinkRealTime.copyFileToHost to retrieve a file from the target
computer to the host computer

• SimulinkRealTime.copyFileToTarget to place a file from the host
computer to the target computer

• SimulinkRealTime.utils.getFileScopeData, to interpret the raw data
from the fread method

The procedures in this section assume that the target computer has a signal
data file created by an Simulink Real-Time file scope. This file has the
pathname C:\data.dat.

Copying a File from the Target Computer to the Host
Computer
You can copy a data file from the target computer to the host computer using
a SimulinkRealTime package function on the host computer.

For example, to retrieve a file named data.dat from the target computer
C:\ drive (default):
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1 If you have not already done so, in the MATLAB window, type the following
to assign the default SimulinkRealTime.target object to a variable.

tg=slrt;

2 Type

SimulinkRealTime.copyFileToHost(tg,'data.dat');

This retrieves the file and saves that file to the variable data. This content
is in the Simulink Real-Time file format.

Copying a File from the Host Computer to the Target
Computer
You can copy a file from the host computer to the target computer using a
SimulinkRealTime package function on the host computer.

For example, to copy a file named data2.dat from the host computer to the
target computer C:\ drive (default),

1 If you have not already done so, in the MATLAB window, type the following
to assign the default SimulinkRealTime.target object to a variable.

tg=slrt;

2 Type the following to save that file to the variable data.

SimulinkRealTime.copyFileToTarget(tg,'data2.dat');

Accessing File Systems from a Specific Target
Computer
You can access specific target computer files from the host computer for the
SimulinkRealTime.fileSystem object.

Use the SimulinkRealTime.fileSystem creator function. If your system has
multiple targets, you can access specific target computer files from the host
computer for the SimulinkRealTime.fileSystem object.

For example, to list the name of the current folder of a target computer
through a TCP/IP connection,
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1 In the MATLAB window, type a command like the following to assign the
SimulinkRealTime.fileSystem object to variable.

fsys=SimulinkRealTime.fileSystem('TCPIP','192.168.0.10','22222');

2 Type

fsys.dir;

Alternatively, you can use the SimulinkRealTime.target constructor to
first construct a target object, then use that target object as an argument
to SimulinkRealTime.fileSystem.

1 In the MATLAB window, type a command like the following to assign the
SimulinkRealTime.target object to a variable.

tg1=SimulinkRealTime.target('TCPIP','192.168.0.10','22222');

2 Type the following command to assign the SimulinkRealTime.fileSystem
object to a variable.

fsys=SimulinkRealTime.fileSystem(tg1);

3 Type

fsys.dir;

Alternatively, if you want to work with the file system of the default target
computer, you can use the SimulinkRealTime.fileSystem constructor
without arguments.

1 In the MATLAB window, type a command like the following to assign the
SimulinkRealTime.fileSystem object to a variable.

fsys=SimulinkRealTime.fileSystem;

The Simulink Real-Time software assigns the fsys variable to the default
target computer.

2 Type

fsys.dir;
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Reading the Contents of a File on the Target Computer
You can read the contents of a data file from the target computer by using
SimulinkRealTime.fileSystem methods on the host computer. This is an
alternate method to “Configure File Scopes Using MATLAB Language” on
page 5-103.

Use the method syntax to run an SimulinkRealTime.fileSystem object
method. The syntax method_name(fs_object, argument_list) can be
replaced with

fs_object.method_name(argument_list)

For example, to retrieve the contents of a file named data.dat from the target
computer C:\ drive (default),

1 If you have not already done so, in the MATLAB window, type the following
to assign the SimulinkRealTime.fileSystem object to a variable.

fsys=SimulinkRealTime.fileSystem;

2 Type

h=fsys.fopen('data.dat');

or

h=fopen(fsys,'data.dat');

This opens the file data.dat for reading and assigns the file identifier to h.

3 Type

data2=fsys.fread(h);

or

data2=fread(fsys,h);

This reads the file data.dat and stores the contents of the file to data2.
This content is in the Simulink Real-Time file format.

4 Type
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fsys.fclose(h);

This closes the file data.dat.

Before you can view or plot the contents of this file, you must convert the
contents. See “Converting Simulink® Real-Time™ File Format Content to
Double Precision Data” on page 12-9.

Converting Simulink Real-Time File Format Content to Double
Precision Data
The Simulink Real-Time software provides the function
SimulinkRealTime.utils.getFileScopeData to convert Simulink Real-Time
file format content (in bytes) to double precision data representing the signals
and timestamps. The SimulinkRealTime.utils.getFileScopeData function
takes in data from a file in Simulink Real-Time format. The data must be a
vector of bytes (uint8). To convert the data to uint8, use a command like
the following:

data2 = uint8(data2');

This section assumes that you have a variable, data2, that contains data in
the Simulink Real-Time file format (see “Reading the Contents of a File on
the Target Computer” on page 12-8):

1 In the MATLAB window, change folder to the folder that contains the
Simulink Real-Time format file.

2 Type

new_data2 = SimulinkRealTime.utils.getFileScopeData(data2);

SimulinkRealTime.utils.getFileScopeData converts the format of
data2 from the Simulink Real-Time file format to an array of bytes. It also
creates a structure for that file in new_data2, of which one of the elements
is an array of doubles, data. The data member is also appended with a
time stamp vector. The data is returned as doubles, which represent the
real-world values of the original Simulink signals at the specified times
during target execution.
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You can view or examine the signal data. You can also plot the data with
plot(new_data2.data).

If you are using the Simulink Real-Time software in StandAlone mode, you
can extract the data from the data file if you know the number of signals in
the scope and file header size. If you know these numbers, you can extract
the data. Note the following:

• First determine the file header size. To obtain the file header size, ignore
the first eight bytes of the file. The next four bytes store the header size as
an unsigned integer.

• After the header size number of bytes, the file stores the signals
sequentially as doubles. For example, assume the scope has three signals,
x, y, and z. Assume that x[0] is the value of x at sample 0, x[1] is the
value at sample 1, and so forth, and t[0], t[1] are the simulation time
values at samples 0, 1, and so forth, respectively. The file saves the data
using the following pattern:

x[0] y[0] z[0] t[0] x[1] y[1] z[1] t[1] x[2] y[2] z[2] t[2]...
x[N] y[N] z[N] t[N]

N is the number of samples acquired. The file saves x, y, z, and t as doubles
at 8 bytes each.

Removing a File from the Target Computer
You can remove a file from the target computer by using Simulink Real-Time
methods on the host computer for the SimulinkRealTime.fileSystem object.
If you have not already done so, close this file first with fclose.

Use the method syntax to run an SimulinkRealTime.fileSystem object
method. The syntax method_name(fs_object, argument_list) can be
replaced with

fs_object.method_name(argument_list)

For example, to remove a file named data2.dat from the target computer
C:\ drive (default),

1 If you have not already done so, in the MATLAB window, type the following
to assign the SimulinkRealTime.fileSystem object to a variable.
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fsys=SimulinkRealTime.fileSystem;

2 Type the following to remove the specified file from the target computer.

fsys.removefile('data2.dat');

or

removefile(fsys,'data2.dat');

Getting a List of Open Files on the Target Computer
You can get a list of open files on the target computer file system from the
host computer by using Simulink Real-Time methods on the host computer
for the SimulinkRealTime.fileSystem object. Do this to identify files you
can close. The target computer file system limits the number of open files
you can have to eight.

Use the method syntax to run an SimulinkRealTime.fileSystem object
method. The syntax method_name(fs_object, argument_list) can be
replaced with

fs_object.method_name(argument_list)

For example, to get a list of open files for the file system object fsys,

1 If you have not already done so, in the MATLAB window, type the following
to assign the SimulinkRealTime.fileSystem object to a variable.

fsys=SimulinkRealTime.fileSystem;

2 Type

fsys.filetable

If the file system has open files, a list like the following is displayed:

ans =
Index Handle Flags FilePos Name
------------------------------------------

0 00060000 R__ 8512 C:\DATA.DAT
1 00080001 R__ 0 C:\DATA1.DAT
2 000A0002 R__ 8512 C:\DATA2.DAT
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3 000C0003 R__ 8512 C:\DATA3.DAT
4 001E0001 R__ 0 C:\DATA4.DA

3 The table returns the open file handles in hexadecimal. To convert a
handle to one that other SimulinkRealTime.fileSystem methods, such as
fclose, can use, use the hex2dec function. For example,

h1 = hex2dec('001E0001'))
h1 =
1966081

4 To close that file, use the SimulinkRealTime.fileSystem fclose method.
For example,

fsys.fclose(h1);

Getting Information about a File on the Target
Computer
You can display information for a file on the target computer file system
from the host computer by using Simulink Real-Time methods on the host
computer for the SimulinkRealTime.fileSystem object.

Use the method syntax to run an SimulinkRealTime.fileSystem object
method. The syntax method_name(fs_object, argument_list) can be
replaced with

fs_object.method_name(argument_list)

For example, to display the information for the file identifier fid1,

1 If you have not already done so, in the MATLAB window, type the following
to assign the SimulinkRealTime.fileSystem object to a variable.

fsys=SimulinkRealTime.fileSystem;

2 Type

fid1=fsys.fopen('data.dat');

This opens the file data.dat for reading and assigns the file identifier
to fid1.
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3 Type

fsys.fileinfo(fid1);

This returns disk information like the following for the C:\ drive file
system.

ans =
FilePos: 0

AllocatedSize: 12288
ClusterChains: 1

VolumeSerialNumber: 1.0450e+009
FullName: 'C:\DATA.DAT'

Getting Information about a Disk on the Target
Computer
You can display information for a disk on the target computer file system
from the host computer by using Simulink Real-Time methods on the host
computer for the SimulinkRealTime.fileSystem object.

Use the method syntax to run an SimulinkRealTime.fileSystem object
method. The syntax method_name(fs_object, argument_list) can be
replaced with

fs_object.method_name(argument_list)

For example, to display the disk information for the C:\ drive,

1 If you have not already done so, in the MATLAB window, type the following
to assign the SimulinkRealTime.fileSystem object to a variable.

fsys=SimulinkRealTime.fileSystem;

2 Type

fsys.diskinfo('C:\');

This returns disk information like the following for the C:\ drive file
system.

ans =
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Label: 'SYSTEM '
DriveLetter: 'C'

Reserved: ''
SerialNumber: 1.0294e+009

FirstPhysicalSector: 63
FATType: 32

FATCount: 2
MaxDirEntries: 0

BytesPerSector: 512
SectorsPerCluster: 4

TotalClusters: 2040293
BadClusters: 0

FreeClusters: 1007937
Files: 19968

FileChains: 22480
FreeChains: 1300

LargestFreeChain: 64349
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Troubleshooting

Refer to these guidelines, hints, and tips for questions or issues you
might have about your installation of the Simulink Real-Time
product. For more specific troubleshooting solutions, go to
the MathWorks® Support Simulink Real-Time Web site
(http://www.mathworks.com/support/search_results.html?q=product:"Simul
for specific troubleshooting solutions.

• Chapter 13, “Getting Started with Troubleshooting”

• Chapter 14, “Confidence Test Failures”

• Chapter 15, “Host Computer Configuration”

• Chapter 16, “Target Computer Configuration”

• Chapter 17, “Host-Target Communication”

• Chapter 18, “Target Computer Start Process”

• Chapter 19, “Modeling”

• Chapter 20, “Model Compilation”

• Chapter 21, “Application Download”

• Chapter 22, “Application Execution”

• Chapter 23, “Application Parameters”

• Chapter 24, “Application Signals”

• Chapter 25, “Application Performance”

• Chapter 26, “Getting MathWorks Support”

http://www.mathworks.com/support/search_results.html?q=product:"Simulink+Real-Time"




13

Getting Started with
Troubleshooting



13 Getting Started with Troubleshooting

Troubleshooting Procedure
An Simulink Real-Time installation can sometimes fail. Causes include
hardware failures, changes in underlying system software, and procedural
errors. Follow this procedure to address these problems:

1 Run the confidence test (see “Run Confidence Test on Configuration”).

Tip Run the confidence test as the first step in troubleshooting, as well as in
validating your initial product installation and configuration.

2 If one or more tests fail, see the following information about the specific
failure:

• “Test 1: Ping Using System Ping” on page 14-2

• “Test 2: Ping Using slrtpingtarget” on page 14-5

• “Test 3: Reboot Target Computer” on page 14-7

• “Test 4: Build and Download xpcosc” on page 14-9

• “Test 5: Check Host-Target Communications” on page 14-12

• “Test 6: Download Prebuilt Target Application” on page 14-14

• “Test 7: Execute Target Application” on page 14-15

• “Test 8: Upload Data and Compare” on page 14-16

3 Check the categorized questions and answers for clues to the root cause of
the problem.

4 If the tests run, but task execution time is slow or the CPU overloads, see the
questions and answers for Application Performance.

5 Check the MathWorks Support web site and MATLAB Central for tips. See
“Where Is the MathWorks Support Web Site?” on page 26-2.

6 Call MathWorks Technical Support. See “How Do I Contact MathWorks
Technical Support?” on page 26-5.
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Confidence Test Failures

This topic describes guidelines, hints, and tips for questions or issues you
might have while using the Simulink Real-Time product. Refer
to the MathWorks Support Simulink Real-Time Web site
(http://www.mathworks.com/support/search_results.html?q=product:"Simulink+Real-Time")
for specific troubleshooting solutions. The Simulink Real-Time
documentation is also available from this site.

• “Test 1: Ping Using System Ping” on page 14-2

• “Test 2: Ping Using slrtpingtarget” on page 14-5

• “Test 3: Reboot Target Computer” on page 14-7

• “Test 4: Build and Download xpcosc” on page 14-9

• “Test 5: Check Host-Target Communications” on page 14-12

• “Test 6: Download Prebuilt Target Application” on page 14-14

• “Test 7: Execute Target Application” on page 14-15

• “Test 8: Upload Data and Compare” on page 14-16

http://www.mathworks.com/support/search_results.html?q=product:"Simulink+Real-Time"
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Test 1: Ping Using System Ping
If you are using a network connection, this test is a standard system ping to
your target computer.

Note The confidence test skips test 1 for serial connections.

Troubleshoot failures with the following procedure:

1 Open a DOS shell and type the IP address of the target computer:

ping xxx.xxx.xxx.xxx

Check the messages on your screen.

If DOS displays a message similar to the following, system ping succeeds
even though test 1 fails.

Pinging xxx.xxx.xxx.xxx with 32 bytes of data:
Reply from xxx.xxx.xxx.xxx: bytes-32 time<10 ms TTL=59

If the DOS shell displays the following message, the system ping command
failed.

Pinging xxx.xxx.xxx.xxx with 32 byte of data:
Request timed out.

2 Ping succeeds — Ethernet addresses OK?

If ping succeeds, check whether you entered the required IP and gateway
addresses in Simulink Real-Time Explorer:

a Type slrtexplr in the MATLAB Command Window.

b In the Targets pane, expand the target computer node.

c Click the Target Properties icon in the toolbar or double-click
Properties.

d Select Host-to-Target communication.

14-2



Test 1: Ping Using System Ping

e Verify that IP address, Subnet mask, and Gateway boxes contain
the required values.

f Select Boot configuration.

g Click Create boot disk.

h Reboot the target computer with the new kernel.

3 Ping fails — Cables OK?

If ping fails, first check your network cables. You might have a faulty
network cable or, if you are using a coaxial cable, the terminators might
be missing.

4 Ping fails — Simulink Real-Time properties OK?

Check that you have entered the required properties in Simulink Real-Time
Explorer:

a Type slrtexplr in the MATLAB Command Window.

b In the Targets pane, expand the target computer node.

c Click the Target Properties icon in the toolbar or double-click
Properties.

d Select Host-to-Target communication.

e Verify that IP address, Subnet mask, and Gateway boxes contain
the required values.

f Verify that the bus settings match those of the target computer:

• For a PCI computer: check that Bus type is set to PCI instead of ISA.

• For an ISA computer:

– Check that Bus type is set to ISA instead of PCI.

– Check that Address is set to the required I/O port base address and
that the address does not conflict with that of another hardware
resource.

– Check that IRQ is set to the required IRQ line and that the IRQ
line does not conflict with that of another hardware resource.
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– If the target computer motherboard contains a PCI chip set, check
whether the target computer BIOS reserves the IRQ line used by
the ISA bus Ethernet card.

g Select Boot configuration.

h Click Create boot disk.

i Reboot the target computer with the new kernel.

5 Ping fails — Ethernet hardware operating?

Verify that your hardware is operating. For example, check that the green
“ready” light goes on when the cable is connected to the Ethernet card.

6 Ping fails — Ethernet card supported?

Verify that you are using a supported Ethernet card on the target
computer. See “Ethernet Communication Setup” for further details,
including supplied Ethernet cards.

7 Ping fails — Not a locally mounted folder?

Run slrttest from a locally mounted folder, such as Z:\work, rather than
from a UNC network folder, such as \\Server\user\work.

8 If these steps do not solve your problem, check the questions and answers
for Host-Target Communication and section “Faulty BIOS Settings on
Target Computer” on page 16-2.

9 If you still cannot solve your problem, see “How Do I Contact MathWorks
Technical Support?” on page 26-5.
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Test 2: Ping Using slrtpingtarget

This test is an Simulink Real-Time ping to your target computer. Troubleshoot
failures with the following procedure:

1 In the MATLAB Command Window, type

tg=SimulinkRealTime.target('argument-list')

where argument-list is the connection information that indicates which
target computer you are working with. If you do not specify arguments,
the software assumes that you are communicating with the default target
computer.

Check the messages in the MATLAB Command Window.

MATLAB should respond with the following messages:

Simulink Real-Time Object
Connected = Yes
Application = loader

2 Not connected — Bad target boot kernel?

If you do not get the preceding messages, you could have a bad target boot
kernel. To solve this problem, create a new target boot kernel and reboot
the target computer with the new kernel. See “Target Boot Methods”.

3 Not connected — Environment variables set?

Use Simulink Real-Time Explorer to check the environment variables, in
particular the target computer IP address. If test 1 passes but test 2 fails,
you might not have entered the required IP address.

4 Not connected — Ethernet card supported?

If you are using a TCP/IP connection, make sure you are using a supported
Ethernet card (see “Test 1: Ping Using System Ping” on page 14-2).

5 Not connected — RS-232 configuration?

If you are using an RS-232 connection, check the following:
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• Verify that you are using a null modem cable (see “RS-232 Hardware”).

• Verify that the COM ports on the host and target computers are enabled
in the BIOS. If they are disabled, test 2 fails.

• Verify that the specified COM port is connected on each computer.

• Verify that the COM port being used matches the port specified in the
target computer configuration.

Note RS-232 host-target communication mode will be removed in a future
release. Use TCP/IP instead.

6 If these steps do not solve your problem, check the questions and answers
for Host-Target Communication and section “Faulty BIOS Settings on
Target Computer” on page 16-2.

7 If you still cannot solve your problem, see “How Do I Contact MathWorks
Technical Support?” on page 26-5.
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Test 3: Reboot Target Computer
This test tries to boot your target computer using an Simulink Real-Time
command.

Note This procedure assumes that you have set environment settings
with Simulink Real-Time Explorer. See “RS-232 Communication Setup” or
“Ethernet Communication Setup”.

Troubleshoot failures with the following procedure:

1 In the MATLAB Command Window, type

slrttest('-noreboot')

This command reruns the test without using the
SimulinkRealTime.target.reboot command and displays the message

### Test 3, Software reboot the target PC: ... SKIPPED

2 Build Succeeded — Software reboot supported?

Check the results of Test 4, Build and download a Simulink
Real-Time application using model xpcosc. If slrttest skips the
SimulinkRealTime.target.reboot command but builds and loads the
target application without producing an error message, the problem could
be that the target computer does not support the Simulink Real-Time
reboot command. In this case, you need to reboot using a hardware reset
button.

3 Build Failed — Kernel not loaded?

If you saw the following error, the kernel might not be loaded when the
host computer initiates communication with the target computer.

ReadFile Error: 6

Older Simulink Real-Time releases might receive this error. As a
workaround, run slrttest with the noreboot option. For example,
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slrttest('-noreboot')

This command runs the test without trying to reboot the target computer.
It displays the following message:

### Test 3, Software reboot the target PC: ... SKIPPED

4 Build Failed — Example model modified?

If you directly or indirectly modify the xpcosc example model supplied with
the product, test 3 is likely to fail.

Note Do not modify the files installed with the Simulink Real-Time
software. If you want to modify one of these files, copy the file and modify
the copy.

Restore the xpcosc example model to its original state by one of the
following methods:

• Recreate the original model by editing it in the following location:

matlabroot\toolbox\rtw\targets\xpc\xpcdemos

• Reinstall the software.

5 If these steps do not solve your problem, check the questions and answers
for-Target Computer Boot Process and section “Faulty BIOS Settings on
Target Computer” on page 16-2.

6 If you still cannot solve your problem, see “How Do I Contact MathWorks
Technical Support?” on page 26-5.
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Test 4: Build and Download xpcosc

This test tries to build and download the model xpcosc. Troubleshoot failures
with the following procedure:

1 In the MATLAB Command Window, check the error messages.

These messages help you locate where there is a problem.

2 Build Failed — Loader not ready?

If you get the following error message, reboot your target computer:

Simulink real-Time loader not ready

This error message is sometimes displayed even if the target screen shows
that the loader is ready.

3 Build Failed — Using full duplex?

If the communication between the host computer and target computer is
TCP/IP, set the host computer network interface card (NIC) card and hub
to half-duplex mode. Do not set the mode to full-duplex mode.

4 Build Failed — Compiler not supported?

Verify that a supported compiler is being used and that the blocks in the
model can be compiled with the given compiler and compiler version.

5 Build Failed — Compiler path?

All Microsoft Visual compiler components must be in the Microsoft Visual
Studio folder after installation. If the compiler is not installed at the
required location, you might get one of the following errors:

Error executing build command: Error using ==> make_rtw
Error using ==> rtw_c (SetupForVisual)
Invalid DEVSTUDIO path specified
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or

Error executing build command: Error using ==> make_rtw
Error using ==> rtw_c
Errors encountered while building model "xpcosc"

along with the following MATLAB Command Window error:

NMAKE: fatal error U1064: MAKEFILE not found and no target
specified
Stop.

Verify your compiler setup:

a In the MATLAB command window, type:

slrtsetCC('setup')

This function queries the host computer for C compilers that the
Simulink Real-Time environment supports. It returns output like the
following:

Select your compiler for Simulinke Real-Time.

[1] Microsoft Visual C++ Compilers 2008 Professional Edition (SP1) in

c:\Program Files (x86)\Microsoft Visual Studio 9.0

[2] Microsoft Visual C++ Compilers 2010 Professional in

C:\Program Files (x86)\Microsoft Visual Studio 10.0

[0] None

Compiler:

b At the Compiler prompt, enter the number for the compiler that you
want to use. For example, 2.

The function verifies your selection:

Verify your selection:

Compiler: Microsoft Visual C++ Compilers 2010 Professional
Location: C:\Program Files (x86)\Microsoft Visual Studio 10.0
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Are these correct [y]/n?

c Type y or press Enter to verify the selection.

The function finishes the dialog.

Done...

6 Build Failed — COM port read failed?

If you see the following MATLAB Command Window error:

ReadFile failed while reading from COM-port

• Check the state of your target computer. If it is unresponsive, you might
need to reboot the target computer.

• In Simulink Real-Time Explorer, try to connect to the target computer
again. Be sure to also check the connection between the host computer
and target computer.

7 If these steps do not solve your problem, check the questions and
answers for Model Compilation, Application Download, and Host-Target
Communication and section “Faulty BIOS Settings on Target Computer”
on page 16-2.

8 If you still cannot solve your problem, see “How Do I Contact MathWorks
Technical Support?” on page 26-5.
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Test 5: Check Host-Target Communications
This error occurs only when the environment variable settings are out of date.
Troubleshoot failures with the following procedure:

1 Type slrtexplr in the MATLAB Command Window.

2 In the Targets pane, expand the target computer node.

3 Click the Target Properties icon in the toolbar or double-click
Properties.

4 Select Host-to-Target communication and make the required changes
to the communication properties.

Note RS-232 host-target communication mode will be removed in a future
release. Use TCP/IP instead.

5 Select Boot configuration.

6 Set the required Boot mode.

Tip If you have Simulink Real-Time standalone mode installed, verify that
you have selected Boot modeStand Alone.

For information on boot options, see “Target Boot Methods”.

7 Click Create boot disk

8 Reboot the target computer.

9 Rerun slrttest.

10 If these steps do not resolve the issue, recreate the target boot kernel
using SimulinkRealTime.createBootImage, reboot the target computer,
and rerun slrttest.
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11 If these steps do not solve your problem, check the questions and answers
for Host-Target Communication and section “Faulty BIOS Settings on
Target Computer” on page 16-2.

12 If you still cannot solve your problem, see “How Do I Contact MathWorks
Technical Support?” on page 26-5.
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Test 6: Download Prebuilt Target Application
This test runs the basic target object constructor, slrt. This error rarely
occurs unless an earlier test has failed.

1 Verify that the preceding steps completed without producing an error
message.

2 Configure, build and download the tutorial model and record whatever
error messages appear (see “Build and Download Target Application”).

3 If these steps do not solve your problem, check the questions and answers
for Application Download and Host-Target Communication and section
“Faulty BIOS Settings on Target Computer” on page 16-2.

4 If you still cannot solve your problem, see “How Do I Contact MathWorks
Technical Support?” on page 26-5.
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Test 7: Execute Target Application
This test executes a target application (xpcosc) on the target computer. This
test fails if you change the xpcosc model start time to something other than
0, such as 0.001. This change causes the test, and the MATLAB interface, to
halt. To address this failure:

1 Set the xpcosc model start time back to 0.

2 Rerun the test.

3 If these steps do not solve your problem, check the questions and answers
for Application Execution, Application Performance, Application Signals,
and Application Parameters and section “Faulty BIOS Settings on Target
Computer” on page 16-2.

4 If you still cannot solve your problem, see “How Do I Contact MathWorks
Technical Support?” on page 26-5.
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Test 8: Upload Data and Compare
This test executes a target application (xpcosc) on the target computer. This
test might fail if you change the xpcosc model (for example, if you remove
the Outport block).

Note Do not modify the files installed with the Simulink Real-Time software.
If you want to modify one of these files, copy the file and modify the copy.

1 To eliminate this problem, restore the xpcosc example model to its original
state by one of the following methods:

• Recreate the original model by editing it in the following location:

matlabroot\toolbox\rtw\targets\xpc\xpcdemos

• Reinstall the software.

2 Other issues might also cause this test to fail. If you still need more help,
check the following:

• If you are running a new Simulink Real-Time release, be sure that you
have a new target boot kernel for this release. See “What Should I Do
After Updating Software?” on page 26-4.

• There is a known issue with Simulink Real-Time software version
1.3. It might occur when you run slrttest two consecutive
times. See the known issue and solution documented in
http://www.mathworks.com/support/solutions/data/1-18DTB.html.

3 If you are installing another version of the Simulink Real-Time software
on top of an existing version, check the version number of the current
installation. At the MATLAB command line, type slrtlib. The version
number appears at the bottom of the Simulink Real-Time block library
window. If the version number is not the one to which you want to upgrade,
reinstall the software.

4 If these steps do not solve your problem, check the questions and answers
for Application Execution, Application Performance, Application Signals,
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and Application Parameters and section “Faulty BIOS Settings on Target
Computer” on page 16-2.

5 If you still cannot solve your problem, see “How Do I Contact MathWorks
Technical Support?” on page 26-5.
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Why Does Boot Drive Creation Halt?
If your host computer MATLAB interface halts while creating an Simulink
Real-Time boot disk or network boot image:

• Use another drive to create a new Simulink Real-Time boot drive or
network boot image.

• If your host computer has antivirus software, it might conflict with the
MATLAB software. Disable the software while using the MATLAB
interface.

• Verify that the host computer drive is accessible. If it is not accessible,
replace the drive.
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• “Faulty BIOS Settings on Target Computer” on page 16-2

• “Allowable Partitions on the Target Hard Drive” on page 16-3

• “File System Disabled on the Target Computer” on page 16-4

• “Adjust the Target Computer Stack Size” on page 16-5

• “Where to Find PCI Board Information” on page 16-6

• “How to Diagnose My Board Driver” on page 16-7
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Faulty BIOS Settings on Target Computer
The BIOS settings of a computer system influence how the computer works. If
you experience problems using the Simulink Real-Time software, check the
system BIOS settings of the target computer. These settings are beyond the
control of the Simulink Real-Time product. See “BIOS Settings”.

Faulty BIOS settings can cause issues like the following:

• Why is my target not booting?

• Why can SimulinkRealTime.targetgetPCIInfo detect PCI boards, but
autosearch -l cannot?

• Why can my standalone application run on some target computers, but
not others?

• Why is my target computer crashing while downloading applications?

• Why is my target PC104 hanging on boot?

• Why is my boot time slow?

• Why is my target application not running as a real-time application?

• Why are my USB ports not working?
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Allowable Partitions on the Target Hard Drive
The target computer hard drive can contain one or multiple partitions.
However, the Simulink Real-Time software supports file systems of type
FAT-12, FAT-16, or FAT-32 only.
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File System Disabled on the Target Computer
If your target computer does not have a FAT hard disk, the monitor on the
target computer displays the following error:

ERROR -4: drive not found
No accessible disk found: file system disabled

If you do not want to access the target computer file system, you can ignore
this message. If you want to access the target computer file system, add a
FAT hard disk to the target computer system and reboot.

Tip Verify that the hard drive is not cable-selected and that the BIOS can
detect it.
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Adjust the Target Computer Stack Size
To discover and adjust the stack size used by the real-time threads on the
target computer:

1 Add the following blocks to your model:

• Current Available Stack Size — Outputs the number of bytes of stack
memory currently available to the target application thread.

• Minimum Available Stack Size — Outputs the number of bytes that
have not been used in the stack since the thread was created.

The block traverses the entire stack at every time step to find and report
unused bytes. Get Minimal Free Stack Size should be used only for
diagnostic purposes.

2 Execute the target application, monitoring the stack size and minimal
stack size.

3 Calculate a stack size that allows execution to proceed.

Note

• To meet the memory requirements, you might have to reconfigure your
target computer.

• The Simulink Real-Time kernel can use only 2 GB of memory.

4 Adjust the stack size of the real-time threads by setting a TLC option
parameter.

For example, to set the stack size for target application xpcosc to 256
kBytes, type the following in the MATLAB Command Window:

set_param('xpcosc','TLCOptions','-axPCModelStackSizeKB=256')
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Where to Find PCI Board Information
Information about the PCI devices in your target computer is useful if you
want to determine what PCI boards are installed in your Simulink Real-Time
system, or if you have multiple boards of a particular type in your system.
Before you start, determine what boards are installed in your target computer
by typing the following in the MATLAB Command Window:

tg = slrt;
tg.getPCIInfo('all')

If you have or want to use multiple boards of a particular type in your
system, verify that the I/O driver supports multiple boards. See the
“Multiple board support” entry for this board type in the Simulink
Real-Time library or the Simulink Real-Time Interactive Hardware Selection
Guide (http://www.mathworks.com/support/product/XP/productnews
/interactive_guide/xPC_Target_Interactive_Guide.html.

If you confirm that the board type supports multiple boards, and these boards
are installed in the Simulink Real-Time system, do the following to obtain the
bus and slot information for these boards:

1 In the PCI devices display, note the contents of the Bus and Slot columns
of the PCI devices in which you are interested.

2 Enter the bus and slot numbers as vectors into the PCI Slot parameter of
the PCI device. For example:

[1 9]

where 1 is the bus number and 9 is the slot number.

For additional information about PCI bus I/O devices, refer to “PCI Bus I/O
Devices”.
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How to Diagnose My Board Driver
If you encounter issues using the Simulink Real-Time I/O drivers:

1 Display the input/output behavior of the board using an external instrument,
such as an oscilloscope or logic analyzer.

2 Verify that you have configured the I/O board driver according to the
manufacturer’s data sheet.

3 Verify that you are using the latest version of the I/O board driver and of
the Simulink Real-Time software. See “How Do I Get a Software Update?”
on page 26-3.

4 Verify that the behavior persists when you run the target application on a
different target computer.

5 Verify that the behavior persists when you install another instance of the I/O
board in the target computer.

6 Download the manufacturer’s I/O driver and diagnostic software from the
manufacturer web site, install the driver and software on your computer, and
test the hardware using the manufacturer’s software.

7 Report the issue to MathWorks Support at
http://www.mathworks.com/support/contact_us/index.html.
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17 Host-Target Communication

Is There Communication Between the Computers?
Use the following MATLAB commands from the host computer to validate
the host/target setup:

• slrtpingtarget

The slrtpingtarget command performs a basic communication check
between the host and target computers. This command returns success
only if the Simulink Real-Time kernel is loaded and running and the
host and target computer are communicating. Use this command for a
quick check of the communication between the host computer and target
computer.

• slrttest

The slrttest command performs a series of tests on your Simulink
Real-Time system. These tests range from performing a basic
communication check to building and running target applications. At the
end of each test, the command returns an OK or failure message. If the test
is inappropriate for your setup, the command returns a SKIPPED message.
Use this command for a thorough check of your Simulink Real-Time
installation.

Communication errors might also occur in the following instances:

• The target computer is running an old Simulink Real-Time boot kernel that
is not in sync with the Simulink Real-Time release installed on the host
computer. Create a new target boot kernel for each new release.

• If the communication between the host computer and target computer is
TCP/IP, set the host computer network interface card (NIC) card and hub
to half-duplex mode. Do not set the mode to full-duplex mode.

• If you have an active firewall in your system, you might experience
communication errors. For example, build errors might occur if you try to
build and download a model with a thermocouple board (causing a slower
initialization time) in a system that contains a firewall. To work around
this issue, you can add the MATLAB interface to the firewall exception list.
See also “Boards with Slow Initialization” on page 17-4

• To diagnose BIOS problems, see:
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- “Faulty BIOS Settings on Target Computer” on page 16-2

- “BIOS Settings”

• If multiple Ethernet cards or chips are installed in the target computer, see
“Timeout with Multiple Ethernet Cards” on page 17-6.
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Boards with Slow Initialization
Some Simulink Real-Time boards take a long time to initialize. This situation
might cause the software to run out of time before a model downloads, causing
the host computer to disconnect from the target computer.

By default, if the host computer does not get a response from the target
computer after downloading a target application and waiting 5 seconds, the
host computer software times out. The target computer responds only after
downloading and initializing the target application.

Usually 5 seconds is enough time to initialize a target application, but in
some cases it might not be long enough. The time to download a target
application mostly depends on your I/O hardware. For example, thermocouple
hardware (such as the PCI-DAS-TC board) takes longer to initialize. With
slower hardware, you might also get errors when building and downloading
an associated model. Even though the target computer is fine, a false timeout
is reported and you might get an error like the following:

"cannot connect to ping socket"

This is not a fatal error. You can reestablish communication with the
following procedure:

1 Type slrtpingtarget at the MATLAB command prompt.

2 Wait for the system to return from the slrtpingtarget command. If
slrtpingtarget finds a working connection between the host computer
and target computer, the response is something like:

ans =

success

3 Restart the target object.

Alternatively, you can increase the timeout value, using the following
procedure:

1 In your Simulink model, select Simulation > Model Configuration
Parameters, and navigate to the Simulink Real-Time Options node.
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2 Clear the Use default communication timeout parameter.

The Specify the communication timeout in seconds parameter
appears.

3 Specify a new timeout value, in seconds. For example, enter 20 in
parameter Specify the communication timeout in seconds.

4 Click OK.

5 In the Simulink Editor window and from the Code menu, click C/C++
Code > Build Model.

In this case, the host computer waits for about 20 seconds before declaring
that a timeout has occurred. It does not take 20 seconds for every download.
The host computer polls the target computer about once every second, and
if a response is returned, returns the success value. Only in the case where
a download really fails does it take the full 20 seconds.
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Timeout with Multiple Ethernet Cards
The Simulink Real-Time product supports a number of Ethernet cards and
chips, as described in “Ethernet Communication Setup”. If your target
computer has more than one of these cards or chips installed, you could
experience timeout problems. For example, suppose you are using the
Network Boot option to boot the target computer. If the host computer boots
the target computer using Ethernet A on the target computer, it associates
the IP address of the target computer with the Media Access Control (MAC)
address of Ethernet adapter A. If, after it does so, the target computer BIOS
connects the target computer to Ethernet B, the Simulink Real-Time software
cannot connect the host and target computers because they are connected to
different Ethernet controllers.

First, try to disable or remove the Ethernet controller that you will not use.
For example, if you have both an on-board Ethernet controller and a separate
Ethernet card, you could disable the on-board Ethernet controller through the
target computer BIOS. If you are required to have multiple Ethernet adapters
of the same type in the target computer, you might need to experiment to
determine which Ethernet adapter the software has chosen.

If you are not using the Network Boot option to boot the target computer
and cannot establish communication between the target computer and host
computer:

1 Switch the network cable to the other Ethernet port and try again.

2 If you can establish communication, use this Ethernet port to connect the
host computer to the target computer.

If you are using the Network Boot option and experience this issue, do the
following:

1 Connect the network cable to Ethernet adapter B.

2 In the MATLAB Command Window, type

!arp -d
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This command removes the association between the target computer address
and the hardware address of Ethernet adapter A from the cache of the host
computer. This removal allows a new connection (and association) to be made.

3 Change the Ethernet adapter card that the Network Boot option uses. You
can do this in one of the following ways:

• Change the target computer BIOS to change the Ethernet adapter to the
one that the Network Boot option is looking for.

• Follow the procedure “Ethernet Card Selection by Index” on page 4-26..
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Recovery from Board Driver Errors
If an error in a driver causes the Simulink Real-Time system to crash, a
timeout occurs and slrtpingtarget fails with an error message. In such an
event, you need to reboot the target and reestablish communication between
the host computer and target computer.

To get the Simulink Real-Time system back up and running:

1 Remove the reference to the problem driver from the model.

2 Reboot the target computer.

3 At the MATLAB command line, issue slrtpingtarget to reestablish
communications.

4 If the driver with which you are having problems is one provided by
MathWorks, try to pinpoint the problem area (for example, determine
whether certain settings in the driver block cause problems).

Alternatively, you can exit and restart the MATLAB interface.
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How Can I Diagnose Network Problems?
If you experience network problems when using this product,
use an available computer with Internet access to refer to
the MathWorks Support Simulink Real-Time Web site
(http://www.mathworks.com/support/search_results.html?q=product:"Simulink+Re
This Web site has the most up-to-date information about this topic.
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18 Target Computer Start Process

Why Won’t the Target Computer Start?
If your target computer cannot start with the Simulink Real-Time boot disk,
removable boot drive, or network boot image:

• Recreate the target boot kernel using new media.

• Verify using SimulinkRealTime.getTargetSettings that the current
properties in the Simulink Real-Time kernel correspond with the
environment variables displayed in the Host-to-Target communication
and Target settings panes of Simulink Real-Time Explorer.

Tip To display the current values of Simulink Real-Time
environment properties for the default target computer, type
SimulinkRealTime.getTargetSettings without arguments. To display
their allowed values, type:

tgs = SimulinkRealTime.getTargetSettings;
tgs.set

• Verify that the Simulink Real-Time boot disk or removable boot drive
contains files like the following:

- BOOTSECT.RTT

- XPCTGB1.RTA

Note The name of the last file varies depending on the communication
method.

• If the .RTT and .RTA files are not complete, reinstall the software.

• The Simulink Real-Time kernel may not be able to discover system
hardware not compliant with the Advanced Configuration and Power
Interface (ACPI) standard. To allow the kernel to discover such hardware,
use the following Simulink Real-Time environment property to access the
legacy MPFPS in the computer BIOS:
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slrtSetTargetSettings('LegacyMultiCoreConfig', 'on')

• If you are doing a network boot and the procedure displays a message
similar to TFTP Timeout:

- Verify that the xpctftpserver program is running. If it is not, recreate
the network boot image.

- Temporarily disable the Internet security (firewall) software on the host
computer. If you can now start:

• Follow the Internet security software instructions to allow the start
procedure to work in its presence. For example, add the MATLAB
interface to the firewall exception list.

• Reenable the Internet security software.

• If problems persist, see the questions and answers for Target Computer
Start Process.

• If you still cannot start the target computer from a boot disk or removable
boot drive, you might need to replace the target computer disk drive
hardware.
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Why Won’t the Kernel Load?
When starting the target computer, you might see a message like the
following:

Simulink Real-Time 4.X loading kernel..@@@@@@@@@@@@@@@@@@@@@@

The target computer displays this message when it cannot read and load
the kernel from the target boot disk.

The probable cause is a bad boot kernel. To diagnose this problem, recreate
the target boot kernel. If you have a removable boot drive, reformat the drive
or use a new formatted drive. If you have a boot CD, create a new boot disk. If
you are using network boot, recreate the network boot image.
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Why Is the Target Medium Not Bootable?
When starting the target computer, you might get a message similar to the
following:

Not a bootable medium or NTLDR is missing

Selecting either DOS Loader or Stand Alone mode instead of Removable
Disk mode can cause this message.

To solve this problem:

1 Type slrtexplr in the MATLAB Command Window.

2 In the Targets pane, expand the target computer node.

3 Click the Target Properties icon in the toolbar or double-click
Properties.

4 Select Boot configuration and select the desired entry in the Boot mode
list.

5 Click Create boot disk..

18-5



18 Target Computer Start Process

Why Is the Target Computer Halted?
If your target computer displays a System Halted message while starting:

• Verify in the Host-to-Target communication pane of Simulink
Real-Time Explorer that the Target driver parameter is configured as
required by your network.

• Recreate the target boot kernel using new media and use the new kernel
to boot the target computer.

• Verify that the Simulink Real-Time software supports your target computer
hardware. Be sure to verify the network communication hardware.

18-6



19

Modeling

• “How Do I Handle Encoder Register Rollover?” on page 19-2

• “How Can I Write Custom Device Drivers?” on page 19-3



19 Modeling

How Do I Handle Encoder Register Rollover?
Encoder boards have a fixed size counter register of 16 bits, 24 bits, or 32
bits. Regardless of the size, the register eventually overflows and rolls over.
Registers can roll over in either the positive or negative direction.

Some boards provide a hardware mechanism to account for overflows or
rollovers. As a best practice, you should design your model to deal with
overflows or rollovers. Defining an initial count can handle the issue for some
applications.

To handle register rollovers, you can use standard Simulink blocks to design
the following counter algorithm types:

• Rollover Counter — Counts the number of times the output of an encoder
block has rolled over. This counter should count up for positive direction
rollovers and down for negative direction rollovers.

• Extended Counter — Provides a rollover count not limited by register size.
For an n-bit register, this counter should be able to count values greater
than 2^(n-1).

The Incremental Encoder/Utilities/Rollover sublibrary of the Simulink
Real-Time library contains example blocks for these two types of counters.
See Rollover Counter and Extended Counter for further details. You can use
these blocks in your model as is, or modify them for your model. Connect the
output of the encoder block to these blocks.

Note To view the algorithms used in these implementations, right-click the
subsystem and select Mask > Look Under Mask.

Keep the following requirements in mind when using these blocks:

• Some driver blocks allow an initial starting value to be loaded into the
register. You must pass this value to the rollover blocks to adjust for
that offset.

• The rollover block needs to know how many counts each rollover represents.
Typically, this number is 2^n, where n is the size of the register in bits.
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How Can I Write Custom Device Drivers?
You might want to write your own driver if you want to include an
unsupported device driver in your Simulink Real-Time system. See “Custom
I/O Drivers”.

Before you consider writing custom device drivers for the Simulink Real-Time
system, you should possess:

• Good C programming skills

• Knowledge of writing S-functions and compiling those functions as C-MEX
functions

• Knowledge of SimStruct, a MATLAB Simulink C language header file that
defines the Simulink data structure and the SimStruct access macros. It
encapsulates the data required by the model or S-function, including block
parameters and outputs.

• An excellent understanding of the I/O hardware. Because of the real-time
nature of the Simulink Real-Time system, you must develop drivers
with minimal latency. Because most drivers access the I/O hardware at
the lowest possible level (register programming), you must have a good
understanding of how to control a board with register information and have
access to the register-level programming manual for the device.

• A good knowledge of port and memory I/O access over various buses. You
need this information to access I/O hardware at the register level.
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Requirements for Standalone Target Applications
You can use either the Simulink Real-Time API dynamic link library (DLL) or
the Simulink Real-Time component object model (COM) API library to create
a custom standalone interface to control a real-time application running on
the target computer. To deploy these standalone applications, you must have
the Simulink Real-Time standalone mode license. Without this license, you
can create and use the standalone application in your environment, but you
cannot deploy that application on another host computer that does not contain
your licensed copy of the Simulink Real-Time software.

See “Standalone Boot Method”.
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Compiler Errors from Models Linked to DLLs
The Simulink Real-Time software supports links to static link libraries (.lib)
only, not links to dynamic link libraries (.dll). When you compile your models,
verify that you link only to static link libraries. Linking to static libraries is
not an issue when you compile with Simulink Real-Time S-functions.

20-3



20 Model Compilation

Compilation Failure with WATCOM Compilers
The Open WATCOM compiler is no longer supported. Use a Microsoft
compiler instead.
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Why Does My Download Time Out?
If the host computer and target computer are not connected, or you have
not entered the required environment properties, the download process
terminates after about 5 seconds with a timeout error. Be sure that you have
followed the instructions outlined in “Host-Target Configuration” before
continuing.

To diagnose the problem, use the following procedure:

1 Type slrtexplr in the MATLAB Command Window.

2 In the Targets pane, expand the target computer node.

3 Click the Target Properties icon in the toolbar or double-click
Properties.

4 Select Host-to-Target communication and make the required changes
to the communication properties.

Note RS-232 host-target communication mode will be removed in a future
release. Use TCP/IP instead.

5 Select Boot configuration and click Create boot disk.

6 Reboot the target computer and try downloading the application again.

7 In some cases, the download might have completed even though you get a
timeout error. To detect this condition, wait until the target screen displays

System:initializing application finished.

8 Type slrtpingtarget at the MATLAB command prompt.

If slrtpingtarget finds a working connection between the host computer
and target computer, the response is something like:

ans =
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success

9 Right-click the target computer in question and select Connect.

If the connection resumes, the connection is working. If the connection
times out consistently for a particular model, the timeout needs to be
increased. See “Increase the Time for Downloads” on page 21-4.

For information on setting up the Simulink Real-Time environment, see
either “RS-232 Settings” or “ISA Bus Ethernet Settings”, and then see “Target
Boot Methods”.
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Increase the Time for Downloads
By default, if the host computer does not get a response from the target
computer after downloading a target application and waiting about 5 seconds,
the host computer software times out. On the other hand, the target computer
responds only after downloading and initializing the target application.

Usually 5 seconds is enough time to download a target application, but
in some cases it may not be long enough. The time to download a target
application mostly depends on your I/O hardware. For example, thermocouple
hardware takes longer to initialize. In this case, even though the target
computer is fine, a false timeout is reported.

You can increase the timeout value in one of the following ways:

• At the model level, open the Simulink > Model Configuration
Parameters dialog box and navigate to the Simulink Real-Time
Options node. Clear the Use default communication timeout
parameter and enter a new desired timeout value in the Specify the
communication timeout in seconds parameter. For example, enter 20
to increase the value to 20 s.

• At the target application level, use the target application
SimulinkRealTime.target.set method to set the CommunicationTimeOut
property to the desired timeout value. For example, to increase the value
to 20 s:

tg.set('CommunicationTimeOut',20)

For both methods, the host computer polls the target computer about once
every second, and if a response is returned, returns the success value. Only if
a download really fails does the host computer wait the full twenty seconds.
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Why Does the Download Halt?
If the MATLAB interface freezes and there are target ping errors, this failure
is likely the result of an active firewall, a long initialization process, or both
combined. To diagnose this problem, see:

• “Is There Communication Between the Computers?” on page 17-2

• “Boards with Slow Initialization” on page 17-4

“Timeout with Multiple Ethernet Cards” on page 17-6
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View Application Execution from the Host
Simulink Real-Time displays output from the target application on the target
computer monitor. You can view this monitor from the host computer using
the Real-Time Simulink Real-Time display window.

For a single-target system, type:

SimulinkRealTime.target.viewTargetScreen

For a particular target computer TargetPC1, type:

SimulinkRealTime.target.viewTargetScreen('TargetPC1')

The Simulink Real-Time display window is displayed on the host computer
monitor.
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Sample Time Deviates from Expected Value
You might notice that the sample time you measure from your model is not
equal to the sample time you requested. This difference depends on your
hardware. Your model sample time is as close to your requested time as the
hardware allows.

However, hardware does not allow infinite precision in setting the spacing
between the timer interrupts. This limitation can cause the divergent sample
times.

For the supported target computers, the only timer that can generate
interrupts is based on a 1.193 MHz clock. For the Simulink Real-Time system,
the timer is set to a fixed number of ticks of this frequency between interrupts.
If you request a sample time of 1/10000 seconds, or 100 microseconds, you do
not get exactly 100 ticks. Instead, the Simulink Real-Time software calculates
that number as:

100 x 10-6 s X 1.193 x 106 ticks/s = 119.3 ticks

The Simulink Real-Time software rounds this number to the nearest whole
number, 119 ticks. The actual sample time is then:

119 ticks/(1.193 X 106 ticks/s) = 99.75 X 10-6 s
(99.75 microseconds)

Compared to the requested original sample time of 100 microseconds, this
value is 0.25% faster.

As an example of how you can use this value to derive the expected deviation
for your hardware, assume the following:

• Output board that generates a 50 Hz sine wave (expected signal)

• Sample time of 1/10000

• Measured signal of 50.145 Hz

The difference between the expected and measured signals is 0.145 Hz, which
deviates from the expected signal value by 0.29% (0.145 / 50). Compared
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to the previously calculated value of 0.25%, there is a difference of 0.04%
from the expected value.

If you want to further refine the measured deviation for your hardware,
assume the following:

• Output board that generates a 50 Hz sine wave (expected signal)

• Sample time of 1/10200

• Measured signal of 50.002 Hz

1/10200 s X 1.193 x 106 ticks/s = 116.96 ticks

Round this number to the nearest whole number of 117 ticks. The resulting
frequency is then

(116.96 ticks/117)(50) = 49.983 Hz

The difference between the expected and measured signal is 0.019, which
deviates from the expected signal value by 0.038% (0.019 / 50.002). The
deviation when the sample time is 1/10000 is 0.04%.

Some amount of error is common for most computers, and the margin of error
varies from machine to machine.

Note Most high-level operating systems, like Microsoft Windows or Linux®,
occasionally insert extra long intervals to compensate for errors in the
timer. Be aware that the Simulink Real-Time software does not attempt to
compensate for timer errors. For this product, close repeatability is more
important for most models than exact timing. However, some chips might
have inherent designs that produce residual jitters that could change your
system behavior. For example, some Intel Pentium chips might produce
residual jitters on the order of 0.5 microsecond from interrupt to interrupt.
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What Measured Sample Time Can I Expect?
The Simulink Real-Time kernel is tuned for minimal overhead and maximum
performance. To check what sample time you can expect, run slrtbench at
the MATLAB command line.

• slrtbench('this')— Evaluates your target computer against predefined
benchmarks and compares it to other target computers. The results
indicate the smallest base sample time that an Simulink Real-Time
application can achieve on your system.

• slrtbench('model') — Evaluates your target computer against your
specific model.

Actual obtainable sample times depend on a number of factors, including:

• Processor performance

• Model complexity

• I/O block types

• Number of I/O channels
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Why Has the Stop Time Changed?
If you change the step size of a target application after it has been built, it
is possible that the target application will execute for fewer steps than you
expect. The number of execution steps is:

floor(stop time/step size)

When you compile code for a model, Simulink Coder calculates a number of
steps based on the current step size and stop time. If the stop time is not an
integral multiple of the step size, Simulink Coder adjusts the stop time for
that model based on the original stop time and step size. If you later change
a step size for a target application but do not recompile the code, Simulink
Real-Time uses the new step size and the previously adjusted stop time. The
resulting model may execute for fewer steps than you expect.

For example, if a model has a stop time of 2.4 and a step size of 1, Simulink
Coder adjusts the stop time of the model to 2 at compilation. If you change the
step size to 0.6 but do not recompile the code, the expected number of steps is
4, but the actual number of steps is 3 because Simulink Real-Time uses the
previously adjusted stop time of 2.

To avoid this problem, verify that the original stop time (as specified in the
model) is an integral multiple of the original step size.
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Why Is the Web Interface Not Working?
The Web interface to the target computer requires a connection between a
Web browser and the IP address and port by which you access the target. If
this IP address and port is already in use because you connected to the target
via Simulink, Simulink Real-Time Explorer, or a MATLAB command such as
slrt, the Web interface cannot connect and will fail.

Tip Type the MATLAB command close(slrt) immediately before opening
the Web interface.
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23 Application Parameters

Why Does the getparamid Function Return Nothing?
The SimulinkRealTime.target.getparamid and
SimulinkRealTime.target.getsignalid functions accept block_name
parameters. For these functions, enter for block_name the mangled name
that the Simulink Coder software uses for code generation. You can
determine the block_name as follows:

• If you do not have special characters in your model, use the gcb function.

• If the blocks of interest have special characters, retrieve the mangled name
with tg.showsignals='on' or tg.showparam = 'on'.

For example, if carriage return '\n' is part of the block path, the mangled
name returns with carriage returns replaced by spaces.

23-2



Which Model Parameters Can I Tune?

Which Model Parameters Can I Tune?
You can tune parameters of fixed-point data types, such as Boolean, integer,
and double. For more on fixed-point data types, see “Supported Data Types”.

You cannot tune parameters of complex or multiword data types.
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How Do I Fix Invalid File IDs?
You might get Error -10: Invalid File ID on the target computer if you
are acquiring signal data with a file scope. This error occurs because the size
of the signal data file exceeds the available space on the disk. The signal data
is most likely corrupt and irretrievable. You should delete the signal data
file and reboot the Simulink Real-Time system. To prevent this occurrence,
monitor the size of the signal data file as the scope acquires data.

Refer to the MathWorks Support Simulink Real-Time Web site
(http://www.mathworks.com/support/search_results.html?q=product:"Simulink+Re
for additional information.
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Which Model Signals Can I Access?
You cannot directly access or tag signals from virtual buses or blocks. To
observe a virtual block:

1 Add a unity Gain block (a Gain block with a gain of 1.0) to the model.

2 Connect the signal output of the virtual block to the input of the unity
Gain block.

3 Access or tag the output signal of the unity Gain block.

To observe a virtual bus, add a unity Gain block to each individual signal.

You cannot directly access signals you have optimized with block reduction
optimization. Access these signals by making them test points.

You cannot access signals of complex or multiword data types.
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How Can I Improve Run-Time Performance?
To improve runtime performance and reduce the task execution time (TET)
of a model model:

1 Run slrtbench at the MATLAB command line:

• slrtbench('this')— Evaluates your target computer against predefined
benchmarks and compares it to other target computers. The results
indicate the smallest base sample time that an Simulink Real-Time
application can achieve on your system.

• slrtbench('model') — Evaluates your target computer against your
specific model.

For more information on Simulink Real-Time benchmarking,
see http://www.mathworks.com/support/product/XP/-
productnews/benchmarks.html.

2 If your target computer is not high on the list of benchmark computers,
consider switching to a target computer with higher performance.

3 Run the Simulink Real-Time profiler on model and record where the time is
being spent. (See “Execution Profiling for Target Applications” on page 10-6.)

4 If the model contains many states (for example, more than 20 states), clear
the States check box in the Data Import/Export pane of the Configuration
Parameters dialog box. This disables state logging, making more memory
available for the target application.

5 Clear the Save to workspace check boxes in the Data Import/Export pane
of the Configuration Parameters dialog box (Time, States, Output, Final
states, Signal logging). This turns logging off, making more computing time
available for calculating the model.

6 Clear the Log Task Execution Time check box in the Simulink Real-Time
Options pane of the Configuration Parameters dialog box. This disables TET
logging for the application.
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7 Increase Fixed-step size (fundamental sample time) in the Solver pane
of the Configuration Parameters dialog box. Executing with a very short
sample time might overload the CPU.

8 Use polling mode, if you do not need background processes (see “Polling Mode”
on page 6-5 for more on setting this mode).

9 Disable the target scope display. To do this, clear the Graphics mode check
box in the Target settings pane of Simulink Real-Time Explorer.

10 Use fewer scopes in the model.

11 Reduce the number of I/O channels in the model.

12 Consider partitioning the model and running it on a multicore system (see
“How Simulink Solves Parallel and Multicore Processing Problems”).

To use your target computer in multicore mode, you must set the Multicore
CPU check box in the Target settings pane of Simulink Real-Time Explorer.

13 Consider partitioning the model and running it on multiple target computers.
This optimization might require multitarget synchronization using CAN,
UDP, parallel port, or reflective memory.

14 Check the questions and answers under Application Performance for tips on
eliminating CPU overloads and improving task execution time.

15 Check the MathWorks Support Web site and MATLAB Central for other tips.
See “Where Is the MathWorks Support Web Site?” on page 26-2.

16 Call MathWorks Technical Support. See “How Do I Contact MathWorks
Technical Support?” on page 26-5.
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Why Does Model Execution Produce CPU Overloads?
A CPU overload indicates that the CPU was unable to complete processing a
model time step before being asked to restart. When an overload occurs, one
of the following can happen:

• The Simulink Real-Time kernel halts model execution.

• If the overload is allowed, the model execution continues until a predefined
event (see “Can I Allow CPU Overloads?” on page 25-7 for details). If a
model continues running after a CPU overload, the model time step is as
long as the time required to finish the execution. This behavior delays the
following time step.

This error might occur if you have:

• Real CPU overloads— Those caused by model design or target computer
resources. For example, a model is trying to do more than can be done in
the allocated time on the target computer. Possible reasons are:

- The target computer is too slow or the model sample time is too small
(see “How Small Can the Sample Time Be?” on page 25-6).

- The model is too complex (algorithmic complexity).

- I/O latency, where each I/O channel used introduces latency into the
system. This might cause the execution time to exceed the model time
step.

To address I/O latency, you can use the Simulink Real-Time Interactive
Guide
(http://www.mathworks.com/support/product/XP/productnews/-
interactive_guide/xPC_Target_Interactive_Guide.html)
to find latency numbers for boards supported by the block library.
For example, if your application includes the National Instruments®

PCI-6713 board, and you want to use four outputs:

1 Look up the board in the Simulink Real-Time Interactive Guide.

From the table, the D/A latency is 1+2.4N.

2 To get the latency for four outputs, calculate the latency
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1+(2.4 x 4) = 10.6 microseconds

3 Include this value in your sample time calculations.

• Spurious CPU overloads — Commonly caused by factors outside of
the model design. These overloads are most likely caused by one of the
following:

- Advanced Power Management

- Plug-and-Play (PnP) operating system

- System Management Interrupts (SMIs)

Enabling these properties can cause non-real-time behavior from the target
computer. You must disable these BIOS properties for the target computer
to run the target application as a real-time application. See“BIOS Settings”.

Some BIOS do not allow you to disable SMIs.. However, for some chip sets,
you can programmatically prevent or disable SMIs. For example, see the
Disabling SMIs on Intel ICH5 Chipsets document at MATLAB Central for
a solution to disabling SMIs in the Intel ICH5 family.

For further information and test models, see the Simulink Real-Time CPU
Overloads document at MATLAB Central.
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How Small Can the Sample Time Be?
If the model has too small a sample time, a CPU overload can occur. This
error indicates that to run the target application, executing one step of the
model requires more time than the sample time for the model (Fixed step
size property) allows.

When this error occurs, the target object property CPUoverload changes from
none to detected. To diagnose the issue:

1 Run slrtbench at the MATLAB command line:

• slrtbench('this')— Evaluates your target computer against predefined
benchmarks and compares it to other target computers. The results
indicate the smallest base sample time that an Simulink Real-Time
application can achieve on your system.

• slrtbench('model') — Evaluates your target computer against your
specific model.

Tip For more information on Simulink Real-Time benchmarking,
see http://www.mathworks.com/support/product/XP/-
productnews/benchmarks.html.

2 Change the model Fixed step size property to at least the indicated
value and rebuild the model. Use the Solver node in the Simulink model
Configuration Parameters dialog.

3 If these steps do not solve your problem, see:

“How Can I Improve Run-Time Performance?” on page 25-2.
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Can I Allow CPU Overloads?
Typically, the Simulink Real-Time kernel halts model execution when
it encounters a CPU overload. You can direct the Simulink Real-Time
environment to allow CPU overloads using the TLCOptions model property.

Option Description Default

xPCMaxOverloads Number of acceptable overloads. 0

xPCMaxOverloadLen Number of contiguous
acceptable overloads. If
you do not specify this option,
the default value is the same
as xPCMaxOverloads. Specify
a value that is the same or
less than the value for the
xPCMaxOverloads option. Do
not a use a value greater than
xPCMaxOverloads.

Same as value of
xPCMaxOverloads

xPCStartupFlag Number of executions of
the model at startup,
where the timer interrupt
is temporarily disabled during
model execution. After the
model finishes the first
xPCStartupFlag number
of executions, the Simulink
Real-Time software enables
the timer interrupt, which will
invoke the next execution for
the model.

1

If you experience a CPU overload after the model starts, the software ignores
timer interrupts if the task is already running. The model continues running,
subject to the values of xPCMaxOverloads and xPCMaxOverloadLen. The
model then executes at the next step.

Consider the following cases:
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• xPCMaxOverloads is 2. The software tolerates the first two overloads and
stops execution at the third.

• xPCMaxOverloads is 3 and xPCMaxOverloadLen is 2. The software tolerates
the first three overloads and halts the model at the fourth.

• xPCStartupFlag is 4. The kernel ignores overloads for the first four
executions.

The three properties interact. When the Simulink Real-Time kernel runs
the model, it checks the number of CPU overloads against the values of
xPCMaxOverloads and xPCMaxOverloadLen. When the number of CPU
overloads reaches the lower of these two values, the kernel stops executing
the model.

Suppose you enter the following TLCOptionsmodel property for model xpcosc.
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set_param('xpcosc','TLCOptions','-axPCMaxOverloads=30
-axPCOverLoadLen=2 -axPCStartupFlag=5')

The software ignores CPU overloads for the first five iterations through the
model. After this, the software allows up to 30 CPU overloads, allowing at
most two consecutive CPU overloads.

With the TLCOptions model property, you can use the following blocks in
your model to monitor CPU overloads.

• Use the Get Overload Counter and Set Overload Counter blocks to set and
keep track of CPU overload numbers.

• Use the Time Stamp Counter block to profile your model.
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Where Is the MathWorks Support Web Site?
For Simulink Real-Time solutions and guidelines, see the following
MathWorks Web site resources:

• MathWorks Support Simulink Real-Time Web site
(http://www.mathworks.com/support/search_results.html?q=product:"Simulink

The Simulink Real-Time documentation is also available from this site.

• MATLAB Central File Exchange
(http://www.mathworks.com/matlabcentral/fileexchange/?term=Simulink+Real-
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How Do I Get a Software Update?
1 Navigate to the MathWorks download page
(http://www.mathworks.com/downloads/).

2 Navigate to the page for the Simulink Real-Time software version you want
and download it to your host computer.

3 Install and integrate the new release software.

4 Recreate your Simulink Real-Time environment. (See “What Should I Do
After Updating Software?” on page 26-4.)
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What Should I Do After Updating Software?
If you are working with a new Simulink Real-Time release,
either downloaded from the MathWorks download page
(http://www.mathworks.com/downloads/) or installed from a
DVD, you must do the following:

1 Type slrtexplr in the MATLAB Command Window.

2 In the Targets pane, expand the target computer node.

3 Click the Target Properties icon in the toolbar or double-click
Properties.

4 Select Host-to-Target communication and recreate your Simulink
Real-Time environment (see “RS-232 Communication Setup” or Network
Communication).

Note RS-232 host-target communication mode will be removed in a future
release. Use TCP/IP instead.

5 Select Boot configuration and click Create boot disk.

6 Reboot the target computer.

7 In the Simulink Editor window and from the Code menu, click C/C++
Code > Build Model for each model to be executed.
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How Do I Contact MathWorks Technical Support?
1 If you cannot solve your problem, call function

SimulinkRealTime.getSupportInfo to retrieve diagnostic information for
your Simulink Real-Time configuration. This function writes the diagnostic
information to the file slrtinfo.txt in the current folder.

Note The slrtinfo.txt file might contain information sensitive to
your organization. Review the contents of this file before disclosing it to
MathWorks.

2 Contact MathWorks directly for online or phone support:
http://www.mathworks.com/support/contact_us
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Support Packages and Support Package Installer

What Is a Support Package?
A support package is an add-on that enables you to use a MathWorks product
with specific third-party hardware and software.

Support packages can include:

• Simulink block libraries

• MATLAB functions, classes, and methods

• Firmware updates for the third-party hardware

• Automatic installation of third-party software

• Examples and tutorials

A support package file has a *.zip extension. This type of file contains
MATLAB files, MEX files, and other supporting files required to install the
support package. Use Support Package Installer to install these support
package files.

A support package installation file has a *.mlpkginstall extension. You
can double click this type of file to start Support Package Installer, which
preselects a specific support package for installation. You can download these
files from MATLAB Central File Exchange and use them to share support
packages with others.

What Is Support Package Installer?
Support Package Installer is a wizard that guides you through the process of
installing support packages.

You can use Support Package Installer to:

• Display a list of available, installable, installed, or updatable support
packages

• Install, update, download, or uninstall a support package.

• Update the firmware on specific third-party hardware.
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• Provide your MathWorks software with information about required
third-party software.

If third-party software is included, Support Package Installer displays a list of
the software and licenses for you to review before continuing.

You can start Support Package Installer in one of the following ways:

• On the MATLAB toolstrip, click Add-Ons > Get Hardware Support
Packages.

• In the MATLAB Command Window, enter supportPackageInstaller.

• Double-click a support package installation file (*.mlpkginstall).
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Install This Support Package on Other Computers
You can download a support package to one computer, and then install it on
other computers. Using this approach, you can:

• Save time when installing support packages on multiple computers.

• Install support packages on computers that are not connected to the
Internet.

Before starting, select a computer to use for downloading. This computer must
have the same base product license and platform as the computers upon which
you are installing the support package. For example, suppose you want to
install a Simulink support package on a group of computers that are running
64-bit Windows. To do so, you must first download the support package using
a computer that has a Simulink license and is running 64-bit Windows.

Download the support package to one computer:

1 In the MATLAB Command Window, enter supportPackageInstaller.

2 In Support Package Installer, on the Select an action screen, choose
Download from Internet. Click Next.

3 On the following screen, select the support package to download.

Verify the path of the Download folder. For example,
C:\MATLAB\SupportPackages\R2013b\downloads.

4 Follow the instructions provided by Support Package Installer to complete
the download process.

This action creates a subfolder within the Download folder that contains
the files required for each support package.

5 Make the new folder available to for installation on other computers. For
example, you can share the folder on the network, or copy the folder to
portable media, such as a USB flash drive.
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Note Some support packages require you to install third-party software.
If so, also make the third-party software available for installation on the
other computers.

Install the support package on the other computers:

1 Run Support Package Installer on the other computer or computers.

2 On the Install or update support package screen, select the Folder
option.

3 Click Browse to specify the location of the support package folder on the
network or portable media.

4 Follow the instructions provided by Support Package Installer to complete
the installation process.
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Open Examples for This Support Package

In this section...

“Using the Help Browser” on page 27-6

“Using Support Package Installer” on page 27-8

Using the Help Browser
You can open support package examples from the Help browser:

1 After installing the support package, click View product documentation
(F1).

2 In Help, click Supplemental Software.

27-6



Open Examples for This Support Package

3 In Supplemental Software, double-click Examples.
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4 Select the examples for your support package.

Note For other types of examples, open the Help browser and search for your
product name followed by “examples”.

Using Support Package Installer
Support Package Installer (supportPackageInstaller) automatically
displays the support package examples when you complete the process of
installing and setting up a support package.

On the last screen in Support Package Installer, leave Show support
package examples enabled and click Finish.
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